Version 4.40
Customer Upgrade Guide

for
Sage MAS 90 ERP
Sage MAS 200 ERP

This version of the software has been retired.
©2004-2010 Sage Software, Inc. All rights reserved. Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc., or its affiliated entities. Crystal Reports is the registered trademark and technology of Business Objects SA. All other trademarks are the property of their respective owners.
Contents

Chapter 1 — Introduction 1
About This Guide 1
Enhancements 2
Graphic Conventions 2
Text Conventions 3

Chapter 2 — What's New in Version 4.40 5
Global Enhancements 5
  Updated Sage MAS 90 and 200 Desktop Content 5
  Data File Multi-Segment 6
  Expanded Customer Number 6
  Expanded Item Code 6
  Persistent Zoom Setting on Report Preview 7
  Alias Item Substitution for Inventory Items 7
Data Preparation and Migration Enhancements 8
  Pre Migration 8
  Parallel Migration 8
  Link Maintenance Utility 8
  Sales Order History Report Printing Utility 9
Bill of Materials Enhancements 10
  Maintenance and Data Entry Changes 10
  Utilities Menu 10
Inventory Management Enhancements 11
  Synchronized History Tables 11
  Enhanced Physical Count 11
  Reporting Capabilities 11
  Batch Entry for Inventory Transactions 12
  Increase in Decimal Precision 12
  Standard Cost 12
Purchase Order Enhancements 13
  Drop Shipment Auto Generation 13
  Data Entry Changes 13
  Auto Reorder and Auto Generate Order Selection 13
Customizer Enhancements 13
  Enhanced Customization Capabilities 13
Common Information Enhancements 14
  Global Changes 14
  New Setup Menu 14
Contents

Business Insights Enhancements 15
   New and Enhanced Views 15
Bar Code Enhancements 16
   Global Changes 16
Visual Integrator Enhancements 17
   Import Job Maintenance Changes 17
   Export Job Maintenance Changes 17
Usability and Workflow Advantages of Sage MAS 90 and 200 Business Framework™ 18
   New Business Framework Modules 18
   Dual Grid Entry 18
   Personalization 18
   Hyperlinks 19
   Right-Click Menu 19
   Business Intelligent Data Access to Ad-Hoc Reports 19
   Reports and Forms 20
   Memo Manager 20
   User and Date Timestamps 21
   Setup Wizards 21
   Fiscal Year and Period 21
   Flexible Security 22
   Batch Manager 22
   Advanced Lookup Engine (ALE) 22
   Object Interface - API 22
   Period End Processing 22

Chapter 3 — Upgrading from 4.30 to 4.40 23
Installation Changes 23
Global Changes 23
   Data File Multi-Segment 23
   Activity Log 24
   Advanced Lookup Engine (ALE) 24
   Batch Faxing 24
   Character-Based Forms 24
   Customized Crystal Forms 24
   Data Dictionary Changes 25
   Data Entry 25
   Expanded Customer Numbers 25
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expanded Item Codes</td>
<td>25</td>
</tr>
<tr>
<td>Accounts Payable Changes</td>
<td>26</td>
</tr>
<tr>
<td>Accounts Receivable Changes</td>
<td>26</td>
</tr>
<tr>
<td>Bar Code Changes</td>
<td>26</td>
</tr>
<tr>
<td>Bar Code Options</td>
<td>26</td>
</tr>
<tr>
<td>Unattended Bar Code Transaction Import</td>
<td>26</td>
</tr>
<tr>
<td>Renamed Tasks</td>
<td>26</td>
</tr>
<tr>
<td>Bill of Materials Changes</td>
<td>27</td>
</tr>
<tr>
<td>Global Changes</td>
<td>27</td>
</tr>
<tr>
<td>Bill of Materials Options</td>
<td>27</td>
</tr>
<tr>
<td>Data Entry</td>
<td>27</td>
</tr>
<tr>
<td>Inquiry Changes</td>
<td>27</td>
</tr>
<tr>
<td>Printing</td>
<td>28</td>
</tr>
<tr>
<td>Reports and Forms</td>
<td>28</td>
</tr>
<tr>
<td>Renamed, Removed, or Moved Tasks</td>
<td>29</td>
</tr>
<tr>
<td>Business Insights Changes</td>
<td>30</td>
</tr>
<tr>
<td>Business Insights Reporter</td>
<td>30</td>
</tr>
<tr>
<td>Common Information Changes</td>
<td>31</td>
</tr>
<tr>
<td>Common Information Options</td>
<td>31</td>
</tr>
<tr>
<td>Renamed, Removed, or Moved Tasks</td>
<td>31</td>
</tr>
<tr>
<td>Customizer Changes</td>
<td>32</td>
</tr>
<tr>
<td>e-Business Manager Changes</td>
<td>32</td>
</tr>
<tr>
<td>Web Engine</td>
<td>32</td>
</tr>
<tr>
<td>General Ledger Changes</td>
<td>33</td>
</tr>
<tr>
<td>Fiscal Year Maintenance</td>
<td>33</td>
</tr>
<tr>
<td>Inventory Management Changes</td>
<td>33</td>
</tr>
<tr>
<td>Global Changes</td>
<td>33</td>
</tr>
<tr>
<td>Inventory Management Options</td>
<td>34</td>
</tr>
<tr>
<td>Product Line Maintenance</td>
<td>34</td>
</tr>
<tr>
<td>Transaction Entry</td>
<td>35</td>
</tr>
<tr>
<td>Item Maintenance</td>
<td>35</td>
</tr>
<tr>
<td>Physical Count Changes</td>
<td>36</td>
</tr>
<tr>
<td>Costing Changes</td>
<td>36</td>
</tr>
<tr>
<td>Utilities Menu</td>
<td>37</td>
</tr>
<tr>
<td>Period End Processing</td>
<td>37</td>
</tr>
<tr>
<td>Printing</td>
<td>38</td>
</tr>
<tr>
<td>Reports and Forms</td>
<td>38</td>
</tr>
</tbody>
</table>
Contents

Renamed, Removed, or Moved Tasks 39
Job Cost Changes 40
  Job Cost Options 40
  Data Dictionary Changes 40
Payroll Changes 40
  Taxes 40
Purchase Order Changes 41
  Global Changes 41
  Purchase Order Options 42
  Purchases History 43
  Data Entry 43
  Utilities Menu 43
  Period End Processing 44
  Printing 44
  Registers and Updates 45
  Reports and Forms 45
  Renamed, Removed, or Moved Tasks 46
Return Merchandise Authorization Changes 46
  Data Entry 46
Sales Order Changes 47
  Security Option for Adding Inventory Items on the Fly 47
  Data Entry 47
  Reports 47
  Renamed, Removed, or Moved Tasks 47
Visual Integrator Changes 48
  Import Job Maintenance 48
Work Order Changes 49
  Moved Tasks 49
  Data Dictionary Changes 49
Retired Modules 49
  Timberline 49
  ACT! Link 49
  SageCRM 49

Chapter 4 — Upgrading from Versions Prior to 4.30 to 4.40  51
Installation Changes 51
  Installing the Software 51
Contents

Global Changes  52
  Data File Multi-Segment  52
  Activity Log  52
  Advanced Lookup Engine (ALE)  52
  Batch Faxing  53
  Character-Based Forms  53
  Customized Crystal Forms  53
  Data Dictionary Changes  53
  Data Entry  54
  Desktop  54
  Expanded Customer Numbers  54
  Expanded Item Codes  55
  Help System and Online Manuals  55
  Inquiries  55
  Migrating Level 3.x Data  55
  Module and Accounting Dates  56
  Printing  56
  Printing to a Dot Matrix Printer  57
  Registering Your Modules  57
  Reports and Forms  58
  Security  58
  Selection Grids  58

Library Master Changes  59
  Batch Faxing  59
  Changed Tasks  59
  Reports  60
  Companies  61
  Role Maintenance  61
  URL Maintenance  62
  Renamed, Removed, or Moved Tasks  62

Accounts Payable Changes  64
  Global Changes  64
  Data Entry  65
  Period End Processing  65
  Reports and Forms  65
  Renamed, Removed, or Moved Tasks  66
General Ledger Changes 81
   Fiscal Year Maintenance 81
   Accounts 81
   Allocations 82
   Custom Financials 83
   Standard Financials 83
   Data Entry 83
   Period End Processing 84
   Reports 85
   Renamed and Removed Tasks 86

Inventory Management Changes 87
   Global Changes 87
   Inventory Management Options 87
   Product Line Maintenance 88
   Transaction Entry 88
   Item Maintenance 88
   Physical Count Changes 89
   Costing Changes 89
   Utilities Menu 90
   Period End Processing 90
   Printing 91
   Reports and Forms 92
   Renamed, Removed, or Moved Tasks 92

Job Cost Changes 93
   Job Cost Options 93
   Data Dictionary Changes 93

Payroll Changes 94
   Direct Deposits 94
   Taxes 94
   Reports 95

Purchase Order Changes 96
   Global Changes 96
   Purchase Order Options 97
   Purchases History 98
   Data Entry 98
   Utilities Menu 98
   Period End Processing 99
Contents

- Printing 99
- Registers and Updates 100
- Reports and Forms 100
- Renamed, Removed, or Moved Tasks 101

Return Merchandise Authorization Changes 102

- Data Entry 102
- Utilities Menu 102

Sales Order Changes 103

- Security Option for Adding Inventory Items on the Fly 103
- Data Entry 103
- Reports 103
- Renamed, Removed, or Moved Tasks 103
- Global Changes 104
- Sales History 104
- Sales History Reports 104
- Period End Processing 105
- Job Cost Integration 106

Visual Integrator Changes 107

- Data Dictionaries 107
- Data Dictionary Listing 107
- Import Job Maintenance 107

Work Order Changes 107

- Moved Task 107
- Data Dictionary Changes 107

Report Master Changes 108

Retired Modules 108

- Timberline 108
- ACT! Link 108
- SageCRM 108
- FAS Select 109
- Client Write-Up 109
- Import Master 109
- PostMaster 109
- TimeSlips Link 109
- Visual PostMaster 109
Chapter 5 — Changes to Accounts Payable 111
Global Changes 111
Data Entry 112
Period End Processing 112
Renamed, Removed, or Moved Tasks 113
Reports and Forms 114

Chapter 6 — Changes to Accounts Receivable 115
Global Changes 115
Customer Statements 116
Period End Processing 116
Renamed, Removed, or Moved Tasks 117

Chapter 7 — Changes to Bar Code 119
Bar Code Options 119
Unattended Bar Code Transaction Import 119
Renamed Tasks 119

Chapter 8 — Changes to Business Insights 121
Business Insights Dashboard 121
Business Insights Explorer 121
Business Insights Reporter 122
Menu Organization 124
Renamed Tasks 124

Chapter 9 — Changes to Bill of Materials 125
Global Changes 125
Bill of Materials Options 125
Data Entry 125
Inquiry Changes 126
Printing 126
Reports and Forms 127
Renamed, Removed, or Moved Tasks 127

Chapter 10 — Changes to Common Information 129
Common Information Options 129
Miscellaneous Item Maintenance 130
Renamed, Removed, or Moved Tasks 130
Contents

Chapter 11 — Changes to Customizer 133
Global Changes 133

Chapter 12 — Changes to e-Business Manager 139
Web Engine 139
Global Changes 139

Chapter 13 — Changes to Electronic Reporting for W2 and 1099 (Magnetic Media Reporting) 141
Global Changes 141

Chapter 14 — Changes to Fixed Assets 143
Global Changes 143

Chapter 15 — Changes to General Ledger 145
Fiscal Year Maintenance 145
Accounts 145
Allocations 146
Custom Financials 147
Standard Financials 147
Data Entry 148
Period End Processing 149
Reports 150
Renamed and Removed Tasks 150

Chapter 16 — Changes to Inventory Management 151
Global Changes 151
Inventory Management Options 151
Product Line Maintenance 152
Transaction Entry 152
Item Maintenance 153
Physical Count Changes 153
Costing Changes 154
Utilities Menu 154
Period End Processing 155
Printing 155
Reports and Forms 156
Renamed, Removed, or Moved Tasks 156
Chapter 17 — Changes to Job Cost  159
Job Cost Options  159
Data Dictionary Changes  159

Chapter 18 — Changes to Purchase Order  161
Global Changes  161
Purchase Order Options  162
Purchases History  163
Data Entry  163
Utilities Menu  164
Period End Processing  164
Printing  165
Registers and Updates  165
Reports and Forms  165
Renamed, Removed, or Moved Tasks  166

Chapter 19 — Changes to Payroll  167
Taxes  167
Direct Deposits  168
Reports  168

Chapter 20 — Changes to Return Merchandise Authorization  169
Data Entry  169
Utilities  169

Chapter 21 — Changes to Sales Order  171
Security Option for Adding Inventory Items on the Fly  171
Global Changes  171
Data Entry  171
Sales History  172
Sales History Reports  172
Period End Processing  173
Job Cost Integration  174
Renamed, Removed, or Moved Tasks  174
Contents

Chapter 22 — Changes to Visual Integrator 175
Data Dictionaries 175
Data Dictionary Listing 176
Import Job Maintenance 177
Job Import 180
Export Jobs 180

Chapter 23 — Changes to Work Order 181
Moved Task 181
Data Dictionary Changes 181

Appendix A — Checklists 183
Migration and Conversion Process 183
Migrating from Level 3.x to Version 4.40 184
    Pre-Migration Checklist 184
    Post-Migration Checklist 188
    Conversion Checklist 189
Migrating from Version 4.00 or 4.05 to Version 4.40 195
    Pre-Migration Checklist 195
    Post-Migration Checklist 197
    Conversion Checklist 199
Migrating from Version 4.10 to Version 4.40 204
    Pre-Migration Checklist 204
    Post-Migration Checklist 206
    Conversion Checklist 207
Migrating from Version 4.20 to Version 4.40 213
    Pre-Migration Checklist 213
    Post-Migration Checklist 215
    Conversion Checklist 216
Migrating from Version 4.30 to Version 4.40 222
    Pre-Migration Checklist 222
    Post-Migration Checklist 224
    Conversion Checklist 225
Chapter 1

Introduction

Sage, the recognized leader in business management for small- and mid-size businesses, welcomes you to Sage MAS 90 and 200 ERP version 4.40.

About This Guide

This guide has been created to ease the process of upgrading your software. While the extensive new features included in this release have been designed to improve your workflow and business processes, this means that the way you use your system may change. Chapter 2 of this guide contains all the enhancements for this release. The remaining chapters specifically highlight the differences that you need to be aware of and the steps you need to take before you begin using the new system so you can take better advantage of the improvements. The appendix provides pre-migration and post-migration checklists to ease the upgrade process.

Review the information in this guide before performing the software installation and migration steps in your Installation and System Administrator’s Guide. The Installation and System Administrator’s Guide can be found in the root folder D:\ (where D: is your CD-ROM drive) of the Sage MAS 90 or Sage MAS 200 CD-ROM. The guide is in Adobe Acrobat (PDF) format and is named either MAS90_Install.pdf or MAS200_Install.pdf, depending on the application you own.
Chapter 1  Introduction

Enhancements

For a complete list of enhancements and changes to the software, after installing, refer to the What's New page and the Release Notices. For the What's New information, see What's New in Version 4.40 on page 5.


This guide contains the following information you need for a successful upgrade:

- Installation changes
- Global changes in the software
- Changes to the modules
- Pre-installation checklist
- Pre-migration checklist
- Post-migration checklist

Graphic Conventions

The following icons are used throughout this manual to indicate different types of information.

- The NOTE symbol is followed by additional information about a topic.
- The WARNING symbol is followed by information to help you avoid costly mistakes.
Text Conventions

The following table describes the text conventions used in this manual.

<table>
<thead>
<tr>
<th>Text Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menus</td>
<td>Menus are shown in this format: Select menu &gt; menu task name. Examples: • Select File menu &gt; Change Company. • Select General Ledger Budget menu &gt; Budget Maintenance.</td>
</tr>
<tr>
<td>Bold font</td>
<td>Indicates text entered at a field or text selected at a field. Examples: • At the Value field, type a search value, such as 01, for the lookup. • In the Filter window, to delete a filter, select &lt;none&gt; at a filter’s Column field.</td>
</tr>
<tr>
<td>Italic font</td>
<td>Indicates references to other manuals. Example: • For more information about installing demo data, refer to your Installation and System Administrator’s Guide.</td>
</tr>
</tbody>
</table>
Chapter 2

What's New in Version 4.40

Version 4.40 incorporates an enhanced user interface and features in the Bill of Materials, Inventory Management, Purchase Order, and Bar Code modules, offering improvements such as expanded numeric fields and flexible security.

Business Insights Explorer has also been enhanced to now provide Bill of Materials, Inventory Management, and Purchase Order views. The Charts tab allows you to view and chart data for these modules in various formats.

The following is a complete list of enhancements incorporated in the Sage MAS 90 and 200 version 4.40 release.

Global Enhancements

Updated Sage MAS 90 and 200 Desktop Content

From your new Business Desktop, you can access the following if you have Internet access:

- Sage MAS 90 and 200 Community Forums
- Latest training and support information
- Customer Newsletter for news and product information
- Submit and track your product ideas, needs, and preferences
Chapter 2  What’s New in Version 4.40

Data File Multi-Segment

- Sage MAS 90 and 200 now support segmented files. Data files that are reaching the 2 GB limit will now be segmented. Adding the segmented feature available in ProvideX will enhance the product’s ability to handle large data files. For example, the previous need to purge data from history files when the files reached the 2 GB limit has been eliminated. Index and sort files for modules that have not been upgraded to the Business Framework will not be segmented.

- The Rebuild utilities in Sage MAS 90 and 200 are now enhanced to accommodate segmented files and a progress meter will appear when running the rebuild process.

Expanded Customer Number

- The customer number field is now expanded to 20 characters, from 7 characters in previous releases. (The division number remains at 2 characters).

- Expansion is implemented by company, accessed from the Accounts Receivable Setup Options window.

- The expanded field allows you to add information within the customer number. For example, if you have customers with multiple locations, you can add the city or telephone number within the customer number to identify a unique account.

Expanded Item Code

- The item code field is now expanded to 30 characters, from 15 characters in previous releases.

- Expansion is implemented by company, accessed from the Common Information Setup Options window.

- The expanded field allows to add information within the item code. For example, you can use the UPC code as the item code, or add a portion of a vendor name to the number to easily identify the source vendor for a similar item that you purchase from multiple vendors.

NOTE
Contact your development partner if you have segmented files prior to version 4.40. Sage does not support the conversion of those segmented files.
GLOBAL ENHANCEMENTS
Persistent Zoom Setting on Report Preview

**Persistent Zoom Setting on Report Preview**

- The Report Preview option in Library Master User Maintenance allows each user to set their own default zoom setting to view reports.
- After you establish your zoom preference, you will be able to preview reports at your preferred setting.

**Alias Item Substitution for Inventory Items**

In all data entry windows, you can now enter an alias item and the item code associated with it will be substituted for the alias item entered.
Chapter 2  What’s New in Version 4.40

Data Preparation and Migration Enhancements

Pre Migration

- You can now analyze and prepare your General Ledger and Inventory Management files before migrating your existing data to Sage MAS 90 or 200 version 4.40.
- Depending on the Sage MAS 90 or 200 version you are migrating from and the module installed or activated, the following tasks will appear in the Pre Migration task to assist you and your Sage business partner in preparing your source data prior to migration.
  - General Ledger Account Validation Report
  - General Ledger Special Characters Report
  - General Ledger Out of Balance Report
  - General Ledger Future Years Utility
  - Item Code Validation Report
  - Inventory File Comparison Report
  - Inventory Balancing Utility

Parallel Migration

The Parallel Migration Wizard provides you with the ability to migrate from your Sage MAS 90 or 200 3.x or 4.x source data, to version 4.40 in a phased process, while continuing to operate your business running on your current system.

Link Maintenance Utility

The Link Maintenance Utility provides you with the ability to view or change paths to memo attachments, office templates, and Paperless Office PDFs on your system. You can correct or delete links to the files, and copy or move the files to a different location.
Sales Order History Report Printing Utility

- You are now prompted to run the Sales Order History Report Printing utility before converting your data to the current version.

- This utility prints the final copies of the following reports:
  - Customer Sales History Report
  - Monthly Recap by Product Line Report
  - Monthly Recap by Warehouse/Product Line Report
  - Monthly Recap by Warehouse Report
  - Monthly Recap by Division Report
Bill of Materials Enhancements

Maintenance and Data Entry Changes

- You can now add miscellaneous charges and comments on the fly in Bill of Materials Maintenance, Option Bill Maintenance, and Option Interaction Maintenance. Also, an extended item description has been added to these tasks.

- You can now post miscellaneous charges by warehouse and view the general ledger segment the miscellaneous charges will post to.

- An Item Quantity Inquiry button and the Item Memo window have been added to the Bill of Materials Maintenance, Option Bill Maintenance, and Option Interaction Maintenance tasks. Also, the Item Memo window has been added to all data entry windows.

- The Lot/Serial Distribution button has been added to the Production Entry and Disassembly Entry windows.

Utilities Menu

A new utility to purge Bill of Materials history has been added to the Utilities menu to remove history data for production, disassembly, and engineering change records.
Inventory Management Enhancements

Synchronized History Tables

- The 4.40 architecture creates a relationship between the Item Transaction History table and the period posting and summary history tables. All period posting and summary history tables will now have corresponding detail transaction records. The benefit of the new architecture is that the period posting tables, summary history tables, and detail transaction tables will always be synchronized and if the period end dates are changed, the tables can be recalculated to synchronize the data.

- During conversion, transaction records are reconciled with period posting and summary history tables. If the detail records do not match the summary history or period posting tables, the conversion process will now create missing detail records to force the synchronization.

Enhanced Physical Count

When you want to do a physical count and get an accurate determination of your inventory at a specific point in time, you will be able to print a report containing all the inventory details in your system, with space for your warehouse employees to record an item quantity as they perform the count.

Reporting Capabilities

You can now select Portrait or Landscape format for the following reports.

- Inventory Detail Transaction Report
- Inventory Valuation Report
- Inventory Sales Analysis
- Sales Promotion Report
Chapter 2  What’s New in Version 4.40

Batch Entry for Inventory Transactions

- The Batch Entry feature in Transaction Entry allows each user to have their own working batch for receipts, transfers, and adjustments that can be printed and updated independently.

- You will be able to select specific lot and serial numbers, or a range of lot and serial numbers to reduce unnecessary keystrokes.

- Unique batch numbers will allow more than one user to enter data in the same task and print and update independently without affecting other batches.

Increase in Decimal Precision

- The number of decimal places has been increased to four in Inventory Management, which is now consistent with the four decimal places in Bill of Materials. This is now set up in Common Information Options.

- Cost of goods sold, inventory counts, and profitability reports now provide management with more granular financial information.

Standard Cost

- Inventory items can now be valued at zero dollars and relieved from inventory at zero cost.

- You can now print current or historical standard cost on the Inventory Valuation Report by Period, Inventory Trial Balance report, and the Inventory Detail Transaction Report.

- You can now print the Inventory Valuation Report by period.
Purchase Order Enhancements

Drop Shipment Auto Generation

- For each individual sales order line item, you can now automatically generate a drop shipment, regardless of whether or not a primary vendor has been identified.

- If a sales order contains more than one drop-shipped item to be purchased from the same vendor, only one purchase order will be created to order all of the items. This streamlines the ordering process and reduces the number of purchase orders to issue and track.

Data Entry Changes

- In the Purchase Order Entry window, the user login ID is now displayed.

- In some data entry windows the weight and weight reference can be entered.

- The Item Memo window has been added to all data entry windows.

Auto Reorder and Auto Generate Order Selection

New selection options have been added and grouped appropriately to enhance functionality.

Customizer Enhancements

Enhanced Customization Capabilities

- Custom Office allows you, your administrator, or your business partner to modify your system screens to program events to run without user interaction. These modifications persist across upgrades, so your customizations do not have to be reapplied to future releases.

- Your business partner can create these modifications at their office, export them, and e-mail them to you to easily install on your system.
Common Information Enhancements

Global Changes

- Purchase Order and Bill of Materials miscellaneous charges and items can now be set up and maintained in one location using Miscellaneous Item Maintenance.

- You can now view and compare purchase and quantity history for current and previous years for miscellaneous items.

- The Purge Item History utility has been added because period end closing is no longer required, yet occasionally, regularly item history purges may be desired.

- The new Miscellaneous Item Detail Transaction Report has been added to provide a detailed listing of miscellaneous, charge, and special items.

- You can now retain item history for a minimum of two years for all items and transactions.

- The new setting to expand item codes is accessed in Common Information Options.

- The maximum number of decimals allowed has been increased to four decimal places in Common Information Options.

- In the Miscellaneous Item History by Period report, additional options to print data have been added.

New Setup Menu

The Common Information module now has a Setup menu which includes the following tasks:

- Common Information Options

- Unit of Measure Conversion Maintenance
Business Insights Enhancements

New and Enhanced Views

New and revised views for the Inventory Management, Purchase Order, and Bill of Materials modules have been added to Business Insights Explorer:

- Item Quantities by Warehouse View - New
- Item View - Enhanced
- Item Transactions View - Enhanced
- Open PO By Vendor Name View - New
- Purchase Order View - Enhanced
- Vendor History Purchases View - New
- Vendor History Receipts View - Enhanced
- Bill of Materials View - New
- Component Where-Used View - New
Bar Code Enhancements

Global Changes

- The module will now streamline your warehouse processes by allowing shipping and receiving staff to collect data rapidly and accurately.

- UDFs are now supported in new Bar Code API (Application Programming Interface) implementations to add unique important information to items, such as expiration dates to serial or lot numbers. That information now converts to a bar code, and then prints and correctly scans into your system wherever the Bar Code module is used to capture data.

- Your Sage MAS 90 or 200 imports are still supported with your existing scanning hardware, and radio-frequency handhelds are now supported for new or existing customers who want to move to this type of equipment.

- Bar Code will now be able to scan both sales orders and sales order invoices to support a variety of workflows.

- To simplify the resolution of import errors, a new Rejected Import Maintenance task has been added for conditions such as invalid item codes or insufficient quantity available in a lot/serial tracked item. The reason for the rejection is clearly stated to make it easy to determine how to resolve the issue. In most cases, the correction can be made and the transaction can then be re-imported directly from this new task.

- You can now retain import history for a minimum of ninety days in Bar Code Options.
Visual Integrator Enhancements

Import Job Maintenance Changes

- All data entry business objects now allow an existing line item in the Detail file to be modified. The LineKey field is now displayed in red and its value must be provided to edit an existing detail line. If the value provided is blank or invalid, a new detail line will be added from the import record.

- The ability to import lot and serial distribution records is now included in the related header import.

- A Skip Source Data Truncation check box has been added to allow the import of items that have an extended description.

- Record types are now included in the Job Import Log.

- All Bill of Materials bill components including Bill Header, Bill Detail, Bill Options Header, Bill Options Detail, Bill Options Interactions Header, Bill Options Interactions Detail, and Bill Options Categories can now be imported using the Bill Header business object.

Export Job Maintenance Changes

A new job perform has been created to remove trailing separators when exporting data.
Usability and Workflow Advantages of Sage MAS 90 and 200 Business Framework™

New Business Framework Modules

New in Inventory Management, Purchase Order, and Bill of Materials, the Business Framework functionality now flows throughout the main sections of the Sage MAS 90 and 200 system.

Dual Grid Entry

- The dual grid entry design allows each user to personalize the data entry screens to work the way you want to work - rearrange, hide, and more without engaging a programmer.
- You can drag-and-drop to move the grid line or column position so your data entry order can match your workflow.
- When you rarely use a column of data, that category can be grouped into a secondary grid, and positioned below or beside the primary grid, whichever you prefer.
- If a line entry mistake is made when you are entering data, you can cancel and re-enter the line entry.

Personalization

The Sage MAS 90 and 200 Business Framework™ enables flexible personalization for each user, such as resizing and simplification of screens, saving settings and establishing default printers, streamlining workflows by removing unnecessary tabs and fields, and establishing user-specific desktop dashboards that allow you and your executives to monitor the pulse of your business.
Hyperlinks

Hyperlinks provide you with easy access to related tasks with a single click. Easily jump to maintenance from a data entry screen. For example, within Purchase Order Entry, click the vendor number, terms code, and ship-to address hyperlinks. Using hyperlinks reduces your access time, cuts down on errors, and minimizes the number of keystrokes that are required to gain access to a related piece of information or task.

Right-Click Menu

The right-click menu provides you with contextual accessibility for a logical business workflow, or the most common action(s) that you would make from the screen you are currently using. This reduces the amount of time spent locating the same functionality from the top-line drop-down menus. For example, in Item Maintenance, you can quickly access related tasks such as Warehouse Maintenance, Transaction Entry, and the Inventory Sales History Report.

Business Intelligent Data Access to Ad-Hoc Reports

- The Business Framework allows more flexible and sophisticated user access, such as the powerful Business Insights Explorer, Dashboard, and Reporter.

- Business Insights Explorer provides data-centric views into your business for ad-hoc inquiry, drill-down, and drill-around capabilities using an intuitive interface with drag-and-drop, sort, filter, calculations, color highlighting, and the ability to save personalized private or group views.

- Business Insights Explorer views can be quickly converted to a chart on the fly to display your information the way you want to see it and share it.

- Views and charts can be e-mailed or exported to Microsoft Excel, Word, Access, XML, a Web page, and a Microsoft query for on-demand reporting.
Chapter 2  What’s New in Version 4.40

- Because UDFs are linked throughout the system, the data is available in Business Insights Explorer, Business Insights Reporter, and Crystal Reports.

Reports and Forms

- Popular benefits of the Business Framework include flexible options for reports and forms, which enables user personalization, more efficient workflow, reduced keystrokes, and simplified report selection. In addition to Business Insights Explorer ad-hoc reporting, your traditional report data can be filtered to a specific range of data.

- All reports can be customized using Crystal Reports and Custom Office.

- Output choices include viewing on screen, printing to selected printers, PDF, using Paperless Office to send the report data through e-mail, and exporting the report data into Word or Excel.

- You can make selections based on straightforward terms such as: yesterday, today, tomorrow, last week, last month, 30 days or older, and so forth.

- Workflow is now streamlined to allow users to return to the report selection screen after previewing and printing reports to adjust selection criteria, vary data range, and more.

Memo Manager

- Memos, an electronic version of a Post-it™ note, can follow the workflow throughout your system to inform each user of any important information about the order, customer, or vendor.

- Settings allow the system administrator to determine if, where, and how the memos automatically open.

- You can attach documents to your memos, such as vendor purchase information, to make sure they are visible.
USABILITY AND WORKFLOW ADVANTAGES OF SAGE MAS 90 AND 200 BUSINESS FRAMEWORK™

User and Date Timestamps

Most actions are recorded and identified by the user who performed them and date and time stamped as to when they occurred. This provides you, other users, the administrator, and company management with valuable traceability information.

Setup Wizards

- Intuitive Windows-standard wizards assist you and other users in setting up and activating new modules or functionality in your system.

- When you purchase a new module, such as Inventory Management, or set up a new company the wizard will walk you through the available options. Also, when you use Business Insights Reporter, the wizard walks you through the report selection and filter process so you get reports with the data presented the way you want to see it.

- Business Insights Reporter users are not required to understand detailed data file structures; rather, they are provided with a simple list of business information, such as year-to-date sales or cost of goods sold. The selection can then be made based on meaningful terms to get the data the user wants to include in their report.

Fiscal Year and Period

The Business Framework allows each company to operate without the requirement to close each accounting period or year in General Ledger or other modules. Therefore, you can obtain a snapshot of your company’s financial position at any time by running reports for current, past, or future periods. This functionality is available for the Accounts Payable, Accounts Receivable, Bill of Materials, Inventory Management, Purchase Order, and Sales Order modules in version 4.40.
Flexible Security

Powerful security settings are set according to each role in your company. This flexible security enables you or your administrator to determine what type of activities, down to the task level, are allowed. For example, you may want to allow an accounting clerk to view Sales Order information, but not allow the ability to create or modify a sales order. You may also want the sales order entry person to be able to create and modify sales orders, but not have the ability to modify the credit terms.

Batch Manager

Increase your processing efficiencies using Batch Manager to create, verify, and merge batches. Effectively manage batches by numbering, modifying, or grouping using the Batch Entry feature. With unique batch numbers, more than one user can enter data in the same task and print and update independently, without affecting other batches.

Advanced Lookup Engine (ALE)

You can now resize ALE windows.

Object Interface - API

- Automatically provided as part of your system, the Business Object Interface enables integrations with other business applications through an interface layer. It enables tight integration capabilities, enforcing all business rules. These APIs can be used with Customizer to automate tasks such as creating a single-click reversing journal entry using a Visual Basic script.

- The Business Object Interface also empowers third-party developers to efficiently write add-on specialized programs for your Sage MAS 90 or 200 system.

Period End Processing

A new task, Period End Report Selection, was added to the Period End menu in Inventory Management and Purchase Order.
Chapter 3

Upgrading from 4.30 to 4.40

This chapter describes the differences made between the 4.30 to 4.40 releases. Installation and global changes are listed first followed by module changes and retirements.

Installation Changes

Before installing version 4.40, refer to your Installation and System Administrator’s Guide and to the Supported Platform Matrix located in the Support area of the Sage Online Web site (www.sagesoftwareonline.com) for operating system and hardware requirements.

Global Changes

Data File Multi-Segment

- Sage MAS 90 and 200 now support segmented files. Data files that are reaching the 2 GB limit will now be segmented. Adding the segmented feature available in ProvideX will enhance the product’s ability to handle large data files. For example, the previous need to purge data from history files when the files reached the 2 GB limit has been eliminated.

The following is an example of how a segmented file would look in a company’s data folder:

- IM_ItemTransactionHistory.M4T
- IM_ItemTransaction History.M4T.001
- IM_ItemTransactionHistory.M4T.002

- Index and sort files for modules that have not been upgraded to the Business Framework will not be segmented.
- The Rebuild utilities in Sage MAS 90 and 200 are now enhanced to accommodate segmented files and a progress meter will appear when running the rebuild process.
Chapter 3  Upgrading from 4.30 to 4.40

Activity Log

The Activity Log provides a log of all data removed and the date used. Previously, the data removed and date used was not recorded.

Advanced Lookup Engine (ALE)

- The ALE Conversion Utility has been renamed Lookup Conversion.

- When you are customizing a lookup in Bar Code, Bill of Materials, Inventory Management, and Purchase Order, you can add fields from linked files to the lookup.

- Customizations to lookups in Bar Code, Bill of Materials, Inventory Management, and Purchase Order will not be converted to your version 4.40 software. You will need to re-create lookup customizations for these modules. This includes customizations created in the User Lookup Wizard and by clicking Custom in a lookup window.

Batch Faxing

The fax number must include the area code to process a fax. Previously, if the fax number was within the local area, the area code was not required.

Character-Based Forms

All forms for Bar Code, Bill of Materials, Inventory Management, and Purchase Order are now printed using Crystal Reports. You can no longer print character-based, or nongraphical forms for these modules.

Customized Crystal Forms

- Customized Crystal forms in the Bar Code, Bill of Materials, Inventory Management, and Purchase Order modules will need to be re-created after upgrading to version 4.40.
• Run the Form Comparison report to compare your customized forms to a default form from the prior version. This report prints the form name, folder, .rpt name, form code, and any fields (including user-defined fields) that were added or removed from the standard forms shipped with version 4.x. Use this report as a reference to modify the default version 4.40 Crystal forms. This report (SYWFCU) is available on the product CD and on the Sage Online Web site at: www.sagesoftwareonline.com

Data Dictionary Changes

The Job Cost, Material Requirements Planning, and Work Order file layouts have been changed to accommodate the expanded item code and expanded customer number options.

Data Entry

• To access the Record Count functionality in the Bill of Materials, Inventory Management, and Purchase Order modules, right-click in a window and select System Info. The old method of pressing F8 is still available in the Payroll, Work Order, Materials Requirement Planning, and Job Cost modules.

• On the Lines tab of data entry windows in the Bill of Materials, Inventory Management, and Purchase Order modules, at a field, press F2 or click the Lookup button to access the lookup window. After entering the field, the Lookup button no longer appears; however, you can still press F2 to access the lookup window.

Expanded Customer Numbers

Reports and forms have changed to accommodate the expanded customer number field.

Expanded Item Codes

Reports and forms have changed to accommodate the expanded item code field.
Chapter 3  Upgrading from 4.30 to 4.40

Accounts Payable Changes

The Detail Receipt History task accessed from the Vendor Maintenance window has been renamed Vendor Receipt History.

Accounts Receivable Changes

The Detail Sales History task accessed from the Customer Maintenance window has been renamed Customer Sales History.

Bar Code Changes

Bar Code Options

The Graphical Forms field has been removed as the Bar Code module now uses Crystal Reports to print forms and reports.

Unattended Bar Code Transaction Import

ODB files are no longer imported using the Unattended Bar Code Transaction Import task. ODB files must now be imported using Import Bill of Materials Transactions, Import Inventory Transactions, Import Purchase Order Transactions, and Import Sales Order Transactions.

Renamed Tasks

- The Period End Processing task has been renamed Purge Bar Code History.
- The Bar Code P/O Receiver Printing task has been renamed Purchase Order Printing.
Bill of Materials Changes

Global Changes

- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

- You must re-create all Visual Integrator jobs to import bill of materials data.

Bill of Materials Options

- The option to Allow Entry of Negative Quantities no longer applies to Option Interaction Maintenance.

- If the Allow Kit Bills and/or the Allow Phantom Bills check boxes are cleared, a message dialog box will now appear in Bill of Materials Options. Previously, the message dialog box displayed in Bill of Materials Maintenance.

- You can now enter a unique next automatic disassembly number. Previously, Production Entry and Disassembly Entry shared the same option.

Data Entry

In all data entry windows, the Item Inquiry window has been replaced with the Item Quantity Inquiry window.

Inquiry Changes

- The Bill of Materials Inquiry and Bill of Materials Where-Used Inquiry windows have been re-designed with new fields and drill downs.

- The Options button in Bill of Materials Inquiry and Bill of Materials Where-Used Inquiry has been replaced with radio buttons for the different selections to inquire on. Additionally, a tree view now displays when the Indented view is selected.
Chapter 3  Upgrading from 4.30 to 4.40

Printing

- Reports and listings now use Crystal Reports. Because of this, the Bill of Materials module no longer uses the settings established in Library Master Report Format Maintenance.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field and uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box, so you can resolve the issue without losing your settings.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.

Reports and Forms

Report setting options now appear on the header area of the applicable report window. You can also define and save customized report settings. For more information, see Create a Report Setting in the Help system.
**Renamed, Removed, or Moved Tasks**

- All the inquiry windows on the Main menu have been moved to the Inquiries menu.

- The Replace/Delete Component Entry task on the Change Control menu has been renamed Replace and Delete Component Entry.

- The Replace/Delete Component Register has been renamed Replace and Delete Component Register.

- The Miscellaneous Charge Maintenance task on the Setup menu has been renamed Miscellaneous Item Maintenance. This task is also available from the Common Information Main menu.
Chapter 3  Upgrading from 4.30 to 4.40

Business Insights Changes

Business Insights Reporter

- After upgrading to version 4.40, you will need to re-create Business Insights Reporter reports used in Bill of Materials, Inventory Management, and Purchase Order.

- For custom reports previously created using version 4.30 or prior data from the Bill of Materials, Inventory Management, and Purchase Order modules, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Bill of Materials, Inventory Management, and Purchase Order modules.

NOTE
The Business Insights Reporter Definition Listing prints fields, sorts, and filters for the report you need to re-create.
Common Information Changes

Common Information Options

- The Number of Decimal Places fields, previously in the Inventory Management Options window on the Inventory Management Setup menu and in the Purchase Order Options window on the Purchase Order Setup menu, have been moved to the Common Information Options window on the Common Information Setup menu.

- The Years to Retain Item History field, previously in the Inventory Management Options window on the Inventory Management Setup menu, has been moved to the Common Information Options window on the Common Information Setup menu. Additionally, a minimum of two years is now required to retain history.

- If the Inventory Management module is not set up for a company, the Common Information period history will be accumulated based on the General Ledger fiscal year setup. If the Inventory Management module is set up, the history will be accumulated based on the selection made at the Base Inventory Periods On field in Inventory Management Options.

Renamed, Removed, or Moved Tasks

- The Unit of Measure Conversion Maintenance task, previously on the Inventory Management Setup menu, has been moved to the Common Information Setup menu.

- The Purge Miscellaneous Item History task has been renamed Purge Item History.
Chapter 3  Upgrading from 4.30 to 4.40

Customizer Changes

- You must re-create customized libraries for the Bill of Materials, Inventory Management, and Purchase Order modules after the migration process.

- Data entry user-defined fields (UDFs) for Bill of Materials, Inventory Management, and Purchase Order must be re-created in User-Defined Field and Table Maintenance after upgrading. After re-creating UDFs, you must map the UDFs to their respective history files. For more information, see Map User-Defined Fields (UDFs) in the Help system.

e-Business Manager Changes

Web Engine

- You must uninstall the Web engine, and then re-install it after upgrading to version 4.40.

- If you have customized templates in the IW folder, back them up in another location before uninstalling the Web engine. After uninstalling, you must merge your customized templates with the Standard templates as some have changed for corrections or enhancements.

- Enabling item code expansion (from 15 to 30 characters) can cause layout changes in your HTML templates when rendering in a browser. You should verify if your customized templates are affected.
General Ledger Changes

Fiscal Year Maintenance

- In Fiscal Year Maintenance, if you change an existing period-end date and/or year, the Item History by Period information is now included as part of the recalculation. Previously, the system recalculated only the General Ledger Posting History by Period and Sales Order Recap information.

- The functionality of the Recalculate button has been changed to recalculate only the Sales Order Recap information. Previously, clicking this button recalculated the General Ledger summary information. You can now use Recalculate Account Balances on the General Ledger Utilities menu to recalculate the General Ledger information.

Inventory Management Changes

Global Changes

- If the Inventory Management module is not set up for a company, the Common Information period history will be accumulated based on the General Ledger fiscal year setup. If the Inventory Management module is set up, the history will be accumulated based on the selection made at the Base Inventory Periods On field in Inventory Management Options.

- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

- You can now print receipt labels after printing or previewing the Transaction Register. Previously, you could only print the receipt labels before the update process.

- You must re-create all Visual Integrator jobs to import inventory data.
Chapter 3  Upgrading from 4.30 to 4.40

Inventory Management Options

- The ability to sort physical count by bin location, previously in the Inventory Management Options window on the Inventory Management Setup menu has been moved to the Physical Count Worksheet and Physical Count Entry tasks on the Physical Count menu. You can now select to print by bin location.

- The Number of Decimal Places fields, previously in the Inventory Management Options window on the Inventory Management Setup menu has been moved to the Common Information Options window on the Common Information Setup menu.

- The Retain Transaction History check box has been removed from the Inventory Management Options window. You can now use the Purge Item History utility on the Inventory Management or Common Information Utilities menu to purge transaction history. Additionally, at least 2 years retention is required.

- The ability to add a not-on-file warehouse has been removed. Validation occurs now when the warehouse code is entered. Previously, you were able to enter not-on-file warehouse codes.

- The next automatic entry numbers options have been moved to the new Entry tab. In addition, you can now enter alphanumeric and special characters.

Product Line Maintenance

The Allow Back Orders check box must first be selected to enable the Allow Returns check box. Selecting the Allow Returns check box will now be the entry default selection for items in the Item Maintenance window and can be applied to existing inventory items by clicking Apply. Previously, the Allow Back Orders and Allow Returns check boxes were both enabled, and an inventory item created with this product line then inherited these settings.
Transaction Entry

- You can now use the batch entry feature to perform multiple entry sessions simultaneously.

- You can now clear a previous distribution to enter a new distribution in the Distribution Entry window when adjusting an item. Previously, you had to enter a 0 (zero) at the Distribute field to clear the FIFO/LIFO/Lot/Serial Number and Receipt No. fields.

Item Maintenance

- Some hot keys have been changed to provide convenient shortcuts to tasks that are otherwise accessed through menu navigation. For a list of the updated hot keys, see Using Hot Keys in Item Maintenance in the Help system.

- The Standard Cost field can no longer be changed for standard cost items with activity. If activity exists, this field can only be viewed. Instead, use the new Standard Cost Adjustment Entry task to adjust the standard cost.

- You can now view the information on a grid by quantity, sales, or receipts by selecting the Quantities, Sales, or Receipts option on the new History tab. Previously, you had to click the History button on the Main tab to view item quantity, sales, or receipt information.

- Quantity information previously in the Quantity on Hand and Reorder windows, is now available on the Quantity tab. Reorder information can be accessed by clicking the Reorder button on the Quantity tab and on the drop-down menu.

- Buttons on the Main tab have been moved to the More button.
Chapter 3  Upgrading from 4.30 to 4.40

Physical Count Changes

- You can now print the Physical Count Worksheet by bin location and quantity on hand. Previously, the worksheet could only be printed by item code and item description, and the quantity on hand was not available to print.

- The Physical Count Entry task now checks the Sales Order, Return Merchandise Authorization, Bill of Materials, Purchase Order, and Work Order modules and displays a warning if unprocessed inventory transaction entries exist when trying to freeze the items. Previously, it only checked Inventory Management.

Costing Changes

- If an average cost item has negative quantity on hand, when items are received, the cost is adjusted only for the quantity received. Previously, the cost was adjusted for the entire negative quantity.

- The Inventory Detail Transaction Report, Inventory Trial Balance Report, and Inventory Valuation Report by Period now print the historical standard cost by default and a selection to print the current or historical cost is now available in the report windows. Previously, only the current standard cost was provided.

- The Automatic Cost and Price Change task is no longer used to change the standard cost for standard cost items. You must use Standard Cost Adjustment Entry on the Inventory Management Utilities menu to change the standard cost for standard cost items.
Utilities Menu

A new Utilities menu has been added to the Inventory Management module. The tasks available on this menu are:

- Delete and Change Items
- Purge Item History
- Remove Zero Quantity Costing Tiers
- Recalculate Item History
- Item Valuation Change Selection
- Item Valuation Change Maintenance
- Item Valuation Change Register/Update
- Automatic Cost and Price Change
- Standard Cost Adjustment Selection
- Standard Cost Adjustment Entry
- Stand Cost Adjustment Register/Update

Period End Processing

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Only Remove Detail History option has been replaced with the Purge Item History task on the Utilities menu.

- The Only Remove Costing Tiers with Zero Quantities option has been replaced with the Remove Zero Quantity Costing Tiers task on the Utilities menu.

- The Only Remove Transaction Detail option has been removed.
Chapter 3  Upgrading from 4.30 to 4.40

Printing

- You can now print receipt labels after printing or previewing the Transaction Register. Previously, you could only print receipt labels before the update process.

- The report and form windows now remain open when you receive the message dialog box stating there is no data in the range to print, so you can resolve the issue without losing your settings.

- Reports and listings now use Crystal Reports. Because of this, the Inventory Management module no longer uses the settings established in Library Master Report Format Maintenance.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field, and it uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.

Reports and Forms

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box, so you can resolve the issue without losing your settings.

- The Inventory Valuation Report by Period can now print items with zero balances and the unit cost for standard cost items can be viewed by current or historical transactions.
Renamed, Removed, or Moved Tasks

- The Inventory Maintenance and Inventory Inquiry tasks on the Main menu have been renamed Item Maintenance and Item Inquiry.

- The Sales Kit Listing on the Kits menu has been renamed Sales Kit Report.

- The Inventory Memo Printing report on the Reports menu has been renamed Item Memo Printing.

- The Item Masterfile Audit Report on the Reports menu has been renamed Item Audit Report.

- The U/M Conversion Maintenance task on the Setup menu has been renamed Unit of Measure Conversion Maintenance and moved to the Common Information Setup menu.

- The Buyer/Planner Code Maintenance task on the Setup menu has been renamed Buyer and Planner Code Maintenance.

- The Bar Code Printer Maintenance task on the Setup menu has been moved to the Work Order Setup menu.

- The Item Delete/Renumber/Merge option in the Inventory Management Utilities window on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Items.

- The Automatic Cost/Price Change task has been moved to the Utilities menu and renamed Automatic Cost and Price Change.

- The Transaction Journal task on the Main menu has been renamed Transaction Register.

- The ability to sort physical count by bin location, previously in the Inventory Management Options window on the Setup menu has been moved to the Physical Count Worksheet and Physical Count Entry tasks on the Physical Count menu.

- The name of the hidden utility, IMZBL1, has been changed to IM_BalanceQtyOnHand_UI.
Chapter 3  Upgrading from 4.30 to 4.40

Job Cost Changes

Job Cost Options

The Timberline Estimating and Directory for Estimating Database fields in the Job Cost Options window have been removed due to the retirement of Timberline Link.

Data Dictionary Changes

The file layouts have been changed to accommodate the expanded item code and expanded customer number options.

Payroll Changes

Taxes

In the Quarterly 941 Printing window, the Current Tax Withholding, Prior Quarter Social Sec/Medicare, Additions to Federal Tax, and Additions to Social Sec/Medicare fields have been removed. The COBRA Premium Assist. Payments and Individuals Provided COBRA Assist. fields are now added.
**Purchase Order Changes**

**Global Changes**

- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

- The Tabs button has been removed from data entry tasks and the settings are now available as part of the data entry grid.

- Batch processing is now handled through system Batch Manager programs. Previously, there was one Batch Processing option that applied to the data entry tasks. Receipt of Goods/Invoice Entry tasks have their own batch option and Return Of Goods/Material Requisition Issue Entry tasks have their own batch option.

- The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.

- Previously, historical data was stored by the period to date (PTD), year to date (YTD), last year, and future period. Purchase Order purchases and receipt history are now stored by period by year. The conversion for purchases and receipts history is now performed as follows:
  - The PTD record is converted to the current period.
  - The YTD record is converted to the period before the current period (for example, if the current period is June, then the total YTD amount should be in May).
  - The prior year record is converted to the last fiscal period of the prior year.
  - You must re-create all Visual Integrator jobs to import purchase order data.
Chapter 3  Upgrading from 4.30 to 4.40

Purchase Order Options

- The ability to create passwords or allow overrides to data entry security options has been removed from Purchase Order Options and replaced with a security event option in Role Maintenance on the Library Master Main menu.

- The Number of Decimal Places fields, previously in the Purchase Order Options window on the Purchase Order Setup menu, have been moved to the Common Information Options window on the Common Information Setup menu.

- The ability to inquire on a memo from an entry task has been replaced with the Memo Manager Maintenance task on the Common Information Main menu.

- Entry options have been moved to the Entry tab, line entry options have been moved to the Line Entry tab, printing options have been moved to the Printing tab, and history options have been moved to the History tab.

- You can now display all drop-ship lines from a sales order, regardless of the assigned purchase order vendor. Previously, when a drop-ship purchase order was entered, the drop-ship lines on the sales order would appear only if the vendor matched one of the vendors assigned to the item.

- You can now remove purchase history from the Purchase Order file by selecting the Purge Purchases History task on the Purchase Order Utilities menu. Previously, the purchase history was removed during period-end processing.

- You can now retain comment lines in receipt history. Previously, the Accounts Payable module controlled comments for receipt history.

- You can now select a format to use for posting comments to General Ledger.

- Additional fields have been added to print the Back Order Fill Report.
Purchases History

- Previously, purchase history was saved by period and month. With version 4.40 and higher, purchase history is now continuously saved by receipt date and posting date.

- You must now retain at least two years of purchase history at the Years to Retain Purchase History field in the Purchase Order Options window, with the option to retain up to 99 years.

Data Entry

- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in Purchase Order Entry, Receipt of Goods Entry, and Receipt of Invoice Entry.

- The Tabs button has been removed, and a Defaults button added to all data entry windows.

- You can now use a security event in Role Maintenance to prevent users from adding inventory items on the fly. Previously, the Allow On-the-Fly Additions of Inventory Items field was available in Purchase Order Options.

Utilities Menu

A new Utilities menu has been added to the Purchase Order module. The tasks available in this menu are:

- Purge Completed Purchase Orders
- Purge Expired Master/Repeating Orders
- Purge Completed or Cancelled PO Recap
- Purge Obsolete Purchase Orders
- Purge Purchase Order Receipt History
- Purge Purchases History
Chapter 3 Upgrading from 4.30 to 4.40

**Period End Processing**

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various options previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Purge Completed Purchase Orders option has been replaced with the Purge Completed Purchase Orders task.

- The Purge Expired Master/Repeating Orders option has been replaced with the Purge Expired and Master Repeating Order task.

- The Purge Completed or Cancelled PO Recap option has been replaced with the Purge Completed or Cancelled PO Recap task.

- The Purge Obsolete Purchase Orders option has been replaced with the Purge Obsolete Purchase Orders task. Additionally, records dated on or before the purge date entered has been removed.

- The Purge Purchase Order Receipt History option has been replaced with the Purge Purchase Order Receipt History task.

- The Purge Purchases History utility has been added to the Utilities menu to remove purchase history. Previously, the purchase history was removed during period-end processing.

**Printing**

- Reports and listings now use Crystal Reports. Because of this, the Purchase Order module no longer uses the settings established in Library Master Report Format Maintenance.

- The report and form windows now remain open when you receive the message dialog box stating there is no data in the range to print, so you can resolve the issue without losing your settings.
The process for exporting or printing a report to a file has changed. The
Print to File option previously available in the Printer Setup window has
been moved to the Export/E-mail option accessed from the Printer field
and it uses the Crystal Reports engine. For more information on how to
export or print reports to a file, see Export or Print to a File in the Help
system.

The process for deferring the printing of a report has changed. The
Deferred option has been moved to the Deferred option accessed from
the Printer field. This option was previously available in the Printer
Setup window. For more information on how to defer the printing of a
report, see Defer a Report in the Help system.

Print jobs scheduled for deferred printing are now located in the
..\Home\Deferred folder.

The font size on some reports was changed to allow the report to remain
in portrait format.

**Registers and Updates**

The Purchase Order Variance Register now prints after the register and
before the update. Previously, this register printed after the update.

**Reports and Forms**

- In the Back Order Fill Report, you can now print only the items that have
  a back ordered quantity on the sales order if the received quantity is not
  equal to zero. Previously, the report printed all items on the purchase
  order that had a back ordered quantity on the sales order.

- Report setting options now appear on the header area of the applicable
  report window. You can also define and save customized report settings.
  For more information, see Create a Report Setting in the Help system.

- The report and form windows now remain open when you receive the
  “Data is not selected for report printing” message dialog box, so you can
  resolve the issue without losing your settings.
Renamed, Removed, or Moved Tasks

- The Purge Completed Purchase Orders, Purge Expired Master/Repeating Orders, Purge Completed or Cancelled PO Recap, and Purge Obsolete Purchase Order utilities have been moved from the Period End Processing window to the Utilities menu.

- The Purge Purchase Order Receipt History and Purge Purchases History utilities have been added to the Utilities menu.

- The Open PO by Item Report has been renamed Open Orders by Item Report.

- The Open PO by Job Report has been renamed Open Orders by Job Report.

- The Receipt History Report has been renamed Purchase Order Receipt History Report.

- The Open PO by Work Order Report has been renamed Open Orders by Work Order Report.

- The Automatic Reorder Selection option has been renamed Auto Reorder Selection.

- The Ship to Address Maintenance task has been renamed Ship-To Address Maintenance.

- The Miscellaneous Charge Maintenance task has been renamed Miscellaneous Item Maintenance.

Return Merchandise Authorization Changes

Data Entry

The Item Inquiry window has been replaced with the Item Quantity Inquiry window in RMA Entry and RMA Receipts Entry.
Sales Order Changes

Security Option for Adding Inventory Items on the Fly

You can now use a security event in Role Maintenance to prevent users from adding inventory items on the fly. Previously, the Allow On-the-Fly Additions of Inventory Items field was available in Sales Order Options.

Data Entry

- In the Sales Order Entry window, the user login ID is now displayed if security is set up. Previously, the user code displayed.
- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in Sales Order Entry and Invoice Data Entry.

Reports

The Customer Sales History Report now prints by invoice date or posting date depending on whether you base inventory periods by physical periods or calendar months. Previously, this report was printed by period or month.

This same report also printed sales history by item or product line. Now you can print information using three new reports.

- Customer Sales History by Item
- Customer Sales History by Product Line
- Customer Sales History

Renamed, Removed, or Moved Tasks

- The Monthly Recap by Division has been renamed Sales Recap by Division.
- The Monthly Recap by Product Line has been renamed Sales Recap by Product Line.
- The Monthly Recap by Warehouse has been renamed Sales Recap by Warehouse.
Chapter 3  Upgrading from 4.30 to 4.40

• The Monthly Recap by Warehouse by Product Line has been renamed Sales Recap by Warehouse by Product Line.

Visual Integrator Changes

Import Job Maintenance

• You must re-create all Visual Integrator jobs to import inventory, bill of materials, and purchase order data.

• All data entry business objects now allow an existing line item in the Detail file to be modified. The Line Key field is now displayed in red and its value must be provided to edit an existing detail line. If the value provided is blank or invalid, a new detail line will be added from the import record.

• The ability to import lot and serial distribution records is now included in the related header import. In the Available Fields section of the Data tab, tier distribution fields are now available and are preceded by the letters LL. Previously, importing lot and distribution records was only available in Sales Order Invoice Data Entry and required a tier distribution record type using a pre-defined tier distribution import layout.

• In the Import Job Maintenance window, in the Available Selections section of the Record tab, the Change Next On option has been removed.

When evaluating the Header information in the Source file and a change is found, the next record is automatically created. It is important to have consistent Header information when importing multiple line and distribution records. For example, if the key value (sales order number) in the Source file is the same for three rows, and one field in each row has a different value, the subsequent row will replace the previous row imported with the same key.

• The Job Import Log now contains the record type to distinguish between Header, Line, and Distribution records. Previously, only the Header and Line records displayed. The Distribution records were appended to the Line records.
Work Order Changes

Moved Tasks

The Bar Code Printer Maintenance task, previously on the Inventory Management Setup menu, has been moved to the Work Order Setup menu.

Data Dictionary Changes

The file layouts have been changed to accommodate the expanded item code and expanded customer number options.

Retired Modules

Timberline

Timberline Link has been retired.

ACT! Link

ACT! Link has been retired.

SageCRM

SageCRM version 6.1 has been retired. This does not apply to Extended Enterprise Suite customers.
Chapter 3  Upgrading from 4.30 to 4.40
Chapter 4

Upgrading from Versions Prior to 4.30 to 4.40

This chapter describes the differences in the 4.0, 4.10, 4.20, 4.30, and 4.40 releases that you should be aware of. Installation and global changes are listed first followed by module retirements. For information on changes to specific modules, see chapters 5 through 23.

Installation Changes

⚠️ WARNING
If you are upgrading from any level prior to 3.71, you must first upgrade to Level 3.71, and then perform a parallel installation with version 4.40.

🔗 NOTE
Remote administration of the Application Server can be performed using a Terminal Services session because this functionality is not part of the Application Server.

Installing the Software

- Before installing version 4.40, refer to your Installation and System Administrator’s Guide and to the Supported Platform Matrix located in the Support area of the Sage Online Web site (www.sagesoftwareonline.com) for operating system and hardware requirements.

- If you have Level 3.x software and version 4.40 software installed on the same workstation, only install Crystal Reports XI Release 2 for Sage MAS 90 or 200 version 4.40 because only this version can read Crystal Reports in both level 3.x and version 4.x.

- The Sage MAS 200 Host and Host Enterprise Manager are no longer used for the Sage MAS 200 installation and are replaced by the Sage MAS 200 Application Server. For more information, refer to your Installation and System Administrator’s Guide.

- The option for installing Microsoft Internet Explorer is removed because the version of Internet Explorer required is now available with the supported versions of Windows.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Global Changes

Data File Multi-Segment

- Sage MAS 90 and 200 now support segmented files. Data files that are reaching the 2 GB limit will now be segmented. Adding the segmented feature available in ProvideX will enhance the product’s ability to handle large data files. For example, the previous need to purge data from history files when the files reached the 2 GB limit has been eliminated.

The following is an example of how a segmented file would look in a company’s data folder:

- IM_ItemTransactionHistory.M4T
- IM_ItemTransactionHistory.M4T.001
- IM_ItemTransactionHistory.M4T.002

- Index and sort files for modules that have not been upgraded to the Business Framework will not be segmented.

- The Rebuild utilities in Sage MAS 90 and 200 are now enhanced to accommodate segmented files and a progress meter will appear when running the rebuild process.

Activity Log

The Activity Log provides a log of all data removed and the date used. Previously, the data removed and date used was not recorded for 4.x level.

Advanced Lookup Engine (ALE)

- The ALE Conversion Utility has been renamed Lookup Conversion.

- When you are customizing a lookup in any module other than Job Cost, Material Requirements Planning, Payroll, and Work Order, you can add fields from linked files to the lookup.

NOTE
Contact your development partner if you have segmented files prior to version 4.40. Sage does not support the conversion of those segmented files.
GLOBAL CHANGES

Batch Faxing

The fax number must include the area code to process a fax. Previously, if the fax number was within the local area, the area code was not required.

Character-Based Forms

Forms for all modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order are printed using Crystal Reports. You can no longer print character-based or non-graphical forms for those modules.

Customized Crystal Forms

• Customized Crystal forms in all modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order will need to be re-created after upgrading to version 4.40.

• Run the Form Comparison report to compare your customized forms to a default form from the prior version. This report prints the form name, folder, .rpt name, form code, and any fields (including user-defined fields) that were added or removed from the standard forms shipped with version 4.x. Use this report as a reference to modify the default version 4.40 Crystal forms. This report (SYWFCU) is available on the product CD and on the Sage Online Web site at: www.sagesoftwareonline.com

Data Dictionary Changes

The Job Cost, Material Requirements Planning, and Work Order file layouts have been changed to accommodate the expanded item code and expanded customer number options.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Data Entry

- To access the Record Count functionality in any module other than Job Cost, Material Requirements Planning, Payroll, and Work Order, right-click in a window and select System Info. The old method of pressing F8 is still available in all other modules.

- On the Lines tab of data entry windows in any module other than Job Cost, Material Requirements Planning, Payroll, and Work Order, at a field, press F2 or click the Lookup button to access the lookup window. After entering the field, the Lookup button no longer appears; however, you can still press F2 to access the lookup window.

Desktop

- Task folders in your Level 3.x Launcher’s My Tasks area will not be migrated to your version 4.40 Desktop. You will need to re-create your task folders.

- Buttons on your Level 3.x Launcher’s Custom toolbar will not be migrated to your version 4.40 Desktop’s Custom toolbar. You will need to re-create your buttons on the Custom toolbar.

- The Business Desktop has been renamed Sage MAS 90 Desktop or Sage MAS 200 Desktop, as applicable.

- The Modules tab has been renamed Tasks.

- File layout and program information previously included in the Technical Reference and Support Guide is now accessible from the File Layouts and Program Information link on the Resources page.

- Tutorials have been moved to the new Tutorials page.

Expanded Customer Numbers

Reports and forms have changed to accommodate the expanded customer number field.
Global Changes

Expanded Item Codes
Reports and forms have changed to accommodate the expanded item code field.

Help System and Online Manuals

- The Help system has been expanded and updated to provide immediate access to all of the information previously found in the online PDF manuals.

- On the Contents tab of the Help system, the Module Help book contains links to individual Help systems for each module in Sage MAS 90 or 200. Under each module’s main book, Help topics are further categorized into books of topics regarding procedures, information about printing forms and reports, and glossary terms. You can select any grouping of Help topics to print at one time, as well as print individual Help topics. For more information, see Print a Book of Help Topics in the Help system.

- Also available on the Contents tab of the Help system is the Module PDFs book which contains links to individual PDFs for each module in Sage MAS 90 or 200. These PDFs have been specially constructed to allow you to easily print the overview information for each task in a module. The PDFs are organized according to the menu structure of the module. For more information, see Print a Module PDF in the Help system.

Inquiries

The Accounts Receivable Inquiry, RMA Inquiry, and Sales Order Inquiry tasks are available. These tasks were not available in version 4.10 only.

Migrating Level 3.x Data

The new file structures in versions 4.x provide flexibility for both Sage and Master Developers to make enhancements for you in the future. As a result, some steps must be taken to prepare your Level 3.x or 4.x data for migration to version 4.40.
During the migration process, user codes with leading blanks or special characters will not be migrated. You will need to re-create these user codes after the migration process. After migrating your data, print and review the System Conversion log.

Module and Accounting Dates

- The Library Master module now uses the Windows system date.

- Your date formats are now based on the Windows Regional Settings from your workstation for consistency across your entire desktop. Therefore, the default settings for Year Display Format and Year 2000 Default have been removed. The software does not support the “year first” Windows date format. If you enter a two-digit year, the century is determined by the century preferences setting in the Windows Regional Settings for your workstation.

- The F6 functionality which allowed you to toggle between a 2-digit year (05/31/10) and a 4-digit year (05/31/2010) has been removed to accommodate the Windows Regional Settings.

Printing

- All reports and listings in modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order now use Crystal Reports. Because of this, those modules no longer use the settings established in Library Master Report Format Maintenance.

- For reports and listings in modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order, the process for exporting or printing a report to a file has changed. In those modules, the Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field and uses the Crystal Reports engine. For more information on how to export or print reports to a file in these modules, see Export or Print to a File in the Help system.
GLOBAL CHANGES
Printing to a Dot Matrix Printer

- For reports and listings in modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order the process for deferring the printing of a report has changed. In those modules, the Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report in these modules, see Defer a Report in the Help system.

- The font size on some reports was changed to allow the report to remain in portrait format.

- Print jobs scheduled for deferred printing are now located in the following locations:
  - Job Cost, Material Requirements Planning, Payroll, and Work Order deferred files are located at ..\Home\Textout.
  - All other module files are located at ..\Home\Deferred.

Printing to a Dot Matrix Printer

- You can print to a dot matrix printer as long as the printer has a corresponding Windows printer driver and supports draft mode font to enable high-speed printing.

- A dot matrix form code is available for printing several forms. For more information, see Customize Dot Matrix Form Template in the Help system.

Registering Your Modules

You now have 45 days to access unregistered modules. Previously, you could access the module 40 times only.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Reports and Forms

- In modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order, report setting options now appear on the header area of the applicable report window. You can also define and save customized report settings. For more information, see Create a Report Setting in the Help system.

- The organization of reports on the Custom Reports menus will not be migrated from your Level 3.x software to version 4.40. Before upgrading, use the SUMNUA utility in your Level 3.x software to print copies of the existing Custom Reports menus’ organization to facilitate adding your reports to the Custom Reports menus in your version 4.40 software. To access the SUMNUA utility in your Level 3.x software, select File menu > Run. In the Run Program window, type SUMNUA.

- The information previously on the Main and Select tabs in report windows is now conveniently on one screen.

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box, so you can resolve the issue without losing your settings.

Security

- Version 4.0 introduced a new security model, which is role based rather than menu based. Security in your Level 3.x software will not be migrated to your version 4.40 software; however, you can choose to migrate users from your Level 3.x software to your version 4.40 software, if you select the Standard Security option during installation. To enable security, refer to your Installation and System Administrator’s Guide.

Selection Grids

In the selection grids, you can now enter the Value fields before selecting an operand.

When All is selected at the Operand field, the operand now changes automatically based on the Value fields entered. If you enter the first Value field only, the operand changes to Equal to, then if you enter the second Value field, the operand changes to Range.
Library Master Changes

Batch Faxing

You can set up batch faxing for the following forms using Report Manager:

- Statement Printing
- Accounts Receivable Invoice Printing
- Customer RMA Printing
- RMA Receiver Printing
- Sales Order Printing
- Picking Sheet Printing
- Sales Order Invoice Printing
- Purchase Order Printing

Previously, batch faxing for these forms was set up in the Fax Form Definition window. To set up batch fax options for these forms, select Library Master Setup menu > Report Manager. In the Report Manager window, select a form and click the Maintain button. In the Maintain window, click the Maintain Fax Options button.

Changed Tasks

- The Automatic Update process is now performed using Task Scheduler for modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order.

- Reports, registers, and journals in the General Ledger, Library Master, and Customizer modules and the Daily Transaction Register from subsidiary modules except for Job Cost, Material Requirements Planning, Payroll, and Work Order are now Crystal Reports. As a result, printers defined in Device Configurator no longer apply to printing these Crystal Reports. Use a Windows printer for printing the Crystal Reports.

- The Data File Display and Maintenance task has been enhanced with a new program. The new program determines if data is for Level 3.x or version 4.x. A new field lists the different secondary keys available and sorts the records in the file being displayed according to the key selected.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Reports

- For information about changes to deferred printing and printing to a file in Library Master reports, see Printing on page 56.
- For information about creating report settings in Library Master Reports, see Reports and Forms on page 58.
- The .rpt files for reports on the Custom Reports menu now have a new folder structure. To use your existing customized report files with version 4.0 or higher, you must add the .rpt files to the Custom Reports menu using the Menu wizard in Report Manager. The .rpt file names must end with "custom.rpt" to be added using the Menu Wizard. To access the Menu Wizard, select Library Master Setup menu > Report Manager. In the Report Manager window, click Add Report to Menu.

- The new folder structure for reports uses a combination of company code, task name, and form code or report setting name determined by the selections in the Add New Format window. Examples of the new folder structure are as follows:

  - For a specific company code, task name, and form code or report setting name:
    (...\MAS90\MAS_ABC\Reports\AR_InvoicePrinting\INVOICESSTD\*.rpt)

  - For a specific company code and task name and all form code or report setting names:
    (...\MAS90\MAS_ABC\Reports\AR_InvoicePrinting\*.rpt)

  - For all companies and specific task name and form code or report setting names:
    (...\MAS90\MAS_SYSTEM\Reports\AR_InvoicePrinting\INVOICESSTD\*.rpt)

  - For all companies, specific task name, and all form code or report setting names:
    (...\MAS90\MAS_SYSTEM\Reports\AR_InvoicePrinting\*.rpt)
Companies

A Copy button has been added to Company Maintenance, allowing you to copy data and forms from an existing company. As a result, the SVFCPY and SVDATA utilities have been removed.

Role Maintenance

- Roles set up to establish access to tasks, security events, and module options for modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order need to be verified after upgrading to version 4.40. New tasks, security events, and module options added for those modules are not selected for current roles after upgrading.

- When defining a role in Role Maintenance to provide users with access to Business Insights Reporter, select the Business Insights Reporter check box under Library Master > Setup Options. This check box was previously located under the Business Insights folder in Role Maintenance.

- You can now set up access to the Business Insights Dashboard for each user using the Dashboard Maintenance Wizard. The module options for the Business Insights Dashboard are removed from Role Maintenance.

- If you are upgrading from version 4.10, roles need to be verified for the Accounts Payable module and for the Accounts Receivable Inquiry, RMA Inquiry, and Sales Order Inquiry tasks. New tasks, security events, and module options added for this module are not selected for current roles after upgrading.

- Override passwords previously maintained in Bill of Materials, Inventory Management, and Purchase Order Options are now handled as security events in Role Maintenance.

- ODBC Security will not be migrated when upgrading to version 4.40 and needs to be re-created.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

URL Maintenance

You can use the URL Maintenance task to store URL information for the Electronic Reporting for W2 and 1099s module. Two URL codes and descriptions were created for the Social Security Administration (SSA) and the Internal Revenue Service (IRS). For more information, see Changes to Electronic Reporting for W2 and 1099 (Magnetic Media Reporting) on page 141.

Renamed, Removed, or Moved Tasks

- Information from the Preferences task has been moved to the User Maintenance, Company Maintenance, and System Configuration tasks. As a result, the Preferences task has been removed.

- Information from the Alternate Directory Maintenance task has been moved to the Change Data Location dialog box, which is accessed by clicking Change Data Location on the Company Maintenance Preferences tab. As a result, the Alternate Directory Maintenance task has been removed.

- The Role Maintenance task replaces the Menu Security Maintenance task.

- The functionality of the Resize Data Files task has been incorporated into the Rebuild Application Key Files task. As a result, the Resize Data Files task has been removed.

- The System Activity Log has been renamed Activity Log.

- The Uninstall Modules task has been added to the System Configuration task.

- The Chat functionality has been removed from the Master Console task.

- The functionality of the Visual Explorer task has been added to the right-click menu accessed from the Sage MAS 90 and 200 Desktop Tree View. As a result, the Visual Explorer task has been removed. For more information, see Open a Task in a Secondary Company in the Help system.

NOTE
For information about changes to the date format settings that previously resided in the Preferences task, see Module and Accounting Dates on page 56.
LIBRARY MASTER CHANGES  
Renamed, Removed, or Moved Tasks

- Registration information from the Product Registration Maintenance task has been moved to the System Configuration task. As a result, the Product Registration Maintenance task has been removed.

- The *part utility has been removed. Use the Installed Modules Listing on the Library Master Reports menu.

- The SVMUPD utility has been removed. Use the Menu Wizard in Report Manager window. For more information, see Reports on this page.

- For information about changes to tasks associated with the Advanced Lookup Engine, see Advanced Lookup Engine (ALE) on page 52.

- The FAS Link module has been renamed Fixed Assets.

- The following Library Master tasks have been removed because they are no longer needed:
  - Convert Evolution/2 Data Files
  - Maintain Explorer Menu
  - Rebuild Alternate Directory Pointers
  - Task Menu Maintenance
  - SVFCPY and SVDATA utilities
Accounts Payable Changes

Global Changes

- Aging for all vendors is now recalculated using the system date during the conversion of version 4.20 data.

- The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.

- Previously, historical data was stored by the period to date (PTD), year to date (YTD), last year, and future period. Accounts Payable vendor history is now stored by period by year. The conversion for vendor sales history is now performed as follows:
  
  - The PTD record is converted to the current period.
  
  - The YTD record is converted to the period before the current period (for example, if the current period is June, then the total YTD amount should be in May).
  
  - The prior year record is converted to the last fiscal period of the prior year.

- You can modify the history data by clicking the Fix button on the Vendor Maintenance History tab. This button is only available when security is enabled and the Allow Editing of History Data in Vendor Maintenance security event is selected in Role Maintenance.

- The Number of Months to Retain Check History option has been removed in 4.20. To retain or display check history in Vendor Maintenance, select the Track Detailed Invoice/Payment History check box in the Accounts Payable Options window.

- You can now post payments of existing invoices to the general ledger in addition to payments of new invoices entered on the fly. Select the Manual Check Register in Detail check box in the Accounts Payable Options window.

- Certain memos can now flow from entity to entity based on the document. For example, an invoice memo would flow to invoice history.
• Time and Billing lines are no longer converted because they can cause out-of-balance invoice totals that do not match the line totals. If you have the Time and Billing module installed, contact your Sage business partner before installing the upgrade.

Data Entry

• In the Manual Check Entry window, you can now add multiple general ledger distribution lines using the Create G/L Distribution button.

• The Credit Card Payment Transfer Details window displays transfer information for payments processed in version 4.20 and higher.

Period End Processing

• Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

• Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

  • The Only Remove Invoices with Zero Balances option has been replaced by the Remove Zero Balance Invoices task.

  • The Only Remove Temporary Vendors with Zero Balances option has been replaced by the Remove Temporary Vendors task.

  • The Only Clear Check History File option and the Purge Detailed Invoice/Payment History File options have been replaced by the Purge Accounts Payable History task.

  • The Purge Sales Tax History File option has been replaced by the Purge Sales Tax History task.

Reports and Forms

• Vendor Listing no longer prints the balance data. To print the balance information, print the new Vendor Listing with Balances.

• You can now print the remit-to address on checks using A/P Check Printing or Manual Check Printing without customizing the check form.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Renamed, Removed, or Moved Tasks

- The Detail Receipt History task accessed from the Vendor Maintenance window has been renamed Vendor Receipt History.

- The Update Purchase Vendor task has been renamed Purchase Vendor Transfer.

- Information that was previously on the Vendor Maintenance History tab has been moved to the Statistics and Summary tabs. History information is now maintained using period-sensitive data which removes the requirement for future buckets and mandatory module closing.

- The Vendor Delete/Renumber/Merge task previously on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Vendors.

- The Assign Vendor Schedules task previously on the Setup menu has been moved to the Utilities menu and renamed Assign Vendor Tax Schedules.

- The Sales Tax Calculation task previously on the Setup menu has been moved to the Utilities menu.

Accounts Receivable Changes

- The Detail Sales History task accessed from the Customer Maintenance window has been renamed Customer Sales History.

Customer Statements

You must now set up the Paperless Office module to e-mail statements to customers. Previously, to e-mail customer statements, you had to select the E-mail Statements check box in Customer Maintenance and then select the appropriate option at the Produce Statements For field in the Statement Printing window. For more information, see Set Up Paperless Office in the Help system.

- Certain memos can now flow from entity to entity based on the document. For example, an invoice memo would flow to invoice history.
Global Changes

- Aging for all customers is now recalculated using the system date during the conversion of Version 4.10 data.

- The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.

- You can modify the history data by clicking the Fix button on the Customer Maintenance History tab. This button is only available when security is enabled and the Allow Editing of History Data in Customer Maintenance security event is selected in Role Maintenance.

- Previously, the historical data was stored by Period to Date (PTD), Year to Date (YTD), Last Year, and Future period. Accounts Receivable customer sales history is now stored by period by year. The conversion for customer sales history is now performed as follows:
  
  - The PTD record is converted to the Current Period.
  
  - The YTD record is converted to the period before the Current Period. For example, if the Current Period is June, then the total YTD amount should be in May.
  
  - The Prior Year record is converted to the last Fiscal Period of the Prior Year.

Period End Processing

- The Salesperson Commission Purge task, previously on the Period End menu, has been moved to the Utilities menu.

- Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

- Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:
  
  - The Only Remove Temporary Customers with Zero Balances option has been replaced by the Remove Temporary Customers task.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

- The Only Remove Invoices with Zero Balances option has been replaced by the Remove Zero Balance Invoices task.

- The Only Purge Sales Tax History File option has been replaced by the Purge Sales Tax History task.

- The Only Clear Invoice/Shipping History File option has been replaced by the Purge Accounts Receivable History task.

- The Only Recalculate Customer High Balances option has been replaced by the Recalculate Customer High Balances task.

Renamed, Removed, or Moved Tasks

- Information that was previously on the Customer Maintenance History tab has been moved to the Customer Maintenance Statistics and Summary tabs. History information is now maintained using period-sensitive data which removes the requirement for future buckets and mandatory module closing.

- The following tasks previously on the Setup menu have been moved to the Utilities menu: Global Customer Field Change, Sales Tax Calculation, and Internet Customers Enable/Purge.

- The Delete/Renumber/Merge task previously on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Customers.
Bar Code Changes

Bar Code Options

The Graphical Forms field has been removed as the Bar Code module now uses Crystal Reports to print forms and reports.

Unattended Bar Code Transaction Import

ODB files are no longer imported using the Unattended Bar Code Transaction Import task. ODB files must now be imported using Import Bill of Materials Transactions, Import Inventory Transactions, Import Purchase Order Transactions, and Import Sales Order Transactions.

Renamed Tasks

- The Period End Processing task has been renamed Purge Bar Code History.
- The Bar Code P/O Receiver Printing task has been renamed Purchase Order Printing.
Bill of Materials Changes

Global Changes

- You must re-create all Visual Integrator jobs to import bill of materials data.

- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

Bill of Materials Options

- The option to Allow Entry of Negative Quantities no longer applies to Option Interaction Maintenance.

- If the Allow Kit Bills and/or the Allow Phantom Bills check boxes are cleared, a message dialog box will now appear in Bill of Materials Options. Previously, the message dialog box displayed in Bill of Materials Maintenance.

- You can now enter a unique next automatic disassembly number. Previously, Production Entry and Disassembly Entry shared the same option.

Data Entry

In all data entry windows, the Item Inquiry window has been replaced with the Item Quantity Inquiry window.

Inquiry Changes

- The Bill of Materials Inquiry and Bill of Materials Where-Used Inquiry windows have been re-designed with new fields and drill downs.

- The Options button in Bill of Materials Inquiry and Bill of Materials Where-Used Inquiry has been replaced with radio buttons for the different selections to inquire on. Additionally, a tree view now displays when the Indented view is selected.
Printing

- Reports and listings now use Crystal Reports. Because of this, the Bill of Materials module no longer uses the settings established in Library Master Report Format Maintenance.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field and uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defe a Report in the Help system.

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box, so you can resolve the issue without losing your settings.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.

Reports and Forms

Report setting options now appear on the header area of the applicable report window. You can also define and save customized report settings. For more information, see Create a Report Setting in the Help system.
Renamed, Removed, or Moved Tasks

- All the inquiry windows on the Main menu have been moved to the Inquiries menu.

- The Replace/Delete Component Entry task on the Change Control menu has been renamed Replace and Delete Component Entry.

- The Replace/Delete Component Register has been renamed Replace and Delete Component Register.

- The Miscellaneous Charge Maintenance task on the Setup menu has been renamed Miscellaneous Item Maintenance. This task is also available from the Common Information Main menu.

Business Insights Changes

Business Insights Dashboard

- To take advantage of the Business Insights Dashboard’s upgraded architecture, you must set up your Dashboard pages again. For more information, see Set Up Business Insights Dashboard in the Help system.

- Internet Explorer 6.0 or higher is required to view the Dashboard pages.

- You can now set up access to the Business Insights Dashboard for each user using the Dashboard Maintenance Wizard. The module options for the Business Insights Dashboard are removed from Role Maintenance.

- In the Top Customer view, the Year to Date field now excludes future-dated transactions that are in the same year. The new Business Insights Dashboard displays the information as of the date entered. If a date is not entered, the information is displayed as of the period-end date.
Business Insights Reporter

- You must activate the Business Insights module to use Business Insights Reporter.

- When defining a role in Role Maintenance to provide users with access to Business Insights Reporter, select the Business Insights Reporter check box under Library Master > Setup Options. This check box was previously located under the Business Insights folder in Role Maintenance.

- After upgrading to version 4.40, you will need to re-create Business Insights Reporter reports used in a previous 4.x version of the software.

- For custom reports previously created using version 4.30 or prior data from the Bill of Materials, Inventory Management, and Purchase Order modules, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Bill of Materials, Inventory Management, and Purchase Order modules.

- For custom reports previously created using version 4.10 or prior data from the Accounts Payable module, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Accounts Payable module.

- For custom reports previously created using version 4.05 or prior data from the Accounts Receivable, Bank Reconciliation, General Ledger, Library Master, Return Merchandise Authorization, or Sales Order modules, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Accounts Receivable, Bank Reconciliation, Return Merchandise Authorization, and Sales Order modules.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

- For custom reports previously created for all other modules, select Library Master Utilities menu > Rebuild Business Insights Reporter Views to rebuild custom reports created with Business Insights Reporter in a previous 4.x version of the software.

- The Business Insights tasks are now on a separate module menu. Previously, the Business Insights tasks were located in a menu under the Library Master module. Business Insights is now organized on three submenus: Dashboard, Explorer, and Reporter.

Business Insights Explorer

The new Business Insights Explorer, which provides an alternative method of accessing data, is now available from the Desktop Tree view and menu. Predefined views of customers, quotes, sales orders, and invoices are available, providing a way to quickly view related data and navigational links to other inquiries or tasks.

Global Changes

After upgrading to Version 4.40, you will need to re-create Business Insights Reporter reports used in a previous 4.x version of the software.

- For custom reports previously created using data from the Accounts Receivable, Bank Reconciliation, General Ledger, Library Master, Return Merchandise Authorization, or Sales Order modules, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. The Business Insights Reporter Definition Listing prints fields, sorts, and filters for the report you need to re-create. Repeat this process for each custom report previously created for the Accounts Receivable, Bank Reconciliation, Return Merchandise Authorization, and Sales Order modules.

- For custom reports previously created for all other modules, select Library Master > Utilities > Rebuild Business Insights Reporter Views to rebuild custom reports created with Business Insights Reporter in a previous 4.x version of the software.
Menu Organization

- The Business Insights tasks are now on a separate module menu. Previously, the Business Insights tasks were located in a menu under the Library Master module. Business Insights is now organized on two submenus: Dashboard and Reporter.

- The Business Insights Reporter menu includes the tasks, Business Insights Reporter, and Business Insights Reporter Listing. You can use Business Insights Reporter to create Crystal Reports for all modules. These reports can optionally be added to the Custom Reports menu for a specified module.

Renamed Tasks

Under the Business Insights Dashboard menu, the following tasks have been renamed:

- Business Insights Options has been renamed Dashboard Options.

- Business Insights Wizard has been renamed Dashboard Selection Wizard.

- Business Insights Listing has been renamed Dashboard Selection Listing.

- Display Business Insights has been renamed Display Dashboard.

- Business Insights Automatic Update has been renamed Start Automatic Dashboard Update.
Common Information Changes

Miscellaneous Item Maintenance

- Miscellaneous Item Maintenance has been added to the Common Information Main menu. This task remains on the Bill of Materials Setup menu and Purchase Order Setup menu.

- Sales codes and miscellaneous items, part of the Accounts Receivable and Sales Order modules, are now referred to as Miscellaneous items and are stored in a common file shared by both modules.

- Miscellaneous items are now designated by the following item types: Miscellaneous items, Charge items, and Comment items. Comment codes are now referred to as Comment items and Miscellaneous Charges are now referred to as Charge items.

Common Information Options

- The Number of Decimal Places fields, previously in the Inventory Management Options window on the Inventory Management Setup menu and in the Purchase Order Options window on the Purchase Order Setup menu, have been moved to the Common Information Options window on the Common Information Setup menu.

- The Years to Retain Item History field, previously in the Inventory Management Options window on the Inventory Management Setup menu, has been moved to the Common Information Options window on the Common Information Setup menu. Additionally, a minimum of two years is now required to retain history.

- If the Inventory Management module is not set up for a company, the Common Information period history will be accumulated based on the General Ledger fiscal year setup. If the Inventory Management module is set up, the history will be accumulated based on the selection made at the Base Inventory Periods On field in Inventory Management Options.
Renamed, Removed, or Moved Tasks

- The Unit of Measure Conversion Maintenance task, previously on the Inventory Management Setup menu, has been moved to the Common Information Setup menu.

- The Purge Miscellaneous Item History has been renamed Purge Item History.

- Purge Obsolete Extended Descriptions, previously on the Library Master Utilities menu, has been moved to the Common Information Utilities menu.

- The Bank ID Number field in the Bank Code Maintenance window has been renamed Bank Account Number.

- Bank Code Maintenance has been added to the Common Information Main menu. This task remains on the Accounts Payable Setup menu, Accounts Receivable Setup menu, Bank Reconciliation Main menu, and Payroll Setup menu.

- Memo Manager Maintenance, previously on the Library Master Setup menu, has been moved to the Common Information Main menu. This task remains on the Accounts Payable, Accounts Receivable, General Ledger, Inventory Management, Purchase Order, Return Merchandise Authorization, and Sales Order Setup menus.

- Sales Tax Account Maintenance has been added to the Common Information Main menu. This task remains on the Accounts Payable Setup menu and Accounts Receivable Setup menu.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Customizer Changes

- Customized libraries for modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order will not be migrated and must be re-created after the migration process.

- Data entry user-defined fields (UDFs) must be re-created in User-Defined Field and Table Maintenance after upgrading to version 4.40. After re-creating UDFs, you must map the UDFs to their respective history files. For more information, see Map User-Defined Fields (UDFs) in the Help system.

- For information about changes to deferred printing and printing to a file in Customizer reports, see Printing on page 56.

- For information about creating report settings in Customizer reports, see Reports and Forms on page 58.

- For information about upgrading from versions prior to 4.30 to 4.40, see Changes to Customizer on page 133.
e-Business Manager Changes

Web Engine

- You must uninstall the Web Engine, and then re-install it after upgrading to version 4.40.

- If you have customized templates in the IW folder, back them up in another location before uninstalling the Web engine. After uninstalling, you must merge your customized templates with the Standard templates as some have changed for corrections or enhancements.

- Enabling item code expansion (from 15 to 30 characters) can cause layout changes in your HTML templates when rendering in a browser. You should verify if your customized templates are affected.

Global Changes

- The Microsoft Web Publishing Wizard is no longer installed or supported. You must now publish e-Business Manager images, JavaScripts, and style sheets to the Internet Information Server (IIS) using your own FTP software. For more information, see Publish Files to the Internet in the e-Business Manager Help system.

- The Publish Files to Web task, which was located on the Setup menu, has been removed as it used the Microsoft Web Publishing Wizard which is no longer supported.

- The polling process that formerly performed the real-time automatic updates for user IDs, customers, and sales orders from the Web engine has been removed. The options that controlled how often the polling process polled for shopping cart entries and customer/user ID changes have therefore also been removed from IT Options.

- You can no longer enter the SMTP server address in IT Options. It must be entered in Company Maintenance in the Library Master module before you can generate e-mail in e-Business Manager.
Electronic Reporting for W2 and 1099 (Magnetic Media Reporting)

Global Changes

- The Magnetic Media Reporting module has been renamed Electronic Reporting for W2 and 1099s to accurately reflect the new process required by the federal government.

- Starting from the 2006 tax year, the Internal Revenue Service (IRS) requires that all payroll and 1099 filings be performed electronically through the Internet. The federal government will no longer accept W2 and 1099 information on any type of magnetic media (diskette). In Sage MAS 90 and 200, you can continue to create a data file compliant with the IRS published standards and save it on the hard disk.

- Some states may still require or accept filings submitted on magnetic media. If your state supports the Federal reporting format and accepts submissions on a diskette, you can create the state diskette by copying the data file you created to a 3.5" diskette. If your state does not support the Federal reporting format, the Electronic Reporting module cannot create your electronic file.

- The new Electronic File Transfer task allows you to launch the appropriate government Web site to submit W2 and 1099 files.

- You can store the URL information for Electronic Reporting in Library Master URL Maintenance. Two URL codes and descriptions were created for the Social Security Administration (SSA) and Internal Revenue Service (IRS).

- The 1099 Magnetic Media Reporting window was renamed 1099 Electronic Reporting. The default disk drive to use is now C.

- The W2 Magnetic Media Reporting window was renamed W2 Electronic Reporting. The default disk drive to use is now C.

- The Mag Media Tax Type Code field in the Payroll Tax Table Maintenance window was renamed Electronic Reporting Tax Type Code.
Fixed Assets Changes

Global Changes

- The FAS Link module has been renamed Fixed Assets.

- The new Fixed Assets Maintenance task is now available on the Fixed Assets Main menu if Sage MAS 90 and 200 Fixed Assets is installed and the Fixed Assets module is activated.

General Ledger Changes

Fiscal Year Maintenance

- In Fiscal Year Maintenance, if you change an existing period-end date and/or year, the Item History by Period information is now included as part of the recalculation. Previously, the system recalculated only the General Ledger Posting History by Period and Sales Order Recap information.

- The functionality of the Recalculate button has been changed to recalculate only the Sales Order Recap information. Previously, clicking this button recalculated the General Ledger summary information. You can now use Recalculate Account Balances to recalculate the General Ledger information.

Accounts

The ability to have a large general ledger account number of up to 32 characters and 10 segments means that the way in which accounts are maintained has changed. The main account (also known as the natural account) is now maintained separately from the other individual segments. As a result, the system has changed in the following ways:

- The copy function is no longer available in Account Maintenance. The copy function is now available in Main Account Maintenance and Sub Account Maintenance.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

- The process for creating new accounts in Account Maintenance has changed. To create an account in Account Maintenance, you must enter a valid combination of an existing main account and sub accounts. For more information, see Create and Maintain Accounts in Account Maintenance in the Help system.

- Options which control how general ledger accounts can be created and added on the fly have changed in General Ledger Options. The Add new accounts from data entry check box has been removed and replaced with the Auto Create when all Segments are Valid field, Add Main Accounts in General Ledger check box, and Add Sub Accounts in General Ledger check box. For more information about these fields, see General Ledger Options in the Help system.

Allocations

To support new features in allocations, as well as to make the terminology more intuitive, the following changes were made in the system:

- The Allocation Maintenance task has been renamed Allocation Entry. The Allocation Entry task is accessed by selecting General Ledger Main menu > Allocation Entry.

- The Allocation Entry task has been renamed Manual Allocation Entry. The Manual Allocation Entry task is accessed by selecting General Ledger Main menu > General Journal Entry. In the General Journal Entry window, click Copy From. In the Copy From window, select the Allocation option and click OK.

- The method of calculating masked allocation distributions has changed. The allocation is now calculated first, then the total amount is distributed to all the accounts that match the masked account. Previously, the allocation percent/quantity entered was distributed to each account that matched the masked account.
• The activity or balance for Period, Quarterly, and Annual allocation cycles is now allocated based on the entire selected cycle rather than just the period ending that cycle. For example, now a quarterly allocation distributes the activity for the entire quarter. Previously, quarterly and annual allocations used the activity for the current period as the allocation amount. For example, previously a quarterly allocation generated at the end of the third period used only the activity for period 3, not the activity for periods 1, 2, and 3.

• In Allocation Selection, there are now separate allocation totals for financial and nonfinancial allocations.

Custom Financials

In order to have maximum flexibility and customization capabilities, you should use FRx for your custom financial reporting needs; however, Sage recognizes that you may have expended considerable time and effort in creating custom financial reports and want to continue using them. Although the Custom Financials menu has been removed, it can still be accessed by using a hidden utility, as long as you do not expand your general ledger account beyond nine characters and three segments.

• You can access the Custom Financials menu and tasks by selecting File > Run and typing *unhidegl in the Run Program window.

• The Custom Financials tasks can only be accessed if you have general ledger account numbers with nine or fewer characters and three or fewer segments.

Standard Financials

The Standard Financial Statements have been renamed Financial Reports and have been enhanced to include the former Monthly Trend Report.

Data Entry

• The system now calculates beginning balances for each fiscal year based on prior year data. As a result, the Beginning Balance (BB) source journal has been removed. To post beginning balances for a new company, you must enter them as journal entries to your general ledger accounts and update them.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

- In Transaction Journal Entry, the logic for the offset postings has changed. The Debit/Credit field has been renamed Offset field. During conversion, the source journal orientation will be changed to Credit if it was previously Debit, and it will be changed to Debit if it was previously Credit. Previously, the value selected at the Debit/Credit field determined the orientation of the lines. Now the value selected at the Offset field determines the orientation of the offset only.

- When you use General Ledger Exchange to import transactions into the General Ledger module, transactions now import to the General Journal Entry files. Previously, transactions were imported directly to the history files. This change was made because of the large number of inter-related tables that must be updated and linked when each transaction is posted. After the import is complete, the General Journal must be printed and updated.

**Period End Processing**

Many of the functions previously found in Period End Processing have been moved. Only full period-end processing can be performed from this task. In addition, to support the reopening and closing of periods, the Fiscal Year Consolidation and Consolidate Detail Records logic has been removed. Previously, you could perform the following tasks from Period End Processing:

- Full period-end processing
- Consolidate General Ledger Detail Records
- Purge Transaction Detail History
- Purge Period Summary History

The new location of various functions follows:

- The Clear Next Year Current Budgets logic is now performed in Budget Maintenance.

- The Purge Transaction Detail History task has been renamed Purge General Ledger History and is now accessible from the General Ledger Utilities menu.
• Journal and register numbers are now reset separately based on the selections at the Reset Journal Numbers During and Reset Register Numbers During fields in the General Ledger Options window.

The following changes have been made to year-end processing:

• The Years to Retain General Ledger History field in the General Ledger Options window now applies to both summary and detail history information. As a result, the Number of Years to Retain Summary History field in the General Ledger Options window has been removed.

• The Posting to Retained Earnings and Updating Beginning Balances logic has been removed as this is now done through the data entry update routines and the Daily Transaction Register. If the next fiscal year has not been created, year-end processing will create the next fiscal year and recalculate beginning balances.

• Zero budget accounts are now removed from the Period Budget Detail file when all periods for any year are zero.

• The Copy Budget at Year End option has been modified to use the new Copy Actual to Default Budget at Year End check box in the General Ledger Options window.

Reports

• The Budget and History Report has been separated into two reports, the Budget and History Report and the Budget and History Report by Period.

• The Standard Financial Statements have been renamed Financial Reports. The Financial Reports now include the former Monthly Trend Report.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Renamed and Removed Tasks

- To provide more flexibility in giving users access to tasks, the Account Inquiry task is now a security event. To give users access to Account Inquiry, use Library Master Role Maintenance to set up users with View Only access to Account Maintenance.

- The Account Maintenance task has been removed from all subsidiary modules because all installations require the General Ledger module.

- The Account Group Maintenance task replaces the Account Break Maintenance task. In Version 4.0, the term account group is now used in place of account break.

- The Sub Account Maintenance task replaces the Department Maintenance task.
Inventory Management Changes

Global Changes

- If the Inventory Management module is not set up for a company, the Common Information period history will be accumulated based on the General Ledger fiscal year setup. If the Inventory Management module is set up, the history will be accumulated based on the selection made at the Base Inventory Periods On field in Inventory Management Options.

- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

- You can now print receipt labels after printing or previewing the Transaction Register. Previously, you could only print the receipt labels before the update process.

- You must re-create all Visual Integrator jobs to import inventory data.

Inventory Management Options

- The ability to sort physical count by bin location, previously in the Inventory Management Options window on the Setup menu has been moved to the Physical Count Worksheet and Physical Count Entry tasks on the Physical Count menu. You can now select to print by bin location.

- The Number of Decimal Places fields, previously in the Inventory Management Options window on the Inventory Management Setup menu has been moved to the Common Information Options window on the Common Information Setup menu.

- The Retain Transaction History check box has been removed from the Inventory Management Options window. You can now use the Purge Item History utility on the Inventory Management or Common Information Utilities menu to purge transaction history. Additionally, at least 2 years retention is required.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

- The ability to add a not-on-file warehouse has been removed. Validation occurs now when the warehouse code is entered. Previously, you were able to enter not-on-file warehouse codes.

- The next automatic entry numbers options have been moved to the new Entry tab. In addition, you can now enter alphanumeric and special characters.

**Product Line Maintenance**

The Allow Back Orders check box must first be selected to enable the Allow Returns check box. Selecting the Allow Returns check box will now be the entry default selection for items in the Item Maintenance window and can be applied to existing inventory items by clicking Apply. Previously, the Allow Back Orders and Allow Returns check boxes were both enabled, and an inventory item created with this product line then inherited these settings.

**Transaction Entry**

- You can now use the batch entry feature to perform multiple entry sessions simultaneously.

- You can now clear a previous distribution to enter a new distribution in the Distribution Entry window when adjusting an item. Previously, you had to enter a 0 (zero) at the Distribute field to clear the FIFO/LIFO/Lot/Serial Number and Receipt No. fields.

**Item Maintenance**

- Some hot keys have been changed to provide convenient shortcuts to tasks that are otherwise accessed through menu navigation. For a list of the updated hot keys, see Using Hot Keys in Item Maintenance in the Help system.

- The Standard Cost field can no longer be changed for standard cost items with activity. If activity exists, this field can only be viewed. Instead, use the new Standard Cost Adjustment Entry task to adjust the standard cost.
INVENTORY MANAGEMENT CHANGES

Physical Count Changes

- You can now view the information on a grid by quantity, sales, or receipts by selecting the Quantities, Sales, or Receipts option on the new History tab. Previously, you had to click the History button on the Main tab to view item quantity, sales, or receipt information.

- Quantity information previously in the Quantity on Hand and Reorder windows, is now available on the Quantity tab. Reorder information can be accessed by clicking the Reorder button on the Quantity tab and on the More button.

- Buttons on the Main tab have been moved to the More button.

Physical Count Changes

- You can now print the Physical Count Worksheet by bin location and quantity on hand. Previously, the worksheet could only be printed by item code and item description, and the quantity on hand was not available to print.

- The Physical Count Entry task now checks the Sales Order, Return Merchandise Authorization, Bill of Materials, Purchase Order, and Work Order modules and displays a warning if unprocessed inventory transaction entries exist when trying to freeze the items. Previously, it only checked Inventory Management.

Costing Changes

- If an average cost item has negative quantity on hand, when items are received, the cost is adjusted only for the quantity received. Previously, the cost was adjusted for the entire negative quantity.

- The Inventory Detail Transaction Report, Inventory Trial Balance Report, and Inventory Valuation Report by Period now print the historical standard cost by default and a selection to print the current or historical cost is now available in the report windows. Previously, only the current standard cost was provided.

- The Automatic Cost and Price Change task is no longer used to change the standard cost for standard cost items. You must use Standard Cost Adjustment Entry on the Inventory Management Utilities menu to change the standard cost for standard cost items.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Utilities Menu

A new Utilities menu has been added to the Inventory Management module. The tasks available in this menu are:

- Delete and Change Items
- Purge Item History
- Remove Zero Quantity Costing Tiers
- Recalculate Item History
- Item Valuation Change Selection
- Item Valuation Change Maintenance
- Item Valuation Change Register/Update
- Automatic Cost and Price Change
- Standard Cost Adjustment Selection
- Standard Cost Adjustment Entry
- Standard Cost Adjustment Register/Update

Period End Processing

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Only Remove Detail History option has been replaced with the Purge Item History task on the Utilities menu.

- The Only Remove Costing Tiers with Zero Quantities option has been replaced with the Remove Zero Quantity Costing Tiers task on the Utilities menu.

- The Only Remove Transaction Detail option has been removed.
Printing

- You can now print receipt labels after printing or previewing the Transaction Register. Previously, you could only print receipt labels before the update process.

- The report and form windows now remain open when you receive the message dialog box stating there is no data in the range to print so you can resolve the issue without losing your settings.

- Reports and listings now use Crystal Reports. Because of this, the Inventory Management module no longer uses the settings established in Library Master Report Format Maintenance.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field, and it uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Reports and Forms

- The report and form windows now remain open when you receive the “Data is not selected for report printing” message dialog box so you can resolve the issue without losing your settings.

- The Inventory Valuation Report by Period can now print items with zero balances and the unit cost for standard cost items can be viewed by current or historical transactions.

Renamed, Removed, or Moved Tasks

- The Inventory Maintenance task on the Main menu has been renamed Item Maintenance.

- The Inventory Inquiry task on the Main menu has been renamed Item Inquiry.

- The Sales Kit Listing on the Kits menu has been renamed Sales Kit Report.

- The Inventory Memo Printing report on the Reports menu has been renamed Item Memo Printing.

- The Item Masterfile Audit Report on the Reports menu has been renamed Item Audit Report.

- The U/M Conversion Maintenance task on the Setup menu has been renamed Unit of Measure Conversion Maintenance and moved to the Common Information Setup menu.

- The Buyer/Planner Code Maintenance task on the Setup menu has been renamed Buyer and Planner Code Maintenance.

- The Bar Code Printer Maintenance task on the Setup menu has been moved to the Work Order Setup menu.

- The Item Delete/Renumber/Merge option in the Inventory Management Utilities window on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Items.
JOB COST CHANGES

Job Cost Options

The Item Valuation Change Selection, Item Valuation Change Maintenance, and Item Valuation Change Register options in the Inventory Management Utilities task on the Setup menu have been moved to the Utilities menu.

The Automatic Cost/Price Change task has been moved to the Utilities menu and renamed Automatic Cost and Price Change.

The Transaction Journal task on the Main menu has been renamed Transaction Register.

The name of the hidden utility, IMZBL1, has been changed to IM_BalanceQtyOnHand_UI.

Job Cost Changes

Job Cost Options

The Timberline Estimating and Directory for Estimating Database fields in the Job Cost Options window have been removed due to the retirement of Timberline Link.

Data Dictionary Changes

The file layouts have been changed to accommodate the expanded item code and expanded customer number options.
Payroll Changes

Direct Deposits

- In the Direct Deposit Interface Setup window, the account numbers can now only be viewed. The account numbers can be changed using Bank Code Maintenance.

- The Space Rather Than Dash in the Word 'Pre-Note' check box is now available in the Direct Deposit Interface Setup window. Previously, this check box was in the Extended Solution's PR-1017 Setup Options window.

- During conversion, if there is a discrepancy between the bank ID (bank account) number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

Taxes

- In the Quarterly 941 Printing window, the Current Tax Withholding, Prior Quarter Social Sec/Medicare, Additions to Federal Tax, and Additions to Social Sec/Medicare fields have been removed. The COBRA Premium Assist. Payments and Individuals Provided COBRA Assist. fields are now added.

- In the Federal Tax Summary window, the Employee FICA Tips and Employer FICA Tips fields were added for wages. The Employee FICA Tip fields were added for payroll taxes.

- In Manual Payroll Tax Entry window, the FICA Tip Tax field was added.

- In Quarterly Tax Report window, the Print FICA Tip Data check box was added.
The Mag Media Tax Type Code field in the P/R Tax Table Maintenance window was renamed Electronic Reporting Tax Type Code. The field name was changed to accurately reflect the new process required by the federal government. For more information, see Changes to Electronic Reporting for W2 and 1099 (Magnetic Media Reporting) on page 141.

**Reports**

To comply with new regulations regarding how social security tips are being reported, the following reports are modified to show FICA and FICA tips totals separately:

- Quarterly Governmental Report
- Payroll Data Entry Audit Report
- Payroll Check History Report
- Employee Listing
- Perpetual History Report
- Employee Listing
- Employer’s Expense Summary
- Quarterly Pay Period Recap
- Payroll Check Printing
- Direct Deposit Stub Printing
- Quarterly Tax Report
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Purchase Order Changes

Global Changes

• You must re-create all Visual Integrator jobs to import purchase order data.

• You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

• You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

• The Tabs button has been removed from data entry tasks and the settings are now available as part of the data entry grid.

• Batch processing is now handled through system Batch Manager programs. Previously, there was one Batch Processing option that applied to the data entry tasks. Receipt of Goods/Invoice Entry and Return Of Goods/Material Requisition Issue Entry tasks now have their own batch options.

• Previously, historical data was stored by the period to date (PTD), year to date (YTD), last year, and future period. Purchase Order purchases and receipt history are now stored by period by year. The conversion for purchases and receipts history is now performed as follows:
  • The PTD record is converted to the current period.
  • The YTD record is converted to the period before the current period (for example, if the current period is June, then the total YTD amount should be in May).
  • The prior year record is converted to the last fiscal period of the prior year.
  • The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.
Purchase Order Options

- The ability to create passwords or allow overrides to data entry security options has been removed from Purchase Order Options and replaced with security event options in Role Maintenance on the Library Master Main menu.

- The Number of Decimal Places fields, previously in the Purchase Order Options window on the Purchase Order Setup menu, have been moved to the Common Information Options window on the Common Information Setup menu.

- The ability to inquire on a memo from an entry task has been replaced with the Memo Manager Maintenance task on the Common Information Main menu.

- Entry options have been moved to the Entry tab, line entry options have been moved to the Line Entry tab, printing options have been moved to the Printing tab, and history options have been moved to the History tab.

- You can now display all drop-ship lines from a sales order, regardless of the assigned purchase order vendor. Previously, when a drop-ship purchase order was entered, the drop-ship lines on the sales order would display if the vendor matched one of the vendors assigned to the item.

- You can now remove purchase history from the Purchase Order file by selecting the Purge Purchases History Utility task on the Purchase Order Utilities menu. Previously, the purchase history was removed during period-end processing.

- You can now retain comment lines in receipt history. Previously, the Accounts Payable module controlled comments for receipt history.

- You can now select a format to use for posting comments to General Ledger.

- Additional fields have been added to print the Back Order Fill Report.
Purchases History

- Previously, purchase history was saved by period and month. With version 4.40 and higher, purchase history is now continuously saved by receipt date and posting date.

- You must now retain at least two years of purchase history at the Years to Retain Purchase History field in the Purchase Order Options window, with the option to retain up to 99 years.

Data Entry

- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in Purchase Order Entry, Receipt of Goods Entry, and Receipt of Invoice Entry.

- The Tabs button has been removed and a Defaults button added to all data entry windows.

- You can now use a security event in Role Maintenance to prevent users from adding inventory items on the fly. Previously, the Allow On-the-Fly Additions of Inventory Items field was available in Purchase Order Options.

Utilities Menu

A new Utilities menu has been added to the Purchase Order module. The tasks available in this menu are:

- Purge Completed Purchase Orders
- Purge Expired Master/Repeating Orders
- Purge Completed or Cancelled PO Recap
- Purge Obsolete Purchase Orders
- Purge Purchase Order Receipt History
- Purge Purchases History
**Period End Processing**

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Purge Completed Purchase Orders option has been replaced with the Purge Completed Purchase Orders task.

- The Purge Expired Master/Repeating Orders option has been replaced with the Purge Expired and Master Repeating Order task.

- The Purge Completed or Cancelled PO Recap option has been replaced with the Purge Completed or Cancelled PO Recap task.

- The Purge Obsolete Purchase Orders option has been replaced with the Purge Obsolete Purchase Orders task. Additionally, records dated on or before the purge date entered has been removed.

- The Purge Purchase Order Receipt History option has been replaced with the Purge Purchase Order Receipt History task.

- The Purge Purchases History utility has been added to the Utilities menu to remove purchase history. Previously, the purchase history was removed during period-end processing.

**Printing**

- Reports and listings now use Crystal Reports. Because of this, the Purchase Order module no longer uses the settings established in Library Master Report Format Maintenance.

- The report and form windows now remain open when you receive the message dialog box stating there is no data in the range to print so you can resolve the issue without losing your settings.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field and it uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.

Registers and Updates

The Purchase Order Variance Register now prints after the register and before the update. Previously, this register printed after the update.

Reports and Forms

- In the Back Order Fill Report, you can now print only the items that have a back ordered quantity on the sales order if the received quantity is not equal to zero. Previously, the report printed all items on the purchase order that had a back ordered quantity on the sales order.

- Report setting options now appear on the header area of the applicable report window. You can also define and save customized report settings. For more information, see Create a Report Setting in the Help system.

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box so you can resolve the issue without losing your settings.
Renamed, Removed, or Moved Tasks

- The Purge Completed Purchase Orders, Purge Expired Master/Repeating Orders, Purge Completed or Cancelled PO Recap, and Purge Obsolete Purchase Order utilities have been moved from the Period End Processing window to the Utilities menu.

- The Purge Purchase Order Receipt History and Purge Purchases History utilities have been added to the Utilities menu.

- The Open PO by Item Report has been renamed Open Orders by Item Report.

- The Open PO by Job Report has been renamed Open Orders by Job Report.

- The Receipt History Report has been renamed Purchase Order Receipt History Report.

- The Open PO by Work Order Report has been renamed Open Orders by Work Order Report.

- The Automatic Reorder Selection option has been renamed Auto Reorder Selection.

- The Ship to Address Maintenance task has been renamed Ship-To Address Maintenance.

- The Miscellaneous Charge Maintenance task has been renamed Miscellaneous Item Maintenance.
Return Merchandise Authorization Changes

Data Entry

- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in RMA Entry and RMA Receipts Entry.

Utilities Menu

Various options previously included in the RMA Utilities task have been moved to the Utilities menu as follows:

- The Purge Expired RMAs option has been replaced by the Purge Expired RMA task.
- The Purge Return Reason Detail option has been replaced by the Purge Return Reason Detail task.
- The Purge RMA Receipts History option has been replaced by the Purge RMA Receipts History task.
- The Create Customer Invoice Search Records option has been replaced by the Create Customer Invoice Search Records task.
Sales Order Changes

Security Option for Adding Inventory Items on the Fly

You can now use a security event in Role Maintenance to prevent users from adding inventory items on the fly. Previously, the Allow On-the-Fly Additions of Inventory Items field was available in Sales Order Options.

Data Entry

- In the Sales Order Entry window, the user login ID is now displayed if security is set up. Previously, the user code displayed.
- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in Sales Order Entry and Invoice Data Entry.

Reports

The Customer Sales History Report now prints by invoice date or posting date depending on whether you base inventory periods by physical periods or calendar months. Previously, this report was printed by period or month.

This same report also printed sales history by item or product line. Now you can print information using three new reports.

- Customer Sales History by Item
- Customer Sales History by Product Line
- Customer Sales History

Renamed, Removed, or Moved Tasks

- The Monthly Recap by Division has been renamed Sales Recap by Division.
- The Monthly Recap by Product Line has been renamed Sales Recap by Product Line.
- The Monthly Recap by Warehouse has been renamed Sales Recap by Warehouse.
• The Monthly Recap by Warehouse by Product Line has been renamed Sales Recap by Warehouse by Product Line.

Global Changes

If the Inventory Management module is integrated with Sales Order, you can now retain a customer’s last purchase price information for both inventory items and miscellaneous items. Previously, you could retain the last purchase price information for inventory items only.

Sales History

• Previously, sales history was saved by period and month. With version 4.10 and higher, sales history is now continuously saved by invoice date and posting date.

• With version 4.10 and higher, you must retain at least two years of sales history at the Years to Retain Sales History field in the Sales Order Options window, with the option to retain up to 99 years.

• Because of the new method for saving history, the Enter Customer Sales History Option by Customer Type check box and the Customer Type/Option fields in Sales Order Options have been removed.

Sales History Reports

• The Customer Sales History Report now prints by invoice date or posting date depending on whether you base inventory periods on fiscal periods or calendar months. Previously, the Customer Sales History Report printed by period and month.

• Previously on the Customer Sales History Report, you could print sales history by item or sales history by product line. Now you can print this information using three new reports, the Customer Sales History by Item, Customer Sales History by Product Line, and Customer Sales History.
Because sales history is now saved by invoice date and posting date, four new reports, Sales Recap by Division, Sales Recap by Product Line, Sales Recap by Warehouse, and Sales Recap by Warehouse and Product Line replace the Monthly Recap by Division, Monthly Recap by Product Line, Monthly Recap by Warehouse, and Monthly Recap by Warehouse and Product Line reports. After upgrading to version 4.10 or higher, if you need to reference the Monthly Recap reports or the previous Customer Sales History report, select File > Run and type the following in the Run Program window:

- **SOWRJA** to access the Monthly Recap by Product Line report
- **SOWRKA** to access the Monthly Recap by Warehouse/Product Line report
- **SOWRLA** to access the Monthly Recap by Warehouse report
- **SOWRMA** to access the Monthly Recap by Division report
- **SOWRNA** to access the Customer Sales History report

**Period End Processing**

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Purge Sales Order History option has been replaced by the Purge Order/Quote History task.
- The Purge Expired Master/Repeating Orders and Purge Expired Price Quotes options have been replaced by the Purge Expired Orders/Quotes task.
- The Purge Sales Order Recap option has been replaced by the Purge Sales Order Recap task.
Chapter 4 Upgrading from Versions Prior to 4.30 to 4.40

Job Cost Integration

Because the Job Cost module can now be integrated with Sales Order, the way that job costs are posted can affect statements of profitability. If you are upgrading from version 4.05 or prior, make sure you plan how to post job costs before upgrading.

- If job costs are posted from the Accounts Payable or Purchase Order module, do not select the Post Invoice Costs to Job Cost check box in the Sales Order Options window. If this check box is selected, costs can potentially be posted to the Job Cost module from more than one module, resulting in an understatement of profitability.

- If the Accounts Payable or Purchase Order modules are not integrated with Job Cost, select the Post Invoice Costs to Job Cost check box in the Sales Order Options window. If this check box is not selected, costs may not be posted to the Job Cost module at all, resulting in an overstatement of profitability.
Visual Integrator Changes

Data Dictionaries

Before you use the Visual Integrator module, select Visual Integrator Main menu > Export Job Maintenance or Import Job Maintenance after installing version 4.40. This initiates the necessary update of the Data Dictionaries so that you can successfully create Visual Integrator jobs.

Data Dictionary Listing

File information for modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order is no longer included on the Data Dictionary Listing. To obtain file information for these modules, on the Desktop, access the Resources page and click the File Layouts and Program Information link. You must re-create Visual Integrator jobs for these modules.

Import Job Maintenance

For information about upgrading from versions prior to 4.30 to 4.40, see Changes to Visual Integrator on page 175.

Work Order Changes

Moved Task

The Bar Code Printer Maintenance task, previously on the Inventory Management Setup menu, has been moved to the Work Order Setup menu.

Data Dictionary Changes

The file layouts have been changed to accommodate the expanded item code and expanded customer number options.
Chapter 4  Upgrading from Versions Prior to 4.30 to 4.40

Report Master Changes

- Reports for modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order are now created using Business Insights Reporter. Report Master reports can no longer be generated for these modules.

- Sage recommends using Business Insights Reporter to create custom reports for modules other than Job Cost, Material Requirements Planning, Payroll, and Work Order.

- Sage recognizes that you may have expended considerable time and effort creating custom reports for Job Cost, Material Requirements Planning, Payroll, and Work Order in Report Master. As a result, although Report Master has been removed, it can still be accessed by using a hidden utility. To access Report Master, select File > Run and type \*unhiderm in the Run Program window.

- For printing reports from subsidiary modules that contain a general ledger account number greater than 20 characters, you will need to manually adjust the print position for the data fields following the account. This is because the maximum mask length in Report Master is 20 characters and that determines how much space Report Master defaults on the report.

Retired Modules

**Timberline**

As of version 4.40, Timberline Link has been retired.

**ACT! Link**

As of version 4.40, ACT! Link has been retired.

**SageCRM**

As of version 4.40, SageCRM version 6.1 has been retired. This does not apply to Extended Enterprise Suite customers.
**FAS Select**

As of version 4.2, FAS Select has been retired.

**Client Write-Up**

As of version 4.0, the Client Write-Up module has been retired. If you need Client Write-Up functionality, contact your Sage business partner.

**Import Master**

As of version 4.0, the Import Master module has been retired in favor of the more flexible Visual Integrator module; therefore, you will need to re-create any Import Master jobs in Visual Integrator before upgrading. Contact your Sage business partner if you need the Visual Integrator module. Print your job listing in Import Master on your current system to use as a reference when creating the Visual Integrator jobs.

**PostMaster**

As of version 4.0, the PostMaster module has been retired.

**TimeSlips Link**

As of version 4.0, the TimeSlips Link module has been retired.

**Visual PostMaster**

As of version 4.0, the Visual PostMaster module has been retired.
Chapter 5

Changes to Accounts Payable

This chapter describes the changes made to the Accounts Payable module.

Global Changes

The following changes were made in version 4.20.

- Aging for all vendors is now recalculated using the system date during the conversion of data for version 4.20 and higher.

- The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.

- Previously, historical data was stored by the period to date (PTD), year to date (YTD), last year, and future period. Accounts Payable vendor history is now stored by period by year. The conversion for vendor sales history is now performed as follows:
  - The PTD record is converted to the current period.
  - The YTD record is converted to the period before the current period (for example, if the current period is June, then the total YTD amount should be in May).
  - The prior year record is converted to the last fiscal period of the prior year.
  - You can modify the history data by clicking the Fix button on the Vendor Maintenance History tab. This button is only available when security is enabled and the Allow Editing of History Data in Vendor Maintenance security event is selected in Role Maintenance.
  - The Number of Months to Retain Check History option was removed. To retain or display check history in Vendor Maintenance, select the Track Detailed Invoice/Payment History check box in the Accounts Payable Options window.
Chapter 5  Changes to Accounts Payable

- You can now post payments of existing invoices to the general ledger in addition to payments of new invoices entered on the fly. Select the Manual Check Register in Detail check box in the Accounts Payable Options window.

- Certain memos can now flow from entity to entity based on the document. For example, an invoice memo would flow to invoice history.

- Time and Billing lines are no longer converted because they can cause out-of-balance invoice totals that do not match the line totals. If you have the Time and Billing module installed, contact your Sage business partner before installing the upgrade.

Data Entry

The following changes were made in version 4.20.

- In the Manual Check Entry window, you can now add multiple general ledger distribution lines using the Create G/L Distribution button.

- The Credit Card Payment Transfer Details window displays transfer information for payments processed in version 4.20 and higher.

Period End Processing

The following changes were made in version 4.20.

- Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

- Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:
  - The Only Remove Invoices with Zero Balances option has been replaced by the Remove Zero Balance Invoices task.
  - The Only Remove Temporary Vendors with Zero Balances option has been replaced by the Remove Temporary Vendors task.
RENAMED, REMOVED, OR MOVED TASKS

- The Only Clear Check History File option and the Purge Detailed Invoice/Payment History File option have been replaced by the Purge Accounts Payable History task.

- The Purge Sales Tax History File option has been replaced by the Purge Sales Tax History task.

Renamed, Removed, or Moved Tasks

The following change was made in version 4.40.

- The Detail Receipt History task in Vendor Maintenance has been renamed Vendor Receipt History.

The following changes were made in version 4.20.

- The Update Purchase Vendor task has been renamed Purchase Vendor Transfer.

- Information that was previously on the Vendor Maintenance History tab has been moved to the Statistics and Summary tabs. History information is now maintained using period-sensitive data which removes the requirement for future buckets and mandatory module closing.

- The Vendor Delete/Renumber/Merge task previously on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Vendors.

- The Assign Vendor Schedules task previously on the Setup menu has been moved to the Utilities menu and renamed Assign Vendor Tax Schedules.

- The Sales Tax Calculation task previously on the Setup menu has been moved to the Utilities menu.
Chapter 5  Changes to Accounts Payable

Reports and Forms

The following changes were made in version 4.20.

- Vendor Listing no longer prints the balance data. To print the balance information, print the new Vendor Listing with Balances.

- You can now print the remit-to address on checks using A/P Check Printing or Manual Check Printing without customizing the check form.
Chapter 6

Changes to Accounts Receivable

This chapter describes the changes made to the Accounts Receivable module.

Global Changes

The following changes were made in version 4.20.

- Certain memos can now flow from entity to entity based on the document. For example, an invoice memo would flow to invoice history.

The following changes were made in version 4.10.

- Aging for all customers is now recalculated using the system date during the conversion of version 4.10 or higher data.

- Previously, the historical data was stored by period to date (PTD), year to date (YTD), last year, and future period. Accounts Receivable customer sales history is now stored by period by year. The conversion for customer sales history is now performed as follows:

  - The PTD record is converted to the current period.
  - The YTD record is converted to the period before the current period (for example, if the current period is June, then the total YTD amount should be in May).
  - The prior year record is converted to the last fiscal period of the prior year.

- You can modify the history data by clicking the Fix button on the Customer Maintenance History tab. This button is only available when security is enabled and the Allow Editing of History Data in Customer Maintenance security event is selected in Role Maintenance.

- The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.
Chapter 6  Changes to Accounts Receivable

Customer Statements

The following changes were made in version 4.30.

You must now set up the Paperless Office module to e-mail statements to customers. Previously, to e-mail customer statements, you had to select the E-mail Statements check box in Customer Maintenance and then select the appropriate option at the Produce Statements For field in the Statement Printing window. For more information, see Set Up Paperless Office in the Help system.

Period End Processing

The following changes were made in version 4.10.

- The Salesperson Commission Purge task, previously on the Period End menu, has been moved to the Utilities menu.

- Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Only Remove Temporary Customers with Zero Balances option has been replaced by the Remove Temporary Customers task.

- The Only Remove Invoices with Zero Balances option has been replaced by the Remove Zero Balance Invoices task.

- The Only Purge Sales Tax History File option has been replaced by the Purge Sales Tax History task.

- The Only Clear Invoice/Shipping History File option has been replaced by the Purge Accounts Receivable History task.

- The Only Recalculate Customer High Balances option has been replaced by the Recalculate Customer High Balances task.
Renamed, Removed, or Moved Tasks

The following changes were made in version 4.40.

- The Detail Sales History task in Customer Maintenance has been renamed Customer Sales History.

The following changes were made in version 4.10.

- Information that was previously on the Customer Maintenance History tab has been moved to the Customer Maintenance Statistics and Summary tabs. History information is now maintained using period-sensitive data which removes the requirement for future buckets and mandatory module closing.

- The following tasks previously on the Setup menu have been moved to the Utilities menu: Global Customer Field Change, Sales Tax Calculation, and Internet Customers Enable/Purge.

- The Delete/Renumber/Merge task previously on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Customers.
Chapter 7

Changes to Bar Code

This chapter describes the changes made to Bar Code in version 4.40.

Bar Code Options

The Graphical Forms field has been removed as the Bar Code module now uses Crystal Reports to print forms and reports.

Unattended Bar Code Transaction Import

ODB files are no longer imported using the Unattended Bar Code Transaction Import task. ODB files must now be imported using Import Bill of Materials Transactions, Import Inventory Transactions, Import Purchase Order Transactions, and Import Sales Order Transactions.

Renamed Tasks

- The Period End Processing task has been renamed Purge Bar Code History.
- The Bar Code P/O Receiver Printing task has been renamed Purchase Order Printing.
Chapter 8

Changes to Business Insights

This chapter describes the changes made to Business Insights.

Business Insights Dashboard

The following changes were made in version 4.30.

- To take advantage of the Business Insights Dashboard’s upgraded architecture, you must set up your Dashboard pages again. For more information, see Set Up Business Insights Dashboard in the Help system.

- Internet Explorer 6.0 or higher is required to view the Dashboard pages.

- You can now set up access to the Business Insights Dashboard for each user using the Dashboard Maintenance Wizard. The module options for the Business Insights Dashboard were removed from Role Maintenance.

- In the Top Customer view, the Year to Date field now excludes future-dated transactions that are in the same year. The new Business Insights Dashboard displays the information as of the date entered. If a date is not entered, the information is displayed as of the period-end date.

Business Insights Explorer

The following changes were made in version 4.20.

The new Business Insights Explorer, which provides an alternative method of accessing data, is now available from the Desktop Tree view and menu. Predefined views of customers, quotes, sales orders, and invoices are available, providing a way to quickly view related data and navigational links to other inquiries or tasks.
Chapter 8  Changes to Business Insights

Business Insights Reporter

The following changes were made in version 4.40.

- After upgrading to version 4.40, you will need to re-create Business Insights Reporter reports used in Bill of Materials, Inventory Management, and Purchase Order.

- For custom reports previously created using version 4.30 or prior data from the Bill of Materials, Inventory Management, and Purchase Order modules, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Bill of Materials, Inventory Management, and Purchase Order modules.

The following changes were made in version 4.30.

- You must activate the Business Insights module to use Business Insights Reporter.

- When defining a role in Role Maintenance to provide users with access to Business Insights Reporter, select the Business Insights Reporter check box under Library Master > Setup Options. This check box was previously located under the Business Insights folder in Role Maintenance.
After upgrading to version 4.30, you will need to re-create Business Insights Reporter reports used in a previous 4.x version of the software.

For custom reports previously created using version 4.10 or prior data from the Accounts Payable module, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Accounts Payable module.

For custom reports previously created using version 4.05 or prior data from the Accounts Receivable, Bank Reconciliation, General Ledger, Library Master, Return Merchandise Authorization, or Sales Order modules, access Business Insights Reporter and select a report in the Business Insights Reporter Selection window. You are prompted to print the Business Insights Reporter Definition Listing and then delete the report. Repeat this process for each custom report previously created for the Accounts Receivable, Bank Reconciliation, Return Merchandise Authorization, and Sales Order modules.

For custom reports previously created for all other modules, select Library Master Utilities menu > Rebuild Business Insights Reporter Views to rebuild custom reports created with Business Insights Reporter in a previous 4.x version of the software.
Chapter 8  Changes to Business Insights

Menu Organization

The following changes were made in version 4.10.

- The Business Insights tasks are now on a separate module menu. Previously, the Business Insights tasks were located in a menu under the Library Master module. Business Insights is now organized on three submenus: Dashboard, Reporter, and Explorer.

The following changes were made in version 4.0.

- The Business Insights Reporter menu includes the tasks, Business Insights Reporter, and Business Insights Reporter Listing. You can use Business Insights Reporter to create Crystal Reports for all modules. These reports can optionally be added to the Custom Reports menu for a specified module.

Renamed Tasks

The following changes were made in version 4.20.

Under the Business Insights Dashboard menu, the following tasks have been renamed:

- Business Insights Options has been renamed Dashboard Options.
- Dashboard Selection Wizard (previously named Business Insights Wizard) has been renamed Dashboard Maintenance Wizard.
- Dashboard Selection Listing (previously named Business Insights Listing) has been renamed Dashboard Maintenance Listing.
- Display Business Insights has been renamed Display Dashboard.
- Business Insights Automatic Update has been renamed Start Automatic Dashboard Update.
Changes to Bill of Materials

This chapter describes the changes made to the Bill of Materials module in version 4.40.

Global Changes

- You must re-create all Visual Integrator jobs to import bill of materials data.
- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.
- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

Bill of Materials Options

- The option to Allow Entry of Negative Quantities no longer applies to Option Interaction Maintenance.
- If the Allow Kit Bills and/or the Allow Phantom Bills check boxes are cleared, a message dialog box will now appear in Bill of Materials Options. Previously, the message dialog box displayed in Bill of Materials Maintenance.
- You can now enter a unique next automatic disassembly number. Previously, Production Entry and Disassembly Entry shared the same option.

Data Entry

In all data entry windows, the Item Inquiry window has been replaced with the Item Quantity Inquiry window.
Inquiry Changes

- The Bill of Materials Inquiry and Bill of Materials Where-Used Inquiry windows have been re-designed with new fields and drill downs.

- The Options button in Bill of Materials Inquiry and Bill of Materials Where-Used Inquiry has been replaced with radio buttons for the different selections to inquire on. Additionally, a tree view now displays when the Indented view is selected.

Printing

- Reports and listings now use Crystal Reports. Because of this, the Bill of Materials module no longer uses the settings established in Library Master Report Format Maintenance.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field and uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- The report and form windows now remain open when you receive the “Data is not selected for report printing” message dialog box, so you can resolve the issue without losing your settings.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.
Reports and Forms

Report setting options now appear on the header area of the applicable report window. You can also define and save customized report settings. For more information, see Create a Report Setting in the Help system.

Renamed, Removed, or Moved Tasks

- All the inquiry windows on the Main menu have been moved to the Inquiries menu.

- The Replace/Delete Component Entry task on the Change Control menu has been renamed Replace and Delete Component Entry.

- The Replace/Delete Component Register has been renamed Replace and Delete Component Register.

- The Miscellaneous Charge Maintenance task on the Setup menu has been renamed Miscellaneous Item Maintenance. This task is also available from the Common Information Main menu.
Chapter 9  Changes to Bill of Materials
Chapter 10

Changes to Common Information

This chapter describes the changes made to the Common Information module.

Common Information Options

The following changes were made in version 4.40.

- The Number of Decimal Places fields, previously in the Inventory Management Options window on the Inventory Management Setup menu and in the Purchase Order Options window on the Purchase Order Setup menu, have been moved to the Common Information Options window on the Common Information Setup menu.

- The Years to Retain Item History field, previously in the Inventory Management Options window on the Inventory Management Setup menu, has been moved to the Common Information Options window on the Common Information Setup menu. Additionally, a minimum of two years is now required to retain history.

- If the Inventory Management module is not set up for a company, the Common Information period history will be accumulated based on the General Ledger fiscal year setup. If the Inventory Management module is set up, the history will be accumulated based on the selection made at the Base Inventory Periods On field in Inventory Management Options.

NOTE
These options do not apply in Accounts Receivable Invoice Data Entry and Repetitive Invoice Entry.
Chapter 10 Changes to Common Information

Miscellaneous Item Maintenance

The following changes were made in version 4.40.

Miscellaneous Item Maintenance has been added to the Common Information Main menu. This task remains on the Bill of Materials Setup menu and Purchase Order Setup menu.

The following changes were made in version 4.10.

- Sales codes and miscellaneous items, part of the Accounts Receivable and Sales Order modules, are now referred to as Miscellaneous items and are stored in a common file shared by both modules.

- Miscellaneous items are now designated by the following item types: Miscellaneous items, Charge items, and Comment items. Comment codes are now referred to as Comment items and Miscellaneous Charges are now referred to as Charge items.

Renamed, Removed, or Moved Tasks

The following changes were made in version 4.40.

- The Unit of Measure Conversion Maintenance task, previously on the Inventory Management Setup menu, has been moved to the Common Information Setup menu.

- The Purge Miscellaneous Item History has been renamed Purge Item History.

- Purge Obsolete Extended Descriptions, previously on the Library Master Utilities menu, has been moved to the Common Information Utilities menu.

- Memo Manager Maintenance, previously on the Library Master Setup menu, has been moved to the Common Information Main menu. This task remains on the Purchase Order Setup menu and Inventory Management Setup menu.
The following changes were made in version 4.30.

The Bank ID Number field in the Bank Code Maintenance window has been renamed Bank Account Number.

The following changes were made in version 4.20.

- Bank Code Maintenance has been added to the Common Information Main menu. This task remains on the Accounts Payable Setup menu, Accounts Receivable Setup menu, Bank Reconciliation Main menu, and Payroll Setup menu.

- Memo Manager Maintenance, previously on the Library Master Setup menu, has been moved to the Common Information Main menu. This task remains on the Accounts Payable Setup menu, Accounts Receivable Setup menu, General Ledger Setup menu, Return Merchandise Authorization Setup menu, and Sales Order Setup menu.

- Sales Tax Account Maintenance has been added to the Common Information Main menu. This task remains on the Accounts Payable Setup menu and Accounts Receivable Setup menu.
Chapter 10 Changes to Common Information
Chapter 11

Changes to Customizer

This chapter describes the changes made to Customizer.

Global Changes

The following changes were made in version 4.40.

- Customized libraries for the Bill of Materials, Inventory Management, and Purchase Order modules will not be migrated and must be re-created after the migration process.

- Data entry user-defined fields (UDFs) must be re-created in User-Defined Field and Table Maintenance after upgrading to version 4.40. After re-creating UDFs, you must map the UDFs to their respective history files. For more information, see Map User-Defined Fields (UDFs) in the Help system.

- For Purchase Order Receipt of Goods, Receipt of Invoice, and Return of Goods, the new Purchase Order Invoice UDF migrated or converted to 4.40 from 4.20 or 4.30 is no longer needed. For UDFs that existed in the Purchase Order Invoice UDF file, these records will need to be imported into an AP Invoice History Header UDF. The Purchase Order Invoice UDFs are not automatically merged into the AP Invoice History Header UDF upon upgrading to 4.40.

- When upgrading from a previous version of 4.x, the following list of UDFs are updated to specific tables:
  - The Bill of Materials Header UDFs are now updated to the new BM Bill Header table.
  - The Bill of Materials Lines UDFs are now updated to the new BM Bill Detail table.
  - The Inventory Management Warehouse Detail UDFs are updated to the new IM Item Warehouse table.
  - The Purchase Order Receipt History UDFs are now updated to the new PO Receipt History Header table.
Chapter 11 Changes to Customizer

- The Purchase Order Receipt/Return Lines UDFs are now updated to the new PO Receipt History Detail table.
- The Purchase Order UDFs are now updated to the new PO Purchase Order Header table.
- The Purchase Order Lines UDFs are now updated to the new PO Purchase Order Detail table.

The following changes were made in version 4.20.

- Customized libraries for the Accounts Payable module must be re-customized.
- For modules using the new object-oriented architecture, the External Link Definition window now allows you to select business object columns available to the panel instead of the control names in the customized library. For example, to select the Customer No. field in the Sales Order Entry window, you can now select the business object name, SO_SalesOrder_bus_CustomerNo$, instead of the control name, ML_CUST$.
- Data entry user-defined fields (UDFs) must be re-created in User-Defined Field and Table Maintenance. After re-creating UDFs, you must map the UDFs to their respective history files. For more information, see Map User-Defined Fields (UDFs) in the Help system.
- The Accounts Payable Invoice Entry UDFs for both header and lines will need to be re-created in User-Defined Field and Table Maintenance. After these UDFs have been created and updated, it is necessary to map the invoice entry UDFs to their respective history tables.
- For Purchase Order Receipt of Goods, Receipt of Invoice, and Return of Goods, the new Purchase Order Invoice UDF replaces the Accounts Payable Invoice UDF. If an Accounts Payable Invoice UDF exists on a customized Purchase Order .lib file migrated or converted to 4.20, it must be manually removed, and the Purchase Order Invoice UDF must be added.
GLOBAL CHANGES

- When you have upgraded to version 4.20 and re-created UDFs, the following list of UDFs are updated to specific tables:
  - The Accounts Payable Invoice UDFs are updated to the new AP Invoice History Header table.
  - The Accounts Payable Invoice Lines UDFs are updated to the new AP Invoice History Detail table.
  - The Accounts Payable Vendor UDFs are updated to the new AP Vendor Master table.

The following changes were made in version 4.10.

- When upgrading from Level 3.7x, customized libraries for the Accounts Receivable, Bank Reconciliation, General Ledger, e-Business Manager, Return Merchandise Authorization, and Sales Order modules will not be migrated and must be re-created after the migration process.

- After upgrading to Version 4.10, data entry UDFs must be re-created in User-Defined Field and Table Maintenance. After re-creating UDFs, you must map the UDFs to their respective history files. For more information, see Map User-Defined Fields (UDFs) in the Help system.

- The Accounts Receivable and Sales Order Invoice Data Entry UDFs for both header and lines will need to be recreated in UDF and Table Maintenance. After these UDFs have been established and updated, it is necessary to map the invoice entry UDFs to their respective history files.

- Job Cost Job Billing Entry has a new Job Cost Billing UDF that replaces the Accounts Receivable Invoice UDF. The Job Invoice UDF file is now the history file for Job Billing Entry’s Job Cost Billing UDF. The Accounts Receivable Invoice UDF is no longer available in Job Billing Entry. The ARI Entity UDF that exists on a customized lib and is migrated or converted to 4.10 will have to be manually removed from the 4.10 lib.

- The link between the AR Invoice and Job Cost Header entity in Job Billing Entry has been replaced by a link between the Job Cost Billing entity and the Job Cost Header entity.
Chapter 11 Changes to Customizer

- The Inventory Master file UDF has been merged into the CI_Item file. Use the Common Item File in User-Defined Field and Table Maintenance to create UDFs and maintain existing UDFs. The IM_90 file is no longer available. Crystal Reports that previously used the IM_90 file should be modified to use the CI_Item file. The IM_90 UDF will need to be manually removed from the Inventory Maintenance .lib file.

- In User-Defined Field Maintenance, pound signs (###) previously used in the Mask field for a String data type UDF are now invalid. When editing an existing UDF with a mask, the pound signs will be replaced with Z.s and any separators will need to be retyped. Pound signs are only valid for Numeric data type UDFs. For more information, see Format Masks in the Customizer Help system.

- Previously, separators used in UDFs were saved to the applicable data files. In Version 4.10, separators are not saved. After upgrading to Version 4.10, use Crystal Reports to reformat UDF data on custom reports.

- Conversion with AP Invoices in AP Invoice Data Entry will leave orphan records in the AP_95 that are assigned the invoice data entry sequence number. These records need to be manually removed using the Data File Display and Maintenance task. To identify orphan records, the sequence number in the key field for invoices removed during conversion will start with a 99900001, etc.

- RA_91 UDFs will only be added to the Receipts History Header table. You will need to create new UDFs for the Receipts Header table, then go into the history table and map the new UDF to the existing UDF which was migrated.

- RA_96 UDFs will only be added to the Receipts History Detail table. You will need to create new UDFs for the Receipts Detail table, then go into the history table and map the new UDF to the existing UDF which was migrated.
GLOBAL CHANGES

- Pound signs (###) which were allowed for masking a String data type UDF are no longer allowed in Version 4.10 as this is an invalid format for a string (for more information, see String Format Table in the Help system). In Version 4.10, when editing a UDF with a Mask of #’s, the #’s are changed to Z’s. The separator will need to be re-added. Pound signs (###) are only allowed on Numeric data type UDFs.

- For modules upgrading to 4.10, some modules wrote the Mask separator to the UDF data file. UDF values for 4.x modules are written without the separator. During the 4.10 conversion, separators included in the UDF records in the UDF data file will be removed. This will only occur for String data type UDFs.

- When upgrading from a previous Version of 4.x, the following list of UDFs are updated to specific tables:
  
  - Accounts Receivable Invoice UDFs are updated to the AR Invoice History Header table.
  
  - Accounts Receivable Invoice Line UDFs are updated to the AR Invoice History Detail table.
  
  - The Sales Order Entry UDFs are updated to the SO Sales Order Header and the SO Sales Order History Header tables.
  
  - The Sales Order Detail UDFs are updated to the SO Sales Order Detail and the SO Sales Order History Detail tables.
  
  - The Return Merchandise Authorization Receipt Entry/History Header UDFs are updated to the RA Receipts History Header table.
  
  - The Return Merchandise Authorization Receipt Entry/History Lines UDFs are updated to the RA Receipts History Detail table.
  
  - The e-Business Manager Customer UDFs are updated to the IT Shopping Cart Header and IT UID Customer Change tables.
  
  - The e-Business Manager Shopping Cart Item UDFs are updated to the IT Shopping Cart Item and IT Shopping Cart Items Selected tables.
Chapter 11 Changes to Customizer

The following changes were made in version 4.0.

- When upgrading to Version 4.0, General Ledger user-defined fields will be updated to the GL_Account data file; however, General Ledger library customizations will not be migrated and must be re-created after the migration process.

- The PostMaster Conversion Utility previously accessed from the Customizer Main menu has been removed because the PostMaster module has been retired.
Chapter 12

Changes to e-Business Manager

This chapter describes the changes made to the e-Business Manager module.

Web Engine

The following changes were made in version 4.40.

- You must uninstall the Web engine, and then re-install it after upgrading to version 4.40.

- If you have customized templates in the IW folder, back them up in another location before uninstalling the Web engine. After uninstalling, you must merge your customized templates with the Standard templates as some have changed for corrections or enhancements.

- Enabling item code expansion (from 15 to 30 characters) can cause layout changes in your HTML templates when rendering in a browser. You should verify if your customized templates are affected.

Global Changes

The following changes were made in version 4.10.

- The Microsoft Web Publishing Wizard is no longer installed or supported. You must now publish e-Business Manager images, JavaScripts, and style sheets to the Internet Information Server (IIS) using your own FTP software. For more information, see Publish Files to the Internet in the e-Business Manager Help system.

- The Publish Files to Web task, which was located on the Setup menu, has been removed as it used the Microsoft Web Publishing Wizard which is no longer supported.
Chapter 12 Changes to e-Business Manager

- The polling process that formerly performed the real-time automatic updates for user IDs, customers, and sales orders from the Web engine has been removed. The options that controlled how often the polling process polled for shopping cart entries and customer/user ID changes have therefore also been removed from IT Options.

- You can no longer enter the SMTP server address in IT Options. It must be entered in Company Maintenance in the Library Master module before you can generate e-mail in e-Business Manager.
Chapter 13

Changes to Electronic Reporting for W2 and 1099 (Magnetic Media Reporting)

This chapter describes the changes made to the Electronic Reporting for W2 and 1099 module, formerly Magnetic Media Reporting.

Global Changes

The following changes were made in version 4.20.

- The Magnetic Media Reporting module has been renamed Electronic Reporting for W2 and 1099 to accurately reflect the new process required by the federal government.

- Starting from the 2006 tax year, the Internal Revenue Service (IRS) requires that all payroll and 1099 filings be performed electronically through the Internet. The federal government will no longer accept W2 and 1099 information on any type of magnetic media (diskette). In Sage MAS 90 and 200, you can continue to create a data file compliant with the IRS published standards and save it on the hard disk.

- Some states may still require or accept filings submitted on magnetic media. If your state supports the Federal reporting format and accepts submissions on a diskette, you can create the state diskette by copying the data file you created to a 3.5” diskette. If your state does not support the Federal reporting format, the Electronic Reporting module cannot create your electronic file.

- The new Electronic File Transfer task allows you to launch the appropriate government Web site to submit W2 and 1099 files.

- You can store the URL information for Electronic Reporting in Library Master URL Maintenance. Two URL codes and descriptions were created for the Social Security Administration (SSA) and Internal Revenue Service (IRS).

- The 1099 Magnetic Media Reporting window was renamed 1099 Electronic Reporting. The default disk drive to use is now C.
Chapter 13 Changes to Electronic Reporting for W2 and 1099 (Magnetic Media Reporting)

- The W2 Magnetic Media Reporting window was renamed W2 Electronic Reporting. The default disk drive to use is now C.
- The Mag Media Tax Type Code field in the Payroll Tax Table Maintenance window was renamed Electronic Reporting Tax Type Code.
Chapter 14

Changes to Fixed Assets

This chapter describes the changes made to the Fixed Assets module in version 4.20.

Global Changes

- The FAS Link module has been renamed Fixed Assets.
- The new Fixed Assets Maintenance task is now available on the Fixed Assets Main menu if Sage MAS 90 and 200 Fixed Assets is installed and the Fixed Assets module is activated.
Chapter 15

Changes to General Ledger

This chapter describes the changes made to the General Ledger module.

Fiscal Year Maintenance

The following changes were made in version 4.40.

- In Fiscal Year Maintenance, if you change an existing period-end date and/or year, the Item History by Period information is now included as part of the recalculation. Previously, the system recalculated only the General Ledger Posting History by Period and Sales Order Recap information.

- The functionality of the Recalculate button has been changed to recalculate only the Sales Order Recap information. Previously, clicking this button recalculated the General Ledger summary information. You can now use Recalculate Account Balances to recalculate the General Ledger information.

Accounts

The following changes were made in version 4.0.

The ability to have a large general ledger account number of up to 32 characters and 10 segments means that the way in which accounts are maintained has changed. The main account (also known as the natural account) is now maintained separately from the other individual segments. As a result, the system has changed in the following ways:

- The copy function is no longer available in Account Maintenance. The copy function is now available in Main Account Maintenance and Sub Account Maintenance.

- The process for creating new accounts in Account Maintenance has changed. To create an account in Account Maintenance, you must enter a valid combination of an existing main account and sub accounts. For more information, see Create and Maintain Accounts in Account Maintenance in the Help system.
Chapter 15 Changes to General Ledger

- Options which control how general ledger accounts can be created and added on the fly have changed in General Ledger Options. The Add new accounts from data entry check box has been removed and replaced with the Auto Create when all Segments are Valid field, Add Main Accounts in General Ledger check box, and Add Sub Accounts in General Ledger check box. For more information about these fields, see General Ledger Options in the Help system.

Allocations

The following changes were made in version 4.0.

To support new features in allocations, as well as to make the terminology more intuitive, the following changes were made in the system:

- The Allocation Maintenance task has been renamed Allocation Entry. The Allocation Entry task is accessed by selecting General Ledger Main menu > Allocation Entry.

- The Allocation Entry task has been renamed Manual Allocation Entry. The Manual Allocation Entry task is accessed by selecting General Ledger Main menu > General Journal Entry. In the General Journal Entry window, click Copy From. In the Copy From window, select the Allocation option and click OK.

- The method of calculating masked allocation distributions has changed. The allocation is now calculated first, then the total amount is distributed to all the accounts that match the masked account. Previously, the allocation percent/quantity entered was distributed to each account that matched the masked account.

- The activity or balance for Period, Quarterly, and Annual allocation cycles is now allocated based on the entire selected cycle rather than just the period ending that cycle. For example, now a quarterly allocation distributes the activity for the entire quarter. Previously, quarterly and annual allocations used the activity for the current period as the allocation amount. For example, previously a quarterly allocation generated at the end of the third period used only the activity for period 3, not the activity for periods 1, 2, and 3.
• In Allocation Selection, there are now separate allocation totals for financial and nonfinancial allocations.

Custom Financials

The following changes were made in version 4.0.

In order to have maximum flexibility and customization capabilities, you should use FRx for your custom financial reporting needs; however, Sage recognizes that you may have expended considerable time and effort in creating custom financial reports and want to continue using them. Although the Custom Financials menu has been removed, it can still be accessed by using a hidden utility, as long as you do not expand your general ledger account beyond nine characters and three segments.

• You can access the Custom Financials menu and tasks by selecting File > Run and typing *unhidegl in the Run Program window.

• The Custom Financials tasks can only be accessed if you have general ledger account numbers with nine or fewer characters and three or fewer segments.

Standard Financials

The following changes were made in version 4.0.

The Standard Financial Statements have been renamed Financial Reports and have been enhanced to include the former Monthly Trend Report.
Chapter 15 Changes to General Ledger

Data Entry

The following changes were made in version 4.0.

- The system now calculates beginning balances for each fiscal year based on prior year data. As a result, the Beginning Balance (BB) source journal has been removed. To post beginning balances for a new company, you must enter them as journal entries to your general ledger accounts and update them.

- In Transaction Journal Entry, the logic for the offset postings has changed. The Debit/Credit field has been renamed Offset field. During conversion, the source journal orientation will be changed to Credit if it was previously Debit, and it will be changed to Debit if it was previously Credit. Previously, the value selected at the Debit/Credit field determined the orientation of the lines. Now the value selected at the Offset field determines the orientation of the offset only.

- When you use General Ledger Exchange to import transactions into the General Ledger module, transactions now import to the General Journal Entry files. Previously, transactions were imported directly to the history files because of the large number of inter-related tables that must be updated and linked when each transaction is posted. After the import is complete, the General Journal must be printed and updated.

NOTE
For information about changes to customizations for General Ledger lookups, see Advanced Lookup Engine (ALE) on page 52.
Period End Processing

The following changes were made in version 4.0.

Many of the functions previously found in Period End Processing have been moved. Only full period-end processing can be performed from this task. In addition, to support the reopening and closing of periods, the Fiscal Year Consolidation and Consolidate Detail Records logic has been removed. Previously, you could perform the following tasks from Period End Processing:

- Full period-end processing
- Consolidate General Ledger Detail Records
- Purge Transaction Detail History
- Purge Period Summary History

The new location of various functions follows:

- The Clear Next Year Current Budgets logic is now performed in Budget Maintenance.
- The Purge Transaction Detail History task has been renamed Purge General Ledger History and is now accessible from the General Ledger Utilities menu.
- Journal and register numbers are now reset separately based on the selections at the Reset Journal Numbers During and Reset Register Numbers During fields in the General Ledger Options window.

The following changes have been made to year-end processing:

- The Years to Retain General Ledger History field in the General Ledger Options window now applies to both summary and detail history information. As a result, the Number of Years to Retain Summary History field in the General Ledger Options window has been removed.
Chapter 15 Changes to General Ledger

- The Posting to Retained Earnings and Updating Beginning Balances logic has been removed as this is now done through the data entry update routines and the Daily Transaction Register. If the next fiscal year has not been created, year-end processing will create the next fiscal year and recalculate beginning balances.

- Zero budget accounts are now removed from the Period Budget Detail file when all periods for any year are zero.

- The Copy Budget at Year End option has been modified to use the new Copy Actual to Default Budget at Year End check box in the General Ledger Options window.

Reports

The following changes were made in version 4.0.

- The Budget and History Report has been separated into two reports, the Budget and History Report and the Budget and History Report by Period.

- The Standard Financial Statements have been renamed Financial Reports. The Financial Reports now include the former Monthly Trend Report.

Renamed and Removed Tasks

The following changes were made in version 4.0.

- The Account Maintenance task has been removed from all subsidiary modules because all installations require the General Ledger module.

- The Account Group Maintenance task replaces the Account Break Maintenance task. In Version 4.0, the term account group is now used in place of account break.

- The Sub Account Maintenance task replaces the Department Maintenance task.
Chapter 16

Changes to Inventory Management

This chapter describes the changes made to the Inventory Management module in version 4.40.

Global Changes

- If the Inventory Management module is not set up for a company, the Common Information period history will be accumulated based on the General Ledger fiscal year setup. If the Inventory Management module is set up, the history will be accumulated based on the selection made at the Base Inventory Periods On field in Inventory Management Options.

- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.

- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.

- You can now print receipt labels after printing or previewing the Transaction Register. Previously, you could only print the receipt labels before the update process.

- You must re-create all Visual Integrator jobs to import inventory data.

Inventory Management Options

- The ability to sort physical count by bin location, previously in the Inventory Management Options window on the Setup menu has been moved to the Physical Count Worksheet and Physical Count Entry tasks on the Physical Count menu. You can now select to print by bin location.

- The Number of Decimal Places fields, previously in the Inventory Management Options window on the Inventory Management Setup menu has been moved to the Common Information Options window on the Common Information Setup menu.
Chapter 16 Changes to Inventory Management

- The Retain Transaction History check box has been removed from the Inventory Management Options window. You can now use the Purge Item History utility on the Inventory Management or Common Information Utilities menu to purge transaction history. Additionally, at least 2 years retention is required.

- The ability to add a not-on-file warehouse has been removed. Validation occurs now when the warehouse code is entered. Previously, you were able to enter not-on-file warehouse codes.

- The next automatic entry numbers options have been moved to the new Entry tab. In addition, you can now enter alphanumeric and special characters.

Product Line Maintenance

The Allow Back Orders check box must first be selected to enable the Allow Returns check box. Selecting the Allow Returns check box will now be the entry default selection for items in the Item Maintenance window and can be applied to existing inventory items by clicking Apply. Previously, the Allow Back Orders and Allow Returns check boxes were both enabled, and an inventory item created with this product line then inherited these settings.

Transaction Entry

- You can now use the batch entry feature to perform multiple entry sessions simultaneously.

- You can now clear a previous distribution to enter a new distribution in the Distribution Entry window when adjusting an item. Previously, you had to enter a 0 (zero) at the Distribute field to clear the FIFO/LIFO/Lot/Serial Number and Receipt No. fields.
Item Maintenance

- Some hot keys have been changed to provide convenient shortcuts to tasks that are otherwise accessed through menu navigation. For a list of the updated hot keys, see Using Hot Keys in Item Maintenance in the Help system.

- The Standard Cost field can no longer be changed for standard cost items with activity. If activity exists, this field can only be viewed. Instead, use the new Standard Cost Adjustment Entry task to adjust the standard cost.

- You can now view the information on a grid by quantity, sales, or receipts by selecting the Quantities, Sales, or Receipts option on the new History tab. Previously, you had to click the History button on the Main tab to view item quantity, sales, or receipt information.

- Quantity information previously in the Quantity on Hand and Reorder windows, is now available on the Quantity tab. Reorder information can be accessed by clicking the Reorder button on the Quantity tab and on the More button.

- Buttons on the Main tab have been moved to the More button.

Physical Count Changes

- You can now print the Physical Count Worksheet by bin location and quantity on hand. Previously, the worksheet could only be printed by item code and item description, and the quantity on hand was not available to print.

- The Physical Count Entry task now checks the Sales Order, Return Merchandise Authorization, Bill of Materials, Purchase Order, and Work Order modules and displays a warning if unprocessed inventory transaction entries exist when trying to freeze the items. Previously, it only checked Inventory Management.
Chapter 16 Changes to Inventory Management

Costing Changes

- If an average cost item has negative quantity on hand, when items are received, the cost is adjusted only for the quantity received. Previously, the cost was adjusted for the entire negative quantity.

- The Inventory Detail Transaction Report, Inventory Trial Balance Report, and Inventory Valuation Report by Period now print the historical standard cost by default, and a selection to print the current or historical cost is now available in the report windows. Previously, only the current standard cost was provided.

- The Automatic Cost and Price Change task is no longer used to change the standard cost for standard cost items. You must use Standard Cost Adjustment Entry on the Inventory Management Utilities menu to change the standard cost for standard cost items.

Utilities Menu

A new Utilities menu has been added to the Inventory Management module. The tasks available in this menu are:

- Delete and Change Items
- Purge Item History
- Remove Zero Quantity Costing Tiers
- Recalculate Item History
- Item Valuation Change Selection
- Item Valuation Change Maintenance
- Item Valuation Change Register/Update
- Automatic Cost and Price Change
- Standard Cost Adjustment Selection
- Standard Cost Adjustment Entry
- Stand Cost Adjustment Register/Update
**Period End Processing**

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Only Remove Detail History option has been replaced with the Purge Item History task on the Utilities menu.

- The Only Remove Costing Tiers with Zero Quantities option has been replaced with the Remove Zero Quantity Costing Tiers task on the Utilities menu.

- The Only Remove Transaction Detail option has been removed.

**Printing**

- You can now print receipt labels after printing or previewing the Transaction Register. Previously, you could only print receipt labels before the update process.

- The report and form windows now remain open when you receive the message dialog box stating there is no data in the range to print so you can resolve the issue without losing your settings.

- Reports and listings now use Crystal Reports. Because of this, the Inventory Management module no longer uses the settings established in Library Master Report Format Maintenance.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field, and it uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.
Chapter 16 Changes to Inventory Management

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.

Reports and Forms

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box so you can resolve the issue without losing your settings.

- The Inventory Valuation Report by Period can now print items with zero balances and the unit cost for standard cost items can be viewed by current or historical transactions.

Renamed, Removed, or Moved Tasks

- The Inventory Maintenance and Inventory Inquiry tasks on the Main menu have been renamed Item Maintenance and Item Inquiry.

- The Transaction Journal on the Main menu has been renamed Transaction Register.

- The Automatic Cost/Price Change task has been moved to the Utilities menu and renamed Automatic Cost and Price Change.

- The Sales Kit Listing on the Kits menu has been renamed Sales Kit Report.

- The Inventory Memo Printing report on the Reports menu has been renamed Item Memo Printing.

- The Item Masterfile Audit Report on the Reports menu has been renamed Item Audit Report.
- The U/M Conversion Maintenance task on the Setup menu has been renamed Unit of Measure Conversion Maintenance and moved to the Common Information Setup menu.

- The Buyer/Planner Code Maintenance task on the Setup menu has been renamed Buyer and Planner Code Maintenance.

- The Bar Code Printer Maintenance task on the Setup menu has been moved to the Work Order Setup menu.

- The Item Delete/ Renumber/ Merge option in the Inventory Management Utilities window on the Setup menu has been moved to the Utilities menu and renamed Delete and Change Items.

- The Item Valuation Change Selection, Item Valuation Change Maintenance, and Item Valuation Change Register options in the Inventory Management Utilities task on the Setup menu have been moved to the Utilities menu.

- The name of the hidden utility, IMZBL1, has been changed to IM_BalanceQtyOnHand_UI.
Chapter 17

Changes to Job Cost

This chapter describes the changes made to Job Cost in version 4.40.

Job Cost Options

The Timberline Estimating and Directory for Estimating Database fields in the Job Cost Options window have been removed due to the retirement of Timberline Link.

Data Dictionary Changes

The file layouts have been changed to accommodate the expanded item code and expanded customer number options.
Chapter 18

Changes to Purchase Order

This chapter describes the changes made to the Purchase Order module in version 4.40.

Global Changes

- You must re-create all Visual Integrator jobs to import purchase order data.
- You can now undo accidental data entry changes to a data entry screen. Previously, you could only save the changes or cancel the entry.
- You can now view all 30 characters of the item description. Previously, only the first 24 characters were displayed.
- The Tabs button has been removed from data entry tasks and the settings are now available as part of the data entry grid.
- Batch processing is now handled through system Batch Manager programs. Previously, there was one Batch Processing option that applied to the data entry tasks. Receipt of Goods/Invoice Entry and Return Of Goods/Material Requisition Issue Entry tasks now have their own batch options.
- The updating of files is now based on the posting date. Previously, the General Ledger fiscal year was used to determine the period and year.
Previously, historical data was stored by the period to date (PTD), year to date (YTD), last year, and future period. Purchase Order purchases and receipt history are now stored by period by year. The conversion for purchases and receipts history is now performed as follows:

- The PTD record is converted to the current period.
- The YTD record is converted to the period before the current period (for example, if the current period is June, then the total YTD amount should be in May).
- The prior year record is converted to the last fiscal period of the prior year.

**Purchase Order Options**

- The ability to create passwords or allow overrides to data entry security options has been removed from Purchase Order Options and replaced with security event options in Role Maintenance on the Library Master Main menu.

- The Number of Decimal Places fields, previously in the Purchase Order Options window on the Purchase Order Setup menu, have been moved to the Common Information Options window on the Common Information Setup menu.

- The ability to inquire on a memo from an entry task has been replaced with the Memo Manager Maintenance task on the Common Information Main menu.

- Entry options have been moved to the Entry tab, line entry options have been moved to the Line Entry tab, printing options have been moved to the Printing tab, and history options have been moved to the History tab.

- You can now display all drop-ship lines from a sales order, regardless of the assigned purchase order vendor. Previously, when a drop-ship purchase order was entered, the drop-ship lines on the sales order would display if the vendor matched one of the vendors assigned to the item.
- You can now remove purchase history from the Purchase Order file by selecting the Purge Purchases History task on the Purchase Order Utilities menu. Previously, the purchase history was removed during period-end processing.

- You can now retain comment lines in receipt history. Previously, the Accounts Payable module controlled comments for receipt history.

- You can now select a format to use for posting comments to General Ledger.

- Additional fields have been added to print the Back Order Fill Report.

**Purchases History**

- Previously, purchase history was saved by period and month. With version 4.40 and higher, purchase history is now continuously saved by receipt date and posting date.

- You must now retain at least two years of purchase history at the Years to Retain Purchase History field in the Purchase Order Options window, with the option to retain up to 99 years.

**Data Entry**

- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in Purchase Order Entry, Receipt of Goods Entry, and Receipt of Invoice Entry.

- The Tabs button has been removed and a Defaults button added to all data entry windows.

- You can now use a security event in Role Maintenance to prevent users from adding inventory items on the fly. Previously, the Allow On-the-Fly Additions of Inventory Items field was available in Purchase Order Options.
Chapter 18 Changes to Purchase Order

Utilities Menu

A new Utilities menu has been added to the Purchase Order module. The tasks available in this menu are:

- Purge Completed Purchase Orders
- Purge Expired Master/Repeating Orders
- Purge Completed or Cancelled PO Recap
- Purge Obsolete Purchase Orders
- Purge Purchase Order Receipt History
- Purge Purchases History

Period End Processing

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Purge Completed Purchase Orders option has been replaced with the Purge Completed Purchase Orders task.
- The Purge Expired Master/Repeating Orders option has been replaced with the Purge Expired and Master Repeating Order task.
- The Purge Completed or Cancelled PO Recap option has been replaced with the Purge Completed or Cancelled PO Recap task.
- The Purge Obsolete Purchase Orders option has been replaced with the Purge Obsolete Purchase Orders task. Additionally, records dated on or before the purge date entered has been removed.
- The Purge Purchase Order Receipt History option has been replaced with the Purge Purchase Order Receipt History task.
- The Purge Purchases History utility has been added to the Utilities menu to remove purchase history. Previously, the purchase history was removed during period end processing.
Printing

- Reports and listings now use Crystal Reports. Because of this, the Purchase Order module no longer uses the settings established in Library Master Report Format Maintenance.

- The report and form windows now remain open when you receive the message dialog box stating there is no data in the range to print so you can resolve the issue without losing your settings.

- The process for exporting or printing a report to a file has changed. The Print to File option previously available in the Printer Setup window has been moved to the Export/E-mail option accessed from the Printer field and it uses the Crystal Reports engine. For more information on how to export or print reports to a file, see Export or Print to a File in the Help system.

- The process for deferring the printing of a report has changed. The Deferred option has been moved to the Deferred option accessed from the Printer field. This option was previously available in the Printer Setup window. For more information on how to defer the printing of a report, see Defer a Report in the Help system.

- Print jobs scheduled for deferred printing are now located in the ..\Home\Deferred folder.

- The font size on some reports was changed to allow the report to remain in portrait format.

Registers and Updates

The Purchase Order Variance Register now prints after the register and before the update. Previously, this register printed after the update.

Reports and Forms

- In the Back Order Fill Report, you can now print only the items that have a back ordered quantity on the sales order if the received quantity is not equal to zero. Previously, the report printed all items on the purchase order that had a back ordered quantity on the sales order.
Chapter 18 Changes to Purchase Order

- Report setting options now appear on the header area of the applicable report window. You can also define and save customized report settings. For more information, see Create a Report Setting in the Help system.

- The report and form windows now remain open when you receive the "Data is not selected for report printing" message dialog box so you can resolve the issue without losing your settings.

Renamed, Removed, or Moved Tasks

- The Purge Completed Purchase Orders, Purge Expired Master/Repeating Orders, Purge Completed or Cancelled PO Recap, and Purge Obsolete Purchase Order utilities have been moved from the Period End Processing window to the Utilities menu.

- The Purge Purchase Order Receipt History and Purge Purchases History utilities have been added to the Utilities menu.

- The Open PO by Item Report has been renamed Open Orders by Item Report.

- The Open PO by Job Report has been renamed Open Orders by Job Report.

- The Receipt History Report has been renamed Purchase Order Receipt History Report.

- The Open PO by Work Order Report has been renamed Open Orders by Work Order Report.

- The Automatic Reorder Selection option has been renamed Auto Reorder Selection.

- The Ship to Address Maintenance task has been renamed Ship-To Address Maintenance.

- The Miscellaneous Charge Maintenance task has been renamed Miscellaneous Item Maintenance.
Chapter 19

Changes to Payroll

This chapter describes the changes made to the Payroll module.

Taxes

The following change was made in version 4.40.

In the Quarterly 941 Printing window, the Current Tax Withholding, Prior Quarter Social Sec/Medicare, Additions to Federal Tax, and Additions to Social Sec/Medicare fields have been removed. The COBRA Premium Assist. Payments and Individuals Provided COBRA Assist. fields have been added.

The following changes were made in version 4.20.

- In the Federal Tax Summary window, the Employee FICA Tips and Employer FICA Tips fields were added for wages. The Employee FICA Tip fields were added for payroll taxes.
- In Manual Payroll Tax Entry window, the FICA Tip Tax field was added.
- In Quarterly Tax Report window, the Print FICA Tip Data check box was added.
- The Mag Media Tax Type Code field in the P/R Tax Table Maintenance window was renamed Electronic Reporting Tax Type Code. The field name was changed to accurately reflect the new process required by the federal government. For more information, see Changes to Electronic Reporting for W2 and 1099 (Magnetic Media Reporting) on page 141.
Chapter 19 Changes to Payroll

Direct Deposits

The following changes were made in version 4.30.

- In the Direct Deposit Interface Setup window, the account numbers can now only be viewed. The account numbers can be changed using Bank Code Maintenance.

- The Space Rather Than Dash in the Word ‘Pre-Note’ check box is now available in the Direct Deposit Interface Setup window. Previously, this check box was in the Extended Solution’s PR-1017 Setup Options window.

- During conversion, if there is a discrepancy between the bank ID (bank account) number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

Reports

The following changes were made in version 4.20.

To comply with new regulations regarding how social security tips are being reported, the following reports are modified to show FICA and FICA tips totals separately:

- Quarterly Governmental Report
- Payroll Data Entry Audit Report
- Payroll Check History Report
- Employee Listing
- Perpetual History Report
- Employee Listing
- Employer’s Expense Summary
- Quarterly Pay Period Recap
- Payroll Check Printing
- Direct Deposit Stub Printing
- Quarterly Tax Report
Chapter 20

Changes to Return Merchandise Authorization

This chapter describes the changes made to the Return Merchandise Authorization module.

Data Entry

The following changes were made in version 4.40.

The Item Inquiry window has been replaced with the Item Quantity Inquiry window in RMA Entry and RMA Receipts Entry.

Utilities

The following changes were made in version 4.10.

Various options previously included in the RMA Utilities task have been moved to the Utilities menu as follows:

- The Purge Expired RMAs option has been replaced by the Purge Expired RMA task.
- The Purge Return Reason Detail option has been replaced by the Purge Return Reason Detail task.
- The Purge RMA Receipts History option has been replaced by the Purge RMA Receipts History task.
- The Create Customer Invoice Search Records option has been replaced by the Create Customer Invoice Search Records task.
Chapter 20 Changes to Return Merchandise Authorization
Chapter 21

**Changes to Sales Order**

This chapter describes the changes made to the Sales Order module.

**Security Option for Adding Inventory Items on the Fly**

The following changes were made in version 4.40.

You can now use a security event in Role Maintenance to prevent users from adding inventory items on the fly. Previously, the Allow On-the-Fly Additions of Inventory Items field was available in Sales Order Options.

**Global Changes**

The following changes were made in version 4.10.

If the Inventory Management module is integrated with Sales Order, you can now retain a customer's last purchase price information for both inventory items and miscellaneous items. Previously, you could retain the last purchase price information for inventory items only.

**Data Entry**

The following changes were made in version 4.40.

- In the Sales Order Entry window, the user login ID is now displayed if security is set up. Previously, the user code displayed.

- The Item Inquiry window has been replaced with the Item Quantity Inquiry window in Sales Order Entry and Invoice Data Entry.
Chapter 21 Changes to Sales Order

Sales History

The following changes were made in version 4.10.

- Previously, sales history was saved by period and month. With version 4.10 and higher, sales history is now continuously saved by invoice date and posting date.

- With version 4.10 and higher, you must retain at least two years of sales history at the Years to Retain Sales History field in the Sales Order Options window, with the option to retain up to 99 years.

- Because of the new method for saving history, the Enter Customer Sales History Option by Customer Type check box and the Customer Type/Option fields in Sales Order Options have been removed.

Sales History Reports

The following changes were made in version 4.40.

The Customer Sales History Report now prints by invoice date or posting date depending on whether you base inventory periods by fiscal periods or calendar months. Previously, this report was printed by period or month.

This same report also printed sales history by item or product line. Now you can print information using three new reports.

- Customer Sales History by Item
- Customer Sales History by Product Line
- Customer Sales History
The following changes were made in version 4.10.

Because sales history is now saved by invoice date and posting date, four new reports, Sales Recap by Division, Sales Recap by Product Line, Sales Recap by Warehouse, and Sales Recap by Warehouse and Product Line replace the Monthly Recap by Division, Monthly Recap by Product Line, Monthly Recap by Warehouse, and Monthly Recap by Warehouse and Product Line reports. After upgrading to version 4.10 or higher, if you need to reference the Monthly Recap reports or the previous Customer Sales History report, select File > Run and type the following in the Run Program window:

- **SOWRJA** to access the Monthly Recap by Product Line report
- **SOWRKA** to access the Monthly Recap by Warehouse/Product Line report
- **SOWRLA** to access the Monthly Recap by Warehouse report
- **SOWRMA** to access the Monthly Recap by Division report
- **SOWRNA** to access the Customer Sales History report

**Period End Processing**

The following changes were made in version 4.10.

Only full period-end processing can be performed in the Period End Processing task accessed from the Period End menu.

Various fields previously included in the Period End Processing window have been moved to the Utilities menu as follows:

- The Purge Sales Order History option has been replaced by the Purge Order/Quote History task.
- The Purge Expired Master/Repeating Orders and Purge Expired Price Quotes options have been replaced by the Purge Expired Orders/Quotes task.
- The Purge Sales Order Recap option has been replaced by the Purge Sales Order Recap task.
Job Cost Integration

The following changes were made in version 4.10.

Because the Job Cost module can now be integrated with Sales Order, the way that job costs are posted can affect statements of profitability. If you are upgrading from version 4.05 or prior, make sure you plan how to post job costs before upgrading.

- If job costs are posted from the Accounts Payable or Purchase Order module, do not select the Post Invoice Costs to Job Cost check box in the Sales Order Options window. If this check box is selected, costs can potentially be posted to the Job Cost module from more than one module, resulting in an understatement of profitability.

- If the Accounts Payable or Purchase Order modules are not integrated with Job Cost, select the Post Invoice Costs to Job Cost check box in the Sales Order Options window. If this check box is not selected, costs may not be posted to the Job Cost module at all, resulting in an overstatement of profitability.

Renamed, Removed, or Moved Tasks

The following changes were made in version 4.40.

- The Monthly Recap by Division has been renamed Sales Recap by Division.

- The Monthly Recap by Product Line has been renamed Sales Recap by Product Line.

- The Monthly Recap by Warehouse has been renamed Sales Recap by Warehouse.

- The Monthly Recap by Warehouse by Product Line has been renamed Sales Recap by Warehouse by Product Line.
Chapter 22

Changes to Visual Integrator

This chapter describes the changes made to Visual Integrator.

Data Dictionaries

The following changes were made in version 4.40.

Before you use the Visual Integrator module, select Visual Integrator Main menu > Export Job Maintenance or Import Job Maintenance after installing version 4.40. This initiates the necessary update of the Data Dictionaries so that you can successfully create Visual Integrator jobs.

The following changes were made in version 4.10.

After installing Version 4.10, before you use the Visual Integrator module, select Visual Integrator Main menu > Export Job Maintenance. This executes the necessary update of the Data Dictionaries so that you can successfully create Visual Integrator jobs.

The following changes were made in version 4.0.

After installing Version 4.0, before you use the Visual Integrator module, select Visual Integrator Main menu > Export Job Maintenance. This executes the necessary update of the Data Dictionaries so that you can successfully create Visual Integrator jobs.
Data Dictionary Listing

The following changes were made in version 4.40.

File information for modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order is no longer included on the Data Dictionary Listing. To obtain file information for these modules, on the Desktop, access the Resources page and click the File Layouts and Program Information link. You must re-create Visual Integrator jobs for these modules.

The following changes were made in version 4.20.

File information for the Accounts Payable module is no longer included on the Data Dictionary Listing. To obtain file information for these modules, on the Desktop, access the Resources page and click the File Layouts and Program Information link. You must re-create Visual Integrator jobs for Accounts Payable.

The following changes were made in version 4.10.

File information for the Accounts Receivable, Bank Reconciliation, e-Business Manager, Return Merchandise Authorization, and Sales Order modules is no longer included on the Data Dictionary Listing. To obtain file information for these modules, on the Desktop, access the Resources page and click the File Layouts and Program Information link. You must re-create Visual Integrator jobs for these modules.

The following changes were made in version 4.0.

Import Job Maintenance

The following changes were made in version 4.40.

- When you select Visual Integrator Main menu > Import Job Maintenance, the new window, V/I Import Job Selection appears. In the V/I Import Job Selection window, you can enter a new job name or select an existing job. For new jobs, you must select the table (previously referred to as File Name) for which the import will be prepared. After a table is selected, the Import Job Maintenance window appears.

  If a table for modules other than Job Cost, Material Requirements Planning, Payroll, or Work Order is selected in the V/I Import Job Selection window, only the tables for those modules are available for selection at the Table Name field (previously called File Name field) in the Import Job Maintenance window. If a table from Job Cost, Material Requirements Planning, Payroll, TimeCard, or Work Order module is selected in the V/I Import Job Selection window, files from only these modules are available at the File Name field in the Import Job Maintenance window.

- The Validation tab is no longer available because validation is done by the business object. When you create a job for the Job Cost, Material Requirements Planning, Payroll, TimeCard, or Work Order modules, the Validation tab is available.

- In the Import Job Maintenance window, when you create a job for modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, or Work Order, you cannot test or execute the import job until your system administrator gives you the rights to execute the job in Role Maintenance. Previously, system security did not prevent you from immediately executing jobs for these modules.

- You must re-create all Visual Integrator jobs to import inventory, bill of materials, and purchase order data.

- All data entry business objects now allow an existing line item in the Detail file to be modified. The Line Key field is now displayed in red and its value must be provided to edit an existing detail line. If the value provided is blank or invalid, a new detail line will be added from the import record.
Chapter 22 Changes to Visual Integrator

- The ability to import lot and serial distribution records is now included in the related header import. In the Available Fields section of the Data tab, tier distribution fields are now available and are preceded by the letters LL. Previously, importing lot and distribution records was only available in Sales Order Invoice Data Entry and required a tier distribution record type using a pre-defined tier distribution import layout.

- In the Import Job Maintenance window, in the Available Selections section of the Record tab, the Change Next On option has been removed. When evaluating the Header information in the Source file and a change is found, the next record is automatically created. It is important to have consistent Header information when importing multiple line and distribution records. For example, if the key value (sales order number) in the Source file is the same for three rows, and one field in each row has a different value, the subsequent row will replace the previous row imported with the same key.

- The Job Import Log now contains the record type to distinguish between Header, Line, and Distribution records. Previously, only the Header and Line records displayed. The Distribution records were appended to the Line records.

The following changes were made in version 4.20.

If you select an Accounts Payable table for a new job in the V/I Import Job Selection window, corresponding tables are available for selection at the Table Name field in the Import Job Maintenance window. If a table from any other module is selected in the V/I Import Job Selection window, corresponding files from Accounts Payable are available for selection at the File Name field in the Import Job Maintenance window.
The following changes were made in version 4.10.

When you select Visual Integrator Main menu > Import Job Maintenance, the new window, V/I Import Job Selection appears. In the V/I Import Job Selection window, you can enter a new job name or select an existing job. For new jobs, you must select the table (previously referred to as File Name) for which the import will be prepared. After a table is selected, the Import Job Maintenance window appears. If an Accounts Receivable, Bank Reconciliation, Common Information, e-Business Manager, Return Merchandise Authorization, or Sales Order table is selected in the V/I Import Job Selection window, only these tables are available for selection at the Table Name field (previously called File Name field) in the Import Job Maintenance window. If a table from a module other than Accounts Receivable, Bank Reconciliation, Common Information, e-Business Manager, Return Merchandise Authorization, or Sales Order is selected in the V/I Import Job Selection window, files from any other module are available at the File Name field in the Import Job Maintenance window.

The following changes were made in version 4.0.

- When you select Visual Integrator Main menu > Import Job Maintenance, the new window, V/I Import Job Selection appears. In the V/I Import Job Selection window, you can enter a new job name or select an existing job. For new jobs, you must select the table (previously referred to as File Name) for which the import will be prepared. After a table is selected, the Import Job Maintenance window appears. If a general ledger table is selected in the V/I Import Job Selection window, only general ledger tables are available for selection at the Table Name field (previously called File Name field) in the Import Job Maintenance window. If a table from a module other than General Ledger is selected in the V/I Import Job Selection window, files from all modules other than General Ledger are available at the File Name field in the Import Job Maintenance window.

- In the Import Job Maintenance window, when you create a General Ledger job the Records tab is no longer available because there are no record types in General Ledger. Also, the Validation tab is no longer available because validation is done by the system. When you create a job for a module other than General Ledger in the Import Job Maintenance window, the Records tab and Validation tab are available.
In the Import Job Maintenance window, when you create a General Ledger job, you cannot test or execute the import job until your system administrator gives you the rights to execute the job in Role Maintenance. Previously, system security did not prevent you from immediately executing General Ledger jobs.

**Job Import**

The following changes were made in version 4.30.

You no longer need to run the VIWUD1 utility to update the data fields after you use Job Import to import Level 3.x jobs into Visual Integrator. This utility is now run automatically.

The following changes were made in version 4.0.

After you use Job Import to import Level 3.x jobs into Visual Integrator, use the VIWUD1 utility to update the data fields. To access the VIWUD1 utility, select File > Run. In the Run Program window, type VIWUD1.

**Export Jobs**

The following changes were made in version 4.0.

Chapter 23

Changes to Work Order

This chapter describes the changes made to Work Order in version 4.40.

Moved Task

The Bar Code Printer Maintenance task, previously on the Inventory Management Setup menu, has been moved to the Work Order Setup menu.

Data Dictionary Changes

The file layouts have been changed to accommodate the expanded item code and expanded customer number options.
Checklists

Before beginning the installation, test and validate all the hardware and network configurations using the following:

- The Installation and System Administrator’s Guide which can be found in the root folder D:\ (where D: is your CD-ROM drive) of the Sage MAS 90 or Sage MAS 200 CD-ROM. The guide is in Adobe Acrobat (PDF) format and is named either MAS90_Install.pdf or MAS200_Install.pdf, depending on the application that you own.

- The Supported Platform Matrix which can be found in the Support area of the Sage Online Web site at: www.sagesoftwareonline.com

- The current support library for any pertinent information, particularly the Hot Pre-Installation Information page which can be found in the Support area of the Sage Online Web site at: www.sagesoftwareonline.com

Migration and Conversion Process

The migration process consists of three steps:

1. Preparing your source data for migration
2. Migrating your source data to your 4.40 system
3. Converting your source data to version 4.40

This appendix contains the information you will need to migrate and convert your data based on the version of your source data. Proceed to the applicable section as follows:

- Migrating from Level 3.x to Version 4.40 on page 184
- Migrating from Version 4.00 or 4.05 to Version 4.40 on page 195
- Migrating from Version 4.10 to Version 4.40 on page 204
- Migrating from Version 4.20 to Version 4.40 on page 213
- Migrating from Version 4.30 to Version 4.40 on page 222
Appendix A  Checklists

Migrating from Level 3.x to Version 4.40

Prior to migrating your level 3.x source data to version 4.40, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage business partner or development partner prior to beginning the migration process.

Pre-Migration Checklist

After installing the current version of the software, you must prepare your level 3.x source data for migration. This should be done for each company you plan to migrate.

1. Create a copy of your Level 3.x companies by selecting File menu > Run and typing SVDATA at the Program Name field. Create a backup of your MAS90 folder following your backup process. For specific support on how to back up your data, refer to manuals for your backup software or contact the vendor from whom you purchased that product.

If your company code has special characters, run SVDATA to a new company code. Version 4.40 does not support special characters.

2. Verify all data entry files are empty. Print and update all journals and registers. Any data in the data entry files during the migration will be lost (for example, Accounts Receivable Cash Receipts Entry).

3. If data exists in alternate directories, verify in Alternate Directory Maintenance that a UNC path exists for all alternate directories. If changes were made in Alternate Directory Maintenance, rebuild alternate directory pointers using the Library Master Repair menu.

4. Rebuild all data files using the Rebuild Key Files and Rebuild Sort File utilities. You must answer Yes to all recalculation questions.

5. Confirm in Accounts Receivable Customer Maintenance that all customers that have tax exempt numbers have a sales tax code defined. If a sales tax code is not defined, the tax exempt number will be deleted during the upgrade.

NOTE
You must update or clear all data entry in progress to prevent the data from becoming cleared during data migration.
6. Select Library Master Utilities menu > Pre Migration, then enter the source path and company code for your Level 3.x system. Select the reports and utilities that appear.

   a. Select General Ledger Account Validation Report to display all missing general ledger accounts.
      - To fix the accounts, in your Level 3.x system, use General Ledger Main menu > Account Maintenance.

   b. Select General Ledger Special Character Report to display a list of all general ledger accounts with special characters.
      - To fix the accounts, in your Level 3.x system, use General Ledger Setup menu > Account Delete/Renumber/Merge.

   c. Select General Ledger Out of Balance Report to display a list all source journals that are out of balance.
      - To determine how to resolve the out of balance journals, in your Level 3.x system, select General Ledger Reports menu > General Ledger Detail Report and make any corrections to the journal entries as necessary.
      - Recalculate the account balances for each general ledger fiscal year that has transaction history using General Ledger Fiscal Year Maintenance.
      - Perform year-end processing for each year, beginning with the first year you have detail for and have recalculated.
      - Print the General Ledger Trial Balance Report with the beginning and ending balance detail, and all Financial Statements.

NOTE: The tasks that appear in the Pre Migration window are based on the version of your source data.
Appendix A  Checklists

d Select the General Ledger Future Years Utility to check for detail transactions, periodic summary totals, and future fiscal years.

- On the General Ledger Detail Transaction Utility window, accept all the field defaults and then click Log Only.

- Review the log to determine if you would like to remove the future dated data.

- If you want to remove data, run the utility again, and at the Highest Fiscal Year to Retain field, enter the highest year you want to retain future data. Click Log Only and print the report as an audit trail.

- To confirm your data was removed, run the utility again with the same year entered in the previous step. Click Delete to remove the detailed data for the future years.

e Select Item Code Validation Report to display missing item codes from your Warehouse Detail, Item Costing, and Transaction Detail files.

- To fix the files, in your level 3.x source data, use Inventory Management Main menu > Inventory Maintenance.

f Select Inventory File Comparison Report to compare the quantity in your warehouse, tier, and transaction inventory data files.

- Run this report by warehouse and save as an audit trail.

- To correct any quantities, run the Inventory Balancing Utility.
g Select Inventory Balancing Utility to balance your inventory quantities.

- Run this utility for each warehouse.
- At the Action column, select the action to perform for each item, or apply a specific action based on valuation type.
- If the valuation is LIFO, FIFO, Lot, or Serial, at the Action column select Skip if the tier quantities are incorrect. You must perform a physical count to correct the tier quantity. After the tier quantity is correct, run this utility for these valuation methods.
- If the valuation is Average Cost or Standard Cost and the warehouse and transaction quantities are incorrect, you must perform a physical count to correct the warehouse quantity. After the warehouse quantity is correct, run this utility for those valuation methods.
- For more information, see Balance Inventory Quantities in the Help system.

h Run all Inventory Pre Migration tasks again to ensure corrections were made. Keep all reports as an audit trail.

7 Remove all negative tiers using Inventory Management Period End Processing.

Appendix A  Checklists

Post-Migration Checklist

After preparing your level 3.x source data for migration following the Pre-Migration Checklist on page 184, you are now ready to migrate your data to your 4.40 system.

1. Select Library Master Utilities menu > Parallel Migration to migrate your source data to your 4.40 system.

2. To run MS Script links, you must have the Microsoft Windows Script Host processor on your system. For information on installing the MS Windows Script Host processor, refer to the Microsoft Download Center Web site.

3. If you use Automatic Update or Task Schedule, review your scheduled automatic updates and reschedule those updates by selecting Library Master Main menu > Automatic Update or Task Scheduler, as applicable.

4. If you had task folders in your level 3.x Launcher’s My Tasks area, re-create your Public and Private task folders.

5. Test all printers, including Device Configurator printers, that you normally use for printing business critical forms and reports. Each workstation must have a default printer defined.

6. If you are printing bar codes, install the Azalea fonts from the WkSetup\Azalea folder on the Sage MAS 90 or 200 CD-ROM.

7. If security is enabled, set up security using Role Maintenance as follows:
   - Create roles for all tasks you would like to secure. Review all roles and update permissions for all modules and features.
   - For Common Information tasks that appear on multiple menus, security must be set up for the Common Information module using Role Maintenance. For more information, see Common Information Changes on page 76.
   - Set up ODBC security using Role Maintenance.
8. If you migrated data from your Level 3.x system, the entire user name was migrated to the Last Name field in the User Maintenance window. To use the First and Last Name functionality, modify each user name using User Maintenance.

9. If you are using Unified Logon and you migrated your system files, you must add the following statement on one workstation SOTA.ini: Logon=Yes. When you launch Sage MAS 90 or 200, log on as Administrator and set up and assign the appropriate roles to your users.

10. If you have custom buttons on your Desktop in your Level 3.x system, re-create those buttons on the Custom toolbar.

Conversion Checklist

After preparing your level 3.x source data for migration following the Pre-Migration Checklist on page 184 and Post-Migration Checklist on page 188, you are now ready to convert your source data to version 4.40.

1. Select Library Master Main menu > Company Maintenance to convert your source data to version 4.40. This must be done for each of your companies.

2. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to the new version of the software and prior to accessing other modules, select Library Master Utilities menu > Lookup Conversion to convert your lookups.

Re-create customizations to lookups in all modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. This includes customizations created in the User Lookup Wizard and by clicking Custom in a lookup window.

If you modified list modes using the Library Master List Mode Master feature, you must use the User Lookup Wizard to re-create them. List Mode Master was replaced by the User Lookup Wizard. For more information, see User Lookup Wizard in your Library Master Help system.

NOTE
If you migrated Level 3.x user logons and passwords, these passwords were converted to uppercase letters; therefore, they must now be entered as uppercase letters.
3. Rebuild all application sort files using the Rebuild Sort File utility. You must answer Yes to all recalculation questions.

4. Click Reset on your Accounts Payable 1099 forms and Payroll W2 forms to apply new format changes. Use the Forms layout printed during the pre-migration process to reenter your modifications.

5. Review your Tax Tables. Installing the Tax Table Update (TTU) replaces all of your current state and federal tax tables with new tables unless you have specifically excluded a state tax table from the update by selecting the Exclude this Table from Tax Update check box in Tax Table Maintenance. Local tax information is not updated.

6. Review the placement of all your user-defined fields. Update the customized forms using Custom Office Update Customized Panels to Current Level. For more information, see Customizer Changes on page 78.

Re-customize the customized libraries for all modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Customizer Changes on page 78.
7. Run the Crystal Form Comparison Report utility (select File menu > Run, then type SYWFCU) to compare your customized forms to a standard form from version 4.40. For more information, see Customized Crystal Forms on page 53. If you were previously using non-graphical forms, you will need to set them up in Crystal Reports.

Test your modified Crystal Reports and forms. Before modifying graphical forms or the standard Crystal Reports found on the Custom Reports menu, you must be proficient in the use of Crystal Reports.

If you are using Crystal Web Reports, you must run the Crystal Conversion Wizard on all reports.

Use the Crystal Reports Conversion Wizard to convert your Crystal reports and forms. For more information, see Crystal Reports FAQs in the Help system.

If you are upgrading from a level prior to Level 3.41, you must manually convert your Crystal reports and forms.

Add any custom reports to the Custom Reports menu using Report Manager.

8. If dictionary changes were made to any file used on an import created in the Visual Integrator module, those imports will need to be manually updated. Review the appropriate file layout using the File Layouts and Program Information link on the Resources page of the Desktop and the Data Dictionary Listing accessed from the Visual Integrator Main menu to verify that the imported field names are consistent with the new file layout.

9. Set up the Paperless Office module to e-mail statements, reports, journals, registers, and other forms. For more information, see Set Up Paperless Office in the Help system.

10. Set up your Business Insights Dashboard pages. For more information, see Set Up Business Insights Dashboard in the Help system.
Appendix A  Checklists

11____ To use the e-Business Manager module, restore the copied templates back to the IW folder after re-installing the Web Engine.

12____ If you had the Extended Solution for direct deposits, review the conversion log for any bank account numbers that were changed due to a discrepancy between the bank account numbers in Bank Code Maintenance and Direct Deposit Interface Setup.

13____ If you do not use taxation for purchase orders, clear the Sales Tax Reporting check box in the Accounts Payable Options window.

14____ If you include sales tax on purchase orders and want to enter default tax schedules for vendors, use Accounts Payable Assign Vendor Tax Schedules to assign tax schedules.

15____ Confirm in Accounts Receivable Customer Maintenance that all customers that have exemption numbers still have the exemption number defined.

16____ To access the Custom Financials menu and tasks, select File menu > Run and type *unhidegl in the Run Program window. For more information, see Custom Financials on page 147.

17____ Checks in the Payroll and Accounts Payable modules can now be printed in American National Standards Institute (ANSI) format.

   Be sure to first print the check and compare your check stock. Make any needed adjustments.

   To print non-graphical payroll checks in ANSI format, clear the Graphical Forms check box for Checks in the Setup Options window. In the Payroll module, select the Print in ANSI Format check box in the Check Printing window.

   To print graphical payroll checks in ANSI format, select the Graphical Forms check box for Checks in the Payroll Options window. If you have a check form that was created prior to Level 3.70, you can reset the form so that the ANSI Check Amount field appears in the Field Description list on the Detail tab; however, clicking Reset on the Header tab resets all the settings on the form. Print the form layout first, in case changes need to be reentered. As an alternative to resetting the form, you can create a new form.

   In the Accounts Payable module, select the Print in ANSI Format check box in the Check Printing or Manual Check Printing window.
18. If you are upgrading from a level prior to Level 3.70, the way that completions are handled has changed in the Work Order module. If you have existing work order completions prior to Level 3.70, see Costing Methods for Unit Cost of Completion Entry in the Help system to review examples of cost completion methods.

19. The file structure for Warehouse Grouping Maintenance in the Material Requirements Planning module was modified in Level 3.70 to correct Material Requirements Planning generation problems that occurred from inconsistencies in the warehouse grouping data entry. Because changes to the Warehouse Grouping Maintenance file will be initialized if upgrading from Level 3.61 or prior to Level 3.70 or 3.71, the Warehouse Groupings must be reentered in Warehouse Grouping Maintenance after the Material Requirements Planning module has been upgraded.

20. If you have the Extended Solution for direct deposits, verify the bank ID (bank account) number for each bank code. During conversion, if there is a discrepancy between the bank ID number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

21. Print and compare all customized form definitions, including your Accounts Payable 1099 forms, Payroll W-2 forms, and quarterly governmental reports. Default forms may be erased in the migration process.

If you plan to use Federal and State eFiling and Reporting for the 1099 forms, W-2 forms, and governmental reports, perform the conversion to version 4.40 after the quarter end and before the first payroll in the current quarter to avoid values being placed in the wrong boxes on some forms. If conversion is performed mid-quarter, some forms may require editing.
Appendix A  Checklists

22  Compare the following level 3.x and 4.40 reports because sales tax may be recalculated during the conversion: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

23  Export your level 3.x Report Master reports for the Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order modules using Report Master Job Export. Import them into your version 4.40 installation using Report Master Job Import. You must recompile all custom reports defined using Report Master. To recompile reports, access Report Master Maintenance and enter the report name. At the maintenance screen menu bar, type ~ (tilde). Click Yes in the "Do you wish to prepare this report?" message dialog box to recompile. Repeat this procedure for each defined report. Changes have been made to level 3.x data dictionaries.

To access Report Master, select File > Run and type *unhiderm in the Run Program window to generate custom reports for Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Report Master Changes on page 108.

24  If you purchased the Return Merchandise Authorization module, after setting up Return Merchandise Authorization data files for the first time to a pre-existing Sage MAS 90 installation, select Return Merchandise Authorization Setup menu > Create Customer Invoice Search Records to create customer invoice search records in RMA.

Congratulations on migrating and converting your data. For information on what is new in this release, see What's New in Version 4.40 on page 5. Highlights include:

- You can format your general ledger account structure with up to 32 characters and 10 segments.
- You can expand your customer number to 20 characters, from 7 characters in previous releases.
- You can expand your item code to 30 characters, from 15 characters in previous releases.
Migrating from Version 4.00 or 4.05 to Version 4.40

Prior to migrating your version 4.00 or 4.05 source data to version 4.40, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage business partner or development partner prior to beginning the migration process.

Pre-Migration Checklist

After installing the current version of the software, you must prepare your version 4.00 or 4.05 source data for migration. This should be done for each company you plan to migrate.

1. Create a copy of your version 4.00 or 4.05 companies by selecting Library Master Main menu > Company Maintenance. Use the Copy feature in this task. Create a backup of your MAS90 folder following your backup process. For specific support on how to back up your data, refer to manuals for your backup software or contact the vendor from whom you purchased that product.

2. Verify all data entry files are empty. Print and update all journals and registers. Any data in the data entry files during the migration will be lost (for example, Accounts Receivable Cash Receipts Entry).

3. Rebuild all data files using the Rebuild Key Files and Rebuild Sort File utilities. You must answer Yes to all recalculation questions.

4. Confirm in Accounts Receivable Customer Maintenance that all customers that have tax exempt numbers have a sales tax code defined. If a sales tax code is not defined, the tax exempt number will be deleted during the upgrade.

NOTE
You must update or clear all data entry in progress to prevent the data from becoming cleared during data migration.
Appendix A  Checklists

Select Library Master Utilities menu > Pre Migration, then enter the source path and company code for your version 4.00 or 4.05 system. Select the reports and utilities that appear.

- **a** Select Item Code Validation Report to display missing item codes from your Warehouse Detail, Item Costing, and Transaction Detail files.
  - To fix the files, in your version 4.00 or 4.05 source data, use Inventory Management Main menu > Inventory Maintenance.

- **b** Select Inventory File Comparison Report to compare the quantity in your warehouse, tier, and transaction inventory data files.
  - Run this report by warehouse and save as an audit trail.
  - To correct any quantities, run the Inventory Balancing Utility.

- **c** Select Inventory Balancing Utility to balance your inventory quantities.
  - Run this utility for each warehouse.
  - At the Action column, select the action to perform for each item, or apply a specific action based on valuation type.

  - If the valuation is LIFO, FIFO, Lot, or Serial, at the Action column select Skip if the tier quantities are incorrect. You must perform a physical count to correct the tier quantity. After the tier quantity is correct, run this utility for these valuation methods.

  - If the valuation is Average Cost or Standard Cost and the warehouse and transaction quantities are incorrect, you must perform a physical count to correct the warehouse quantity. After the warehouse quantity is correct, run this utility for those valuation methods.

  - For more information, see Balance Inventory Quantities in the Help system.
MIGRATING FROM VERSION 4.00 OR 4.05 TO VERSION 4.40

**d** Run all Inventory Pre Migration tasks again to ensure corrections were made. Keep all reports as an audit trail.

**6** Remove all negative tiers using Inventory Management Period End Processing.


**8** If you created reports using Business Insights Reporter, review the report names in the Business Insights Reporter selection window. If there are multiple reports with similar names, copy the reports and assign a distinct name for each report.


For more information, see Copy a Report in the Help system.

**Post-Migration Checklist**

After preparing your version 4.00 or 4.05 source data for migration following the Pre-Migration Checklist on page 195, you are now ready to migrate your data to your 4.00 system.

**1** Select Library Master Utilities menu > Parallel Migration to migrate your source data to your 4.00 system.

**2** To run MS Script links, you must have the Microsoft Windows Script Host processor on your system. For information on installing the MS Windows Script Host processor, refer to the Microsoft Download Center Web site.

**3** If you use Automatic Update or Task Schedule, review your scheduled automatic updates and reschedule those updates by selecting Library Master Main menu > Automatic Update or Task Scheduler, as applicable.
4. If you had task folders in your My Tasks area, re-create your Public and Private task folders.

5. Test all printers, including Device Configurator printers, that you normally use for printing business critical forms and reports. Each workstation must have a default printer defined.

6. If you are printing bar codes, install the Azalea fonts from the WkSetup\Azalea folder on the Sage MAS 90 or 200 CD-ROM.

7. If security is enabled, set up security using Role Maintenance as follows:
   - Create roles for all tasks you would like to secure. Review all roles and update permissions for all modules and features.
   - For Common Information tasks that appear on multiple menus, security must be set up for the Common Information module using Role Maintenance. For more information, see Common Information Changes on page 76.
   - Set up ODBC security using Role Maintenance.

8. If you are using Unified Logon and you migrated your system files, you must add the following statement on one workstation SOTA.ini: Logon=Yes. When you launch Sage MAS 90 or 200, log on as Administrator and set up and assign the appropriate roles to your users.

9. If you have custom buttons on your Desktop, re-create those buttons on the Custom toolbar.
Conversion Checklist

After preparing your version 4.00 or 4.05 source data for migration following the Pre-Migration Checklist on page 195 and Post-Migration Checklist on page 197, you are now ready to convert your source data to version 4.40.

1. Select Library Master Main menu > Company Maintenance to convert your source data to version 4.40. This must be done for each of your companies.

2. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to the new version of the software and prior to accessing other modules, select Library Master Utilities menu > Lookup Conversion to convert your lookups.

   Re-create customizations to lookups in all modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. This includes customizations created in the User Lookup Wizard and by clicking Custom in a lookup window.

   If you modified list modes using the Library Master List Mode Master feature, you must use the User Lookup Wizard to re-create them. List Mode Master was replaced by the User Lookup Wizard. For more information, see User Lookup Wizard in your Library Master Help system.

3. Rebuild all application sort files using the Rebuild Sort File utility. You must answer Yes to all recalculation questions.

4. Review your Tax Tables. Installing the Tax Table Update (TTU) replaces all of your current state and federal tax tables with new tables unless you have specifically excluded a state tax table from the update by selecting the Exclude this Table from Tax Update check box in Tax Table Maintenance. Local tax information is not updated.
5. Review the placement of all your user-defined fields. Update the customized forms using Custom Office Update Customized Panels to Current Level. For more information, see Customizer Changes on page 78.

Re-customize the customized libraries for all modules other than General Ledger, Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Customizer Changes on page 78.

6. Run the Crystal Form Comparison Report utility (select File menu > Run, then type SYWFCU) to compare your customized forms to a standard form from version 4.40. For more information, see Customized Crystal Forms on page 53. If you were previously using non-graphical forms, you will need to set them up in Crystal Reports.

Test your modified Crystal Reports and forms. Before modifying graphical forms or the standard Crystal Reports found on the Custom Reports menu, you must be proficient in the use of Crystal Reports.

If you are using Crystal Web Reports, you must run the Crystal Conversion Wizard on all reports.

Use the Crystal Reports Conversion Wizard to convert your Crystal reports and forms. For more information, see Crystal Reports FAQs in the Help system.

Add any custom reports to the Custom Reports menu using Report Manager.

7. If dictionary changes were made to any file used on an import created in the Visual Integrator module, those imports will need to be manually updated. Review the appropriate file layout using the File Layouts and Program Information link on the Resources page of the Desktop and the Data Dictionary Listing accessed from the Visual Integrator Main menu to verify that the imported field names are consistent with the new file layout.
8. Set up the Paperless Office module to e-mail statements, reports, journals, registers, and other forms. For more information, see Set Up Paperless Office in the Help system.

9. Set up your Business Insights Dashboard pages. For more information, see Set Up Business Insights Dashboard in the Help system.

10. To use the e-Business Manager module, restore the copied templates back to the IW folder after re-installing the Web Engine.

11. If you had the Extended Solution for direct deposits, review the conversion log for any bank account numbers that were changed due to a discrepancy between the bank account numbers in Bank Code Maintenance and Direct Deposit Interface Setup.

12. If you do not use taxation for purchase orders, clear the Sales Tax Reporting check box in the Accounts Payable Options window.

13. If you include sales tax on purchase orders and want to enter default tax schedules for vendors, use Accounts Payable Assign Vendor Tax Schedules to assign tax schedules.

14. Confirm in Accounts Receivable Customer Maintenance that all customers that have exemption numbers still have the exemption number defined.

15. To access the Custom Financials menu and tasks, select File menu > Run and type *unhidegl in the Run Program window. For more information, see Custom Financials on page 147.
Appendix A  Checklists

16. Checks in the Payroll and Accounts Payable modules can now be printed in American National Standards Institute (ANSI) format.

   To print nongraphical payroll checks in ANSI format, clear the Graphical Forms check box for Checks in the Setup Options window. In the Payroll module, select the Print in ANSI Format check box in the Check Printing window.

   To print graphical payroll checks in ANSI format, select the Graphical Forms check box for Checks in the Payroll Options window.

   In the Accounts Payable module, select the Print in ANSI Format check box in the Check Printing or Manual Check Printing window.

17. If you have the Extended Solution for direct deposits, verify the bank ID (bank account) number for each bank code. During conversion, if there is a discrepancy between the bank ID number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

18. Print and compare all customized form definitions, including your Accounts Payable 1099 forms, Payroll W-2 forms, and quarterly governmental reports. Default forms may be erased in the migration process.

   If you plan to use Federal and State eFiling and Reporting for the 1099 forms, W-2 forms, and governmental reports, perform the conversion to version 4.40 after the quarter end and before the first payroll in the current quarter to avoid values being placed in the wrong boxes on some forms. If conversion is performed mid-quarter, some forms may require editing.
19. Compare the following version 4.x and 4.40 reports because sales tax may be recalculated during the conversion: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

20. Export your version 4.00 or 4.05 Report Master reports for the Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order modules using Report Master Job Export. Import them into your version 4.40 installation using Report Master Job Import. You must recompile all custom reports defined using Report Master. To recompile reports, access Report Master Maintenance and enter the report name. At the maintenance screen menu bar, type ~ (tilde). Click Yes in the "Do you wish to prepare this report?" message dialog box to recompile. Repeat this procedure for each defined report. Changes have been made to your data dictionaries.

To access Report Master, select File > Run and type *unhiderm in the Run Program window to generate custom reports for Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Report Master Changes on page 108.

21. If you purchased the Return Merchandise Authorization module, after setting up Return Merchandise Authorization data files for the first time to a pre-existing Sage MAS 90 installation, select Return Merchandise Authorization Setup menu > Create Customer Invoice Search Records to create customer invoice search records in RMA.

Congratulations on migrating and converting your data. For information on what is new in this release, see What's New in Version 4.40 on page 5. Highlights include:

- You can expand your customer number to 20 characters, from 7 characters in previous releases.
- You can expand your item code to 30 characters, from 15 characters in previous releases.
Migrating from Version 4.10 to Version 4.40

Prior to migrating your version 4.10 source data to version 4.40, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage business partner or development partner prior to beginning the migration process.

Pre-Migration Checklist

After installing the current version of the software, you must prepare your version 4.10 source data for migration. This should be done for each company you plan to migrate.

1. Create a copy of your version 4.10 companies by selecting Library Master Main menu > Company Maintenance. Use the Copy feature in this task. Create a backup of your MAS90 folder following your backup process. For specific support on how to back up your data, refer to manuals for your backup software or contact the vendor from whom you purchased that product.

2. Verify all data entry files are empty. Print and update all journals and registers. Any data in the data entry files during the migration will be lost (for example, Accounts Receivable Cash Receipts Entry).

3. Rebuild all data files using the Rebuild Key Files and Rebuild Sort File utilities. You must answer Yes to all recalculation questions.

4. Select Library Master Utilities menu > Pre Migration, then enter the source path and company code for your version 4.10 system. Select the reports and utilities that appear.
   a. Select Item Code Validation Report to display missing item codes from your Warehouse Detail, Item Costing, and Transaction Detail files.

   • To fix the files, in your version 4.10 source data, use Inventory Management Main menu > Inventory Maintenance.
b Select Inventory File Comparison Report to compare the quantity in your warehouse, tier, and transaction inventory data files.

- Run this report by warehouse and save as an audit trail.
- To correct any quantities, run the Inventory Balancing Utility.

c Select Inventory Balancing Utility to balance your inventory quantities.

- Run this utility for each warehouse.
- At the Action column, select the action to perform for each item, or apply a specific action based on valuation type.
- If the valuation is LIFO, FIFO, Lot, or Serial, at the Action column select Skip if the tier quantities are incorrect. You must perform a physical count to correct the tier quantity. After the tier quantity is correct, run this utility for these valuation methods.
- If the valuation is Average Cost or Standard Cost and the warehouse and transaction quantities are incorrect, you must perform a physical count to correct the warehouse quantity. After the warehouse quantity is correct, run this utility for those valuation methods.
- For more information, see Balance Inventory Quantities in the Help system.

d Run all Inventory Pre Migration tasks again to ensure corrections were made. Keep all reports as an audit trail.

5 Remove all negative tiers using Inventory Management Period End Processing.

Appendix A  Checklists

7. If you created reports using Business Insights Reporter, review the report names in the Business Insights Reporter selection window. If there are multiple reports with similar names, copy the reports and assign a distinct name for each report.


For more information, see Copy a Report in the Help system.

Post-Migration Checklist

After preparing your version 4.10 source data for migration following the Pre-Migration Checklist on page 204, you are now ready to migrate your data to your 4.40 system.

1. Select Library Master Utilities menu > Parallel Migration to migrate your source data to your 4.40 system.

2. To run MS Script links, you must have the Microsoft Windows Script Host processor on your system. For information on installing the MS Windows Script Host processor, refer to the Microsoft Download Center Web site.

3. If you use Automatic Update or Task Schedule, review your scheduled automatic updates and reschedule those updates by selecting Library Master Main menu > Automatic Update or Task Scheduler, as applicable.

4. If you had task folders in your My Tasks area, re-create your Public and Private task folders.

5. Test all printers, including Device Configurator printers, that you normally use for printing business critical forms and reports. Each workstation must have a default printer defined.

6. If you are printing bar codes, install the Azalea fonts from the WkSetup\Azalea folder on the Sage MAS 90 or 200 CD-ROM.
7. If security is enabled, set up security using Role Maintenance as follows:
   - Create roles for all tasks you would like to secure. Review all roles and update permissions for all modules and features.
   - For Common Information tasks that appear on multiple menus, security must be set up for the Common Information module using Role Maintenance. For more information, see Common Information Changes on page 76.
   - Set up ODBC security using Role Maintenance.

8. If you are using Unified Logon and you migrated your system files, you must add the following statement on one workstation SOTA.ini: Logon=Yes. When you launch Sage MAS 90 or 200, log on as Administrator and set up and assign the appropriate roles to your users.

9. If you have custom buttons on your Desktop, re-create those buttons on the Custom toolbar.

**Conversion Checklist**

After preparing your version 4.10 source data for migration following the Pre-Migration Checklist on page 204 and Post-Migration Checklist on page 206, you are now ready to convert your source data to version 4.40.

1. Select Library Master Main menu > Company Maintenance to convert your source data to version 4.40. This must be done for each of your companies.

2. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to the new version of the software and prior to accessing other modules, select Library Master Utilities menu > Lookup Conversion to convert your lookups.

   Re-create customizations to lookups in all modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. This includes customizations created in the User Lookup Wizard and by clicking Custom in a lookup window.
Appendix A  Checklists

If you modified list modes using the Library Master List Mode Master feature, you must use the User Lookup Wizard to re-create them. List Mode Master was replaced by the User Lookup Wizard. For more information, see User Lookup Wizard in your Library Master Help system.

3. Rebuild all application sort files using the Rebuild Sort File utility. You must answer Yes to all recalculation questions.

4. Verify your modules do not have broken links by selecting Library Master Utilities menu > Link Maintenance. Links that display in red are broken and will need to be fixed using the Relink Files button in Link Maintenance. For more information on relinking files, see Copy/Move/Relink Files in your Help system.

5. Review your Tax Tables. Installing the Tax Table Update (TTU) replaces all of your current state and federal tax tables with new tables unless you have specifically excluded a state tax table from the update by selecting the Exclude this Table from Tax Update check box in Tax Table Maintenance. Local tax information is not updated.

6. Review the placement of all your user-defined fields. Update the customized forms using Custom Office Update Customized Panels to Current Level. For more information, see Customizer Changes on page 78.

Re-customize the customized libraries for all modules other than Accounts Receivable, Bank Reconciliation, e-Business Manager, General Ledger, Job Cost, Material Requirements Planning, Payroll, Return Merchandise Authorization, Sales Order, TimeCard, and Work Order. For more information, see Customizer Changes on page 78.
7. Run the Crystal Form Comparison Report utility (select File menu > Run, then type SYWFCU) to compare your customized forms to a standard form from version 4.40. For more information, see Customized Crystal Forms on page 53. If you were previously using non-graphical forms, you will need to set them up in Crystal Reports.

Test your modified Crystal Reports and forms. Before modifying graphical forms or the standard Crystal Reports found on the Custom Reports menu, you must be proficient in the use of Crystal Reports.

If you are using Crystal Web Reports, you must run the Crystal Conversion Wizard on all reports.

Use the Crystal Reports Conversion Wizard to convert your Crystal reports and forms. For more information, see Crystal Reports FAQs in the Help system.

Add any custom reports to the Custom Reports menu using Report Manager.

8. If dictionary changes were made to any file used on an import created in the Visual Integrator module, those imports will need to be manually updated. Review the appropriate file layout using the File Layouts and Program Information link on the Resources page of the Desktop and the Data Dictionary Listing accessed from the Visual Integrator Main menu to verify that the imported field names are consistent with the new file layout.

9. Set up the Paperless Office module to e-mail statements, reports, journals, registers, and other forms. For more information, see Set Up Paperless Office in the Help system.

10. Set up your Business Insights Dashboard pages. For more information, see Set Up Business Insights Dashboard in the Help system.

11. To use the e-Business Manager module, restore the copied templates back to the IW folder after re-installing the Web Engine.
12. If you had the Extended Solution for direct deposits, review the conversion log for any bank account numbers that were changed due to a discrepancy between the bank account numbers in Bank Code Maintenance and Direct Deposit Interface Setup.

13. If you do not use taxation for purchase orders, clear the Sales Tax Reporting check box in the Accounts Payable Options window.

14. If you include sales tax on purchase orders and want to enter default tax schedules for vendors, use Accounts Payable Assign Vendor Tax Schedules to assign tax schedules.

15. Confirm in Accounts Receivable Customer Maintenance that all customers that have exemption numbers still have the exemption number defined.

16. To access the Custom Financials menu and tasks, select File menu > Run and type *unhidegl* in the Run Program window. For more information, see Custom Financials on page 147.

17. Checks in the Payroll and Accounts Payable modules can now be printed in American National Standards Institute (ANSI) format.

   To print nongraphical payroll checks in ANSI format, clear the Graphical Forms check box for Checks in the Setup Options window. In the Payroll module, select the Print in ANSI Format check box in the Check Printing window.

   To print graphical payroll checks in ANSI format, select the Graphical Forms check box for Checks in the Payroll Options window.

   In the Accounts Payable module, select the Print in ANSI Format check box in the Check Printing or Manual Check Printing window.

**NOTE**
Be sure to first print the check and compare your check stock. Make any needed adjustments.
18. If you have the Extended Solution for direct deposits, verify the bank ID (bank account) number for each bank code. During conversion, if there is a discrepancy between the bank ID number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

19. Print and compare all customized form definitions, including your Accounts Payable 1099 forms, Payroll W-2 forms, and quarterly governmental reports. Default forms may be erased in the migration process.

   If you plan to use Federal and State eFiling and Reporting for the 1099 forms, W-2 forms, and governmental reports, perform the conversion to version 4.40 after the quarter end and before the first payroll in the current quarter to avoid values being placed in the wrong boxes on some forms. If conversion is performed mid-quarter, some forms may require editing.

20. Compare the following version 4.10 and 4.40 reports because sales tax may be recalculated during the conversion: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

   NOTE
   If a tax limit type other than Annual is selected in Tax Table Maintenance, your limit values will not be calculated correctly in Federal and State eFiling and Reporting forms until the first payroll run after conversion to version 4.40.
21. Export your version 4.10 Report Master reports for the Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order modules using Report Master Job Export. Import them into your version 4.40 installation using Report Master Job Import. You must recompile all custom reports defined using Report Master. To recompile reports, access Report Master Maintenance and enter the report name. At the maintenance screen menu bar, type ~ (tilde). Click Yes in the “Do you wish to prepare this report?” message dialog box to recompile. Repeat this procedure for each defined report. Changes have been made to your data dictionaries.

To access Report Master, select File > Run and type *unhiderm in the Run Program window to generate custom reports for Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Report Master Changes on page 108.

22. If you purchased the Return Merchandise Authorization module, after setting up Return Merchandise Authorization data files for the first time to a pre-existing Sage MAS 90 installation, select Return Merchandise Authorization Setup menu > Create Customer Invoice Search Records to create customer invoice search records in RMA.

Congratulations on migrating and converting your data. For information on what is new in this release, see What's New in Version 4.40 on page 5. Highlights include:

- You can expand your customer number to 20 characters, from 7 characters in previous releases.
- You can expand your item code to 30 characters, from 15 characters in previous releases.
Migrating from Version 4.20 to Version 4.40

Prior to migrating your version 4.20 source data to version 4.40, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage business partner or development partner prior to beginning the migration process.

Pre-Migration Checklist

After installing the current version of the software, you must prepare your version 4.20 source data for migration. This should be done for each company you plan to migrate.

1. Create a copy of your version 4.20 companies by selecting Library Master Main menu > Company Maintenance. Use the Copy feature in this task. Create a backup of your MAS90 folder following your backup process. For specific support on how to back up your data, refer to manuals for your backup software or contact the vendor from whom you purchased that product.

2. Verify all data entry files are empty. Print and update all journals and registers. Any data in the data entry files during the migration will be lost (for example, Accounts Receivable Cash Receipts Entry).

3. Rebuild all data files using the Rebuild Key Files and Rebuild Sort File utilities. You must answer Yes to all recalculation questions.

4. Select Library Master Utilities menu > Pre Migration, then enter the source path and company code for your version 4.20 system. Select the reports and utilities that appear.

   a. Select Item Code Validation Report to display missing item codes from your Warehouse Detail, Item Costing, and Transaction Detail files.

      • To fix the files, in your version 4.20 source data, use Inventory Management Main menu > Inventory Maintenance.

   b. Note: You must update or clear all data entry in progress to prevent the data from becoming cleared during data migration.

   c. Note: The tasks that appear in the Pre Migration window are based on the version of your source data.
Appendix A  Checklists

b Select Inventory File Comparison Report to compare the quantity in your warehouse, tier, and transaction inventory data files.

- Run this report by warehouse and save as an audit trail.
- To correct any quantities, run the Inventory Balancing Utility.

c Select Inventory Balancing Utility to balance your inventory quantities.

- Run this utility for each warehouse.
- At the Action column, select the action to perform for each item, or apply a specific action based on valuation type.
  - If the valuation is LIFO, FIFO, Lot, or Serial, at the Action column select Skip if the tier quantities are incorrect. You must perform a physical count to correct the tier quantity. After the tier quantity is correct, run this utility for these valuation methods.
  - If the valuation is Average Cost or Standard Cost and the warehouse and transaction quantities are incorrect, you must perform a physical count to correct the warehouse quantity. After the warehouse quantity is correct, run this utility for those valuation methods.
  - For more information, see Balance Inventory Quantities in the Help system.

d Run all Inventory Pre Migration tasks again to ensure corrections were made. Keep all reports as an audit trail.

5 Remove all negative tiers using Inventory Management Period End Processing.


NOTE

The quantities in your warehouse, tier, and transaction inventory data files must match before you can migrate your data to version 4.40.
If you created reports using Business Insights Reporter, review the report names in the Business Insights Reporter selection window. If there are multiple reports with similar names, copy the reports and assign a distinct name for each report.


For more information, see Copy a Report in the Help system.

**Post-Migration Checklist**

After preparing your version 4.20 source data for migration following the Pre-Migration Checklist on page 213, you are now ready to migrate your data to your 4.40 system.

1. Select Library Master Utilities menu > Parallel Migration to migrate your source data to your 4.40 system.

2. To run MS Script links, you must have the Microsoft Windows Script Host processor on your system. For information on installing the MS Windows Script Host processor, refer to the Microsoft Download Center Web site.

3. If you use Automatic Update or Task Schedule, review your scheduled automatic updates and reschedule those updates by selecting Library Master Main menu > Automatic Update or Task Scheduler, as applicable.

4. If you had task folders in your My Tasks area, re-create your Public and Private task folders.

5. Test all printers, including Device Configurator printers, that you normally use for printing business critical forms and reports. Each workstation must have a default printer defined.

6. If you are printing bar codes, install the Azalea fonts from the WkSetup\Azalea folder on the Sage MAS 90 or 200 CD-ROM.
Appendix A  Checklists

7 If security is enabled, set up security using Role Maintenance as follows:

- Create roles for all tasks you would like to secure. Review all roles and update permissions for all modules and features.
- For Common Information tasks that appear on multiple menus, security must be set up for the Common Information module using Role Maintenance. For more information, see Common Information Changes on page 76.
- Set up ODBC security using Role Maintenance.

8 If you are using Unified Logon and you migrated your system files, you must add the following statement on one workstation SOTA.ini: Logon=Yes. When you launch Sage MAS 90 or 200, log on as Administrator and set up and assign the appropriate roles to your users.

9 If you have custom buttons on your Desktop, re-create those buttons on the Custom toolbar.

Conversion Checklist

After preparing your version 4.20 source data for migration following the Pre-Migration Checklist on page 213 and Post-Migration Checklist on page 215, you are now ready to convert your source data to version 4.40.

1 Select Library Master Main menu > Company Maintenance to convert your source data to version 4.40. This must be done for each of your companies.

2 If you have customized Advanced Lookup Engine (ALE) lookups, after converting to the new version of the software and prior to accessing other modules, select Library Master Utilities menu > Lookup Conversion to convert your lookups.

Re-create customizations to lookups in all modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. This includes customizations created in the User Lookup Wizard and by clicking Custom in a lookup window.
If you modified list modes using the Library Master List Mode Master feature, you must use the User Lookup Wizard to re-create them. List Mode Master was replaced by the User Lookup Wizard. For more information, see User Lookup Wizard in your Library Master Help system.

3. Rebuild all application sort files using the Rebuild Sort File utility. You must answer Yes to all recalculation questions.

4. Verify your modules do not have broken links by selecting Library Master Utilities menu > Link Maintenance. Links that display in red are broken and will need to be fixed using the Relink Files button in Link Maintenance. For more information on relinking files, see Copy/Move/Relink Files in your Help system.

5. Review your Tax Tables. Installing the Tax Table Update (TTU) replaces all of your current state and federal tax tables with new tables unless you have specifically excluded a state tax table from the update by selecting the Exclude this Table from Tax Update check box in Tax Table Maintenance. Local tax information is not updated.

6. Review the placement of all your user-defined fields. Update the customized forms using Custom Office Update Customized Panels to Current Level. For more information, see Customizer Changes on page 78.

Re-customize the customized libraries for all modules other than Accounts Payable, Accounts Receivable, Bank Reconciliation, e-Business Manager, General Ledger, Job Cost, Material Requirements Planning, Payroll, Return Merchandise Authorization, Sales Order, TimeCard, and Work Order. For more information, see Customizer Changes on page 78.
Appendix A  Checklists

7. Run the Crystal Form Comparison Report utility (select File menu > Run, then type SYWFCU) to compare your customized forms to a standard form from version 4.40. For more information, see Customized Crystal Forms on page 53. If you were previously using non-graphical forms, you will need to set them up in Crystal Reports.

Test your modified Crystal Reports and forms. Before modifying graphical forms or the standard Crystal Reports found on the Custom Reports menu, you must be proficient in the use of Crystal Reports.

If you are using Crystal Web Reports, you must run the Crystal Conversion Wizard on all reports.

Use the Crystal Reports Conversion Wizard to convert your Crystal reports and forms. For more information, see Crystal Reports FAQs in the Help system.

Add any custom reports to the Custom Reports menu using Report Manager.

8. If dictionary changes were made to any file used on an import created in the Visual Integrator module, those imports will need to be manually updated. Review the appropriate file layout using the File Layouts and Program Information link on the Resources page of the Desktop and the Data Dictionary Listing accessed from the Visual Integrator Main menu to verify that the imported field names are consistent with the new file layout.

9. Set up the Paperless Office module to e-mail statements, reports, journals, registers, and other forms. For more information, see Set Up Paperless Office in the Help system.

10. Set up your Business Insights Dashboard pages. For more information, see Set Up Business Insights Dashboard in the Help system.

11. To use the e-Business Manager module, restore the copied templates back to the IW folder after re-installing the Web Engine.
12. If you had the Extended Solution for direct deposits, review the conversion log for any bank account numbers that were changed due to a discrepancy between the bank account numbers in Bank Code Maintenance and Direct Deposit Interface Setup.

13. If you do not use taxation for purchase orders, clear the Sales Tax Reporting check box in the Accounts Payable Options window.

14. If you include sales tax on purchase orders and want to enter default tax schedules for vendors, use Accounts Payable Assign Vendor Tax Schedules to assign tax schedules.

15. Confirm in Accounts Receivable Customer Maintenance that all customers that have exemption numbers still have the exemption number defined.

16. To access the Custom Financials menu and tasks, select File menu > Run and type `*unhidegl` in the Run Program window. For more information, see Custom Financials on page 147.

17. Checks in the Payroll and Accounts Payable modules can now be printed in American National Standards Institute (ANSI) format.

   To print nongraphical payroll checks in ANSI format, clear the Graphical Forms check box for Checks in the Setup Options window. In the Payroll module, select the Print in ANSI Format check box in the Check Printing window.

   To print graphical payroll checks in ANSI format, select the Graphical Forms check box for Checks in the Payroll Options window.

   In the Accounts Payable module, select the Print in ANSI Format check box in the Check Printing or Manual Check Printing window.

**NOTE**
Be sure to first print the check and compare your check stock. Make any needed adjustments.
Appendix A  Checklists

18. If you have the Extended Solution for direct deposits, verify the bank ID (bank account) number for each bank code. During conversion, if there is a discrepancy between the bank ID number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

19. Print and compare all customized form definitions, including your Payroll W-2 forms and quarterly governmental reports. Default forms may be erased in the migration process.

    If you plan to use Federal and State eFiling and Reporting for the W-2 forms and governmental reports, perform the conversion to version 4.40 after the quarter end and before the first payroll in the current quarter to avoid values being placed in the wrong boxes on some forms. If conversion is performed mid-quarter, some forms may require editing.

20. Compare the following version 4.20 and 4.40 reports because sales tax may be recalculated during the conversion: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

 NOTE

If a tax limit type other than Annual is selected in Tax Table Maintenance, your limit values will not be calculated correctly in Federal and State eFiling and Reporting forms until the first payroll run after conversion to version 4.40.
MIGRATING FROM VERSION 4.20 TO VERSION 4.40

21. Export your version 4.20 Report Master reports for the Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order modules using Report Master Job Export. Import them into your version 4.40 installation using Report Master Job Import. You must recompile all custom reports defined using Report Master. To recompile reports, access Report Master Maintenance and enter the report name. At the maintenance screen menu bar, type ~ (tilde). Click Yes in the "Do you wish to prepare this report?" message dialog box to recompile. Repeat this procedure for each defined report. Changes have been made to your data dictionaries.

To access Report Master, select File > Run and type *unhiderm in the Run Program window to generate custom reports for Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Report Master Changes on page 108.

22. If you purchased the Return Merchandise Authorization module, after setting up Return Merchandise Authorization data files for the first time to a pre-existing Sage MAS 90 installation, select Return Merchandise Authorization Setup menu > Create Customer Invoice Search Records to create customer invoice search records in RMA.

Congratulations on migrating and converting your data. For information on what is new in this release, see What’s New in Version 4.40 on page 5. Highlights include:

- You can expand your customer number to 20 characters, from 7 characters in previous releases.
- You can expand your item code to 30 characters, from 15 characters in previous releases.
Appendix A  Checklists

Migrating from Version 4.30 to Version 4.40

Prior to migrating your version 4.30 source data to version 4.40, consult with your Sage business partner.

If you have custom modules or modifications to any of your modules, consult your Sage business partner or development partner prior to beginning the migration process.

Pre-Migration Checklist

After installing the current version of the software, you must prepare your version 4.30 source data for migration. This should be done for each company you plan to migrate.

1. Create a copy of your version 4.30 companies by selecting Library Master Main menu > Company Maintenance. Use the Copy feature in this task. Create a backup of your MAS90 folder following your backup process. For specific support on how to back up your data, refer to manuals for your backup software or contact the vendor from whom you purchased that product.

2. Verify all data entry files are empty. Print and update all journals and registers. Any data in the data entry files during the migration will be lost (for example, Accounts Receivable Cash Receipts Entry).

3. Rebuild all data files using the Rebuild Key Files and Rebuild Sort File utilities. You must answer Yes to all recalculation questions.

4. Select Library Master Utilities menu > Pre Migration, then enter the source path and company code for your version 4.30 system. Select the reports and utilities that appear.

   a. Select Item Code Validation Report to display missing item codes from your Warehouse Detail, Item Costing, and Transaction Detail files.
      
      • To fix the files, in your version 4.30 source data, use Inventory Management Main menu > Inventory Maintenance.
MIGRATING FROM VERSION 4.30 TO VERSION 4.40

b Select Inventory File Comparison Report to compare the quantity in your warehouse, tier, and transaction inventory data files.

- Run this report by warehouse and save as an audit trail.
- To correct any quantities, run the Inventory Balancing Utility.

c Select Inventory Balancing Utility to balance your inventory quantities.

- Run this utility for each warehouse.
- At the Action column, select the action to perform for each item, or apply a specific action based on valuation type.
  
  - If the valuation is LIFO, FIFO, Lot, or Serial, at the Action column select Skip if the tier quantities are incorrect. You must perform a physical count to correct the tier quantity. After the tier quantity is correct, run this utility for these valuation methods.
  
  - If the valuation is Average Cost or Standard Cost and the warehouse and transaction quantities are incorrect, you must perform a physical count to correct the warehouse quantity. After the warehouse quantity is correct, run this utility for those valuation methods.
  
  - For more information, see Balance Inventory Quantities in the Help system.

d Run all Inventory Pre Migration tasks again to ensure corrections were made. Keep all reports as an audit trail.

5. Remove all negative tiers using Inventory Management Period End Processing.


NOTE
The quantities in your warehouse, tier, and transaction inventory data files must match before you can migrate your data to version 4.40.
Appendix A  Checklists

7. If you created reports using Business Insights Reporter, review the report names in the Business Insights Reporter selection window. If there are multiple reports with similar names, copy the reports and assign a distinct name for each report.


For more information, see Copy a Report in the Help system.

Post-Migration Checklist

After preparing your version 4.30 source data for migration following the Pre-Migration Checklist on page 222, you are now ready to migrate your data to your 4.40 system.

1. Select Library Master Utilities menu > Parallel Migration to migrate your source data to your 4.40 system.

2. To run MS Script links, you must have the Microsoft Windows Script Host processor on your system. For information on installing the MS Windows Script Host processor, refer to the Microsoft Download Center Web site.

3. If you use Automatic Update or Task Schedule, review your scheduled automatic updates and reschedule those updates by selecting Library Master Main menu > Automatic Update or Task Scheduler, as applicable.

4. If you had task folders in your My Tasks area, re-create your Public and Private task folders.

5. Test all printers, including Device Configurator printers, that you normally use for printing business critical forms and reports. Each workstation must have a default printer defined.

6. If you are printing bar codes, install the Azalea fonts from the WkSetup\Azalea folder on the Sage MAS 90 or 200 CD-ROM.
7. If security is enabled, set up security using Role Maintenance as follows:
   - Create roles for all tasks you would like to secure. Review all roles and update permissions for all modules and features.
   - For Common Information tasks that appear on multiple menus, security must be set up for the Common Information module using Role Maintenance. For more information, see Common Information Changes on page 76.
   - Set up ODBC security using Role Maintenance.

8. If you are using Unified Logon and you migrated your system files, you must add the following statement on one workstation SOTA.ini: Logon=Yes. When you launch Sage MAS 90 or 200, log on as Administrator and set up and assign the appropriate roles to your users.

9. If you have custom buttons on your Desktop, re-create those buttons on the Custom toolbar.

Conversion Checklist

After preparing your version 4.30 source data for migration following the Pre-Migration Checklist on page 222 and Post-Migration Checklist on page 224, you are now ready to convert your source data to version 4.40.

1. Select Library Master Main menu > Company Maintenance to convert your source data to version 4.40. This must be done for each of your companies.

2. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to the new version of the software and prior to accessing other modules, select Library Master Utilities menu > Lookup Conversion to convert your lookups.

   Re-create customizations to lookups in all modules other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. This includes customizations created in the User Lookup Wizard and by clicking Custom in a lookup window.
Appendix A  Checklists

If you modified list modes using the Library Master List Mode Master feature, you must use the User Lookup Wizard to re-create them. List Mode Master was replaced by the User Lookup Wizard. For more information, see User Lookup Wizard in your Library Master Help system.

3. Rebuild all application sort files using the Rebuild Sort File utility. You must answer Yes to all recalculation questions.

4. Verify your modules do not have broken links by selecting Library Master Utilities menu > Link Maintenance. Links that display in red are broken and will need to be fixed using the Relink Files button in Link Maintenance. For more information on relinking files, see Copy/Move/Relink Files in your Help system.

5. Review your Tax Tables. Installing the Tax Table Update (TTU) replaces all of your current state and federal tax tables with new tables unless you have specifically excluded a state tax table from the update by selecting the Exclude this Table from Tax Update check box in Tax Table Maintenance. Local tax information is not updated.

6. Review the placement of all your user-defined fields. Update the customized forms using Custom Office Update Customized Panels to Current Level. For more information, see Customizer Changes on page 78.

Re-customize the customized libraries for all modules other than Accounts Payable, Accounts Receivable, Bank Reconciliation, e-Business Manager, General Ledger, Job Cost, Material Requirements Planning, Payroll, Return Merchandise Authorization, Sales Order, TimeCard, and Work Order. For more information, see Customizer Changes on page 78.
7. Run the Crystal Form Comparison Report utility (select File menu > Run, then type SYWFCU) to compare your customized forms to a standard form from version 4.40. For more information, see Customized Crystal Forms on page 53. If you were previously using non-graphical forms, you will need to set them up in Crystal Reports.

Test your modified Crystal Reports and forms. Before modifying graphical forms or the standard Crystal Reports found on the Custom Reports menu, you must be proficient in the use of Crystal Reports.

If you are using Crystal Web Reports, you must run the Crystal Conversion Wizard on all reports.

Use the Crystal Reports Conversion Wizard to convert your Crystal reports and forms. For more information, see Crystal Reports FAQs in the Help system.

Add any custom reports to the Custom Reports menu using Report Manager.

8. If dictionary changes were made to any file used on an import created in the Visual Integrator module, those imports will need to be manually updated. Review the appropriate file layout using the File Layouts and Program Information link on the Resources page of the Desktop and the Data Dictionary Listing accessed from the Visual Integrator Main menu to verify that the imported field names are consistent with the new file layout.

9. Set up the Paperless Office module to e-mail statements, reports, journals, registers, and other forms. For more information, see Set Up Paperless Office in the Help system.

10. Set up your Business Insights Dashboard pages. For more information, see Set Up Business Insights Dashboard in the Help system.

11. To use the e-Business Manager module, restore the copied templates back to the IW folder after re-installing the Web Engine.
12____ If you had the Extended Solution for direct deposits, review the conversion log for any bank account numbers that were changed due to a discrepancy between the bank account numbers in Bank Code Maintenance and Direct Deposit Interface Setup.

13____ If you do not use taxation for purchase orders, clear the Sales Tax Reporting check box in the Accounts Payable Options window.

14____ If you include sales tax on purchase orders and want to enter default tax schedules for vendors, use Accounts Payable Assign Vendor Tax Schedules to assign tax schedules.

15____ Confirm in Accounts Receivable Customer Maintenance that all customers that have exemption numbers still have the exemption number defined.

16____ To access the Custom Financials menu and tasks, select File menu > Run and type *unhidegl in the Run Program window. For more information, see Custom Financials on page 147.

17____ Checks in the Payroll and Accounts Payable modules can now be printed in American National Standards Institute (ANSI) format.

To print nongraphical payroll checks in ANSI format, clear the Graphical Forms check box for Checks in the Setup Options window. In the Payroll module, select the Print in ANSI Format check box in the Check Printing window.

To print graphical payroll checks in ANSI format, select the Graphical Forms check box for Checks in the Payroll Options window.

In the Accounts Payable module, select the Print in ANSI Format check box in the Check Printing or Manual Check Printing window.
18. If you have the Extended Solution for direct deposits, verify the bank ID (bank account) number for each bank code. During conversion, if there is a discrepancy between the bank ID number in Bank Code Maintenance and the bank account number in Direct Deposit Information for a bank code, the account number in Direct Deposit Information replaces the number in Bank Code Maintenance. If an account number is not entered in Direct Deposit Information, the number in Bank Code Maintenance is entered in Direct Deposit Information. Account number changes are noted in the conversion log.

19. Print and compare all customized form definitions, including your Payroll W-2 forms and quarterly governmental reports. Default forms may be erased in the migration process.

   If you plan to use Federal and State eFiling and Reporting for the W-2 forms and governmental reports, perform the conversion to version 4.40 after the quarter end and before the first payroll in the current quarter to avoid values being placed in the wrong boxes on some forms. If conversion is performed mid-quarter, some forms may require editing.

20. Compare the following version 4.30 and 4.40 reports because sales tax may be recalculated during the conversion: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

21. Export your version 4.30 Report Master reports for the Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order modules using Report Master Job Export. Import them into your version 4.40 installation using Report Master Job Import. You must recompile all custom reports defined using Report Master. To recompile reports, access Report Master Maintenance and enter the report name. At the maintenance screen menu bar, type ~ (tilde). Click Yes in the "Do you wish to prepare this report?" message dialog box to recompile. Repeat this procedure for each defined report. Changes have been made to your data dictionaries.
To access Report Master, select File > Run and type *unhiderm in the Run Program window to generate custom reports for Job Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. For more information, see Report Master Changes on page 108.

22 If you purchased the Return Merchandise Authorization module, after setting up Return Merchandise Authorization data files for the first time to a pre-existing Sage MAS 90 installation, select Return Merchandise Authorization Setup menu > Create Customer Invoice Search Records to create customer invoice search records in RMA.

Congratulations on migrating and converting your data. For information on what is new in this release, see What’s New in Version 4.40 on page 5. Highlights include:

- You can expand your customer number to 20 characters, from 7 characters in previous releases.
- You can expand your item code to 30 characters, from 15 characters in previous releases.
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
</tr>
<tr>
<td>accounting dates 56</td>
</tr>
<tr>
<td>Accounts Payable</td>
</tr>
<tr>
<td>data entry 112</td>
</tr>
<tr>
<td>forms 114</td>
</tr>
<tr>
<td>global changes 111</td>
</tr>
<tr>
<td>period-end processing 112</td>
</tr>
<tr>
<td>renamed, removed, or moved tasks 113</td>
</tr>
<tr>
<td>reports 114</td>
</tr>
<tr>
<td>Accounts Receivable</td>
</tr>
<tr>
<td>global changes 115</td>
</tr>
<tr>
<td>period-end processing 116</td>
</tr>
<tr>
<td>renamed, removed, or moved tasks 117</td>
</tr>
<tr>
<td>statements 116</td>
</tr>
<tr>
<td>Activity Log 24</td>
</tr>
<tr>
<td>Advanced Lookup Engine 24</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>Bar Code</td>
</tr>
<tr>
<td>options 119</td>
</tr>
<tr>
<td>renamed tasks 119</td>
</tr>
<tr>
<td>batch fax 59</td>
</tr>
<tr>
<td>batch faxing 24</td>
</tr>
<tr>
<td>Bill of Materials</td>
</tr>
<tr>
<td>data entry 125</td>
</tr>
<tr>
<td>forms 127</td>
</tr>
<tr>
<td>global changes 125</td>
</tr>
<tr>
<td>inquiry changes 126</td>
</tr>
<tr>
<td>options 125</td>
</tr>
<tr>
<td>printing 126</td>
</tr>
<tr>
<td>renamed, removed, or moved tasks 127</td>
</tr>
<tr>
<td>reports 127</td>
</tr>
<tr>
<td>Business Insights</td>
</tr>
<tr>
<td>menu organization 124</td>
</tr>
<tr>
<td>Business Insights Dashboard 121</td>
</tr>
<tr>
<td>renamed tasks 75, 124</td>
</tr>
<tr>
<td>Business Insights Explorer 121</td>
</tr>
<tr>
<td>Business Insights Reporter 122</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>checklists</td>
</tr>
<tr>
<td>conversion 189, 199, 207, 216, 225</td>
</tr>
<tr>
<td>post-installation 188, 197, 206, 215, 224</td>
</tr>
<tr>
<td>Common Information 31, 76</td>
</tr>
<tr>
<td>miscellaneous items 130</td>
</tr>
<tr>
<td>options 129</td>
</tr>
<tr>
<td>renamed, removed, or moved tasks 130</td>
</tr>
<tr>
<td>reports 130</td>
</tr>
<tr>
<td>companies, copying data 61</td>
</tr>
<tr>
<td>costing</td>
</tr>
<tr>
<td>Inventory Management 154</td>
</tr>
<tr>
<td>customer statements 116</td>
</tr>
<tr>
<td>Customizer 78</td>
</tr>
<tr>
<td>global changes 133</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>data entry 25, 54</td>
</tr>
<tr>
<td>Accounts Payable 112</td>
</tr>
<tr>
<td>Bill of Materials 125</td>
</tr>
<tr>
<td>General Ledger 83, 148</td>
</tr>
<tr>
<td>Purchase Order 163</td>
</tr>
<tr>
<td>Return Merchandise Authorization 169</td>
</tr>
<tr>
<td>Sales Order 171</td>
</tr>
<tr>
<td>data file multi-segment 23, 52</td>
</tr>
<tr>
<td>dates, accounting and module 56</td>
</tr>
<tr>
<td>Desktop 54</td>
</tr>
<tr>
<td>direct deposits 168</td>
</tr>
<tr>
<td>dot matrix printers 57</td>
</tr>
<tr>
<td>E</td>
</tr>
<tr>
<td>e-Business Manager</td>
</tr>
<tr>
<td>global changes 79, 139</td>
</tr>
<tr>
<td>Web engine 32, 79, 139</td>
</tr>
<tr>
<td>Electronic Reporting for W2 and 1099s 80</td>
</tr>
<tr>
<td>global changes 141</td>
</tr>
<tr>
<td>URL, maintaining 62</td>
</tr>
<tr>
<td>e-mail</td>
</tr>
<tr>
<td>statements 116</td>
</tr>
<tr>
<td>expanded customer numbers 25</td>
</tr>
<tr>
<td>expanded item codes 25</td>
</tr>
<tr>
<td>F</td>
</tr>
<tr>
<td>fax</td>
</tr>
<tr>
<td>batch faxing 59</td>
</tr>
<tr>
<td>Fixed Assets</td>
</tr>
<tr>
<td>global changes 81, 143</td>
</tr>
</tbody>
</table>
### Index

**forms**  
- Accounts Payable 114  
- Bill of Materials 127  
- character-based 24  
- Crystal forms 24  
- dot matrix printers 57  

**G**  
**General Ledger**  
  - accounts 145  
  - allocations 146  
  - custom financials 83, 147  
  - data entry 83, 148  
  - fiscal years 145  
  - period-end processing 84, 149  
  - renamed and removed tasks 86, 150  
  - reports 85, 150  
  - standard financials 83, 147  
  - graphic conventions 2  

**H**  
**Help system** 55  

**I**  
**inquiries** 55  
**installation**  
  - changes since version 4.30 23  
  - changes since versions prior to 4.30 51  

**M**  
**Magnetic Media Reporting. See Electronic Reporting for W2 and 1099s**  
  - manuals 55  
  - migrate, Level 3.x data 55  
  - modules  
    - dates 56  
    - registering 57  
    - retired 108  

**O**  
**Operand field** 58  

**P**  
**Payroll**  
  - direct deposits 168  
  - reports 168  
  - taxes 167  
**period-end processing**  
  - Accounts Payable 112  
  - Accounts Receivable 116  
  - General Ledger 84, 149  
  - Inventory Management 155  
  - Purchase Order 164  
  - Sales Order 155, 173  
**printing**  
  - Bill of Materials 126  
  - Inventory Management 155  
  - Purchase Order 165  
**Purchase Order**  
  - data entry 163  
  - global changes 161  
  - options 162  
  - period-end processing 164  
  - printing 165  
  - purchases history 163  
  - registers 165  
  - renamed, removed, or moved tasks 166  
  - reports 165  
  - updates 165  
  - utilities 164  

**R**  
**registers**  
  - Purchase Order 165  
  - Report Master 108
Index  S

reports
  Accounts Payable 114
  Bill of Materials 127
  Common Information 130
  dot matrix printers 57
  General Ledger 85, 150
  Payroll 168
  Purchase Order 165
  Sales Order 127, 156, 172
reports and forms
  Inventory Management 156
Return Merchandise Authorization
data entry 169
  utilities 169
roles, maintaining 61

S
Sage MAS 90 and 200 Desktop 54
Sales Order
data entry 171
  Job Cost integration 174
  period-end processing 155, 173
  renamed, removed, or moved tasks 174
  reports 127, 156
  sales history 172
  sales history reports 172
  security option 171
  security 58
  roles 61
  selection grids 58
  statements 116

T
tasks
  changed 59
  renamed, removed, or moved 62
  taxes 167

U
updates
  Purchase Order 165
URL, maintaining 62
utilities
  Inventory Management 154
  Purchase Order 164

V
Value field 58
Visual Integrator
  data dictionaries 107
  Import Job Maintenance 107

W
Web engine 32, 79, 139
Work Order
  moved task 181